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Introduction

OpenTextTM Active Catalogue is the leading product information database for the 
electronic exchange of product information between retailers and vendors in the 
GM&A, grocery, hardlines, and other industries worldwide. It contains more than 
220 million Global Trade Item Numbers (GTINs) from over 7,000 vendors and 
grows daily.
OpenText Active Catalogue enables vendors to focus on product catalogue content 
and sales instead of storing and communicating product information in different 
formats for different customers.
The section is organized as follows: 
■ “About This Guide” on page 1.
■ “Audience” on page 2.
■ “Minimum System Requirements” on page 3.
■ “Conventions Used in This Guide” on page 3.
■ “Accessing Product Documentation” on page 4.
■ “Retailers and Vendors” on page 4.
■ “Contacting Technical Support” on page 5.

About This Guide
This guide explains how to view, maintain, and download catalogue data using the 
browser interface to the hosted application. Similar information is provided in the 
application’s online help.
The guide is organized as follows: 
■ Chapter 1, "Overview," on page 6 describes the basic functions and navigation 

for OpenText Active Catalogue.
■ Chapter 2, "Working with User Profiles," on page 21 explains how an 

administrator (super user) can add and maintain users for their Catalogue 
account. It also describes how an administrator can reset passwords, view 
permissions for defined roles, and view users assigned to a role.

■ Chapter 3, "Working With Access Rights," on page 38 explains how to set up and 
maintain security for OpenText Active Catalogue. Access rights are set up and 
maintained for accounts and users.

■ Chapter 4, "Working with Accounts," on page 49 describes maintenance of your 
account and how to view information about trading partners. Account 
information includes account details (for you and your trading partners) such as 
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Audience

address and contact data, GS1 (UCC/EAN) Company Prefix List information, and 
custom field definitions.

■ Chapter 5, "Working with Attribute Filters," on page 68 explains how to apply, 
create, and modify attribute filters to restrict the display and export of attributes 
to only those attributes relevant to your business. 

■ Chapter 6, "Finding and Viewing Data," on page 76 explains how to find and 
view vendor catalogue data.

■ Chapter 7, "Working with Color and Size Codes," on page 102 explains how to 
find, view, and download the GS1 US color and size codes. In addition, it 
describes how to request a new size code from via email.

■ Chapter 8, "Working with Compliance Checks," on page 120 describes the 
compliance checks that are available using OpenText Active Catalogue, explains 
how to enable the compliance checks, and discusses the options that are 
available if your data does not pass a compliance check.

■ Chapter 9, "Maintaining Catalogue Data," on page 124 explains how to maintain 
your product catalogue including how to edit values for custom fields.

■ Chapter 10, "Analytics and Reports," on page 169 describes several reports that 
you can run that provide information about how you and your trading partners 
use or access Catalogue data.

■ Chapter 11, "Working with CSV Text Files to Upload Data," on page 196 explains 
how to upload small volumes of catalogue item or image data using a comma 
separated values (CSV) text file. Text file upload is useful for vendors with 
smaller catalogues who may have too many items to enter using the browser 
user interface (UI) but too few items to need the scalability of the EDI or Web 
Services formats.

■ Chapter 12, "Working with Downloads," on page 207 explains how to select and 
download catalogue data on a one-time basis.

■ Chapter 13, "Working with EDI Data," on page 228 explains how to use the EDI 
Management Console (EMC) to monitor EDI files that you send to OpenText 
Active Catalogue and identify errors encountered while processing them. It also 
describes how to submit sample EDI to Catalogue.

■  Chapter 14, "Online Correction of Errors," on page 235 explains how to find and 
correct errors encountered while processing a batch EDI document or EDI 
sample data.

■ Appendix A "GTIN Number Structures," on page 256 describes the various GTIN 
types.

■ Appendix B "Container and Component GTIN Codes," on page 258 defines the 
codes used with container and component GTINs in OpenText Active Catalogue.

Audience
The audience for this guide is personnel who use the browser interface to perform 
tasks in the following areas of activity: 
■ Access—View and maintain retailer access to a vendor catalogue. 
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■ Account Maintenance—View and maintain company data such as contact 
information. 

■ Attribute Filters—View, apply, and maintain filters to restrict the display and 
export of GTIN attributes.

■ Catalogue Data—Find, view, maintain, upload, and download catalogue data.
■ Error Processing—View, correct, and resubmit or delete error transactions sent 

through the batch interface.

Minimum System Requirements 
The minimum system requirements for using the browser interface are:
■ Internet Access
■ Internet Browser: IE 8, IE 9, IE 10, Firefox, Chrome, Edge

■ IE 8 and Firefox 36 are certified on Windows.
■ IE 9, IE 10, Firefox, Chrome, and Edge are supported, but not certified.

Note: In IE 8, IE 9, and IE 10 you must apply Compatibility View for the 
numbering and all text to display correctly in the online help system. 

■ For IE 8, click Tools > Compatibility View Settings. In the dialog box, 
either add the Catalogue URL to the Compatibility View, or select the 
Display all websites in Compatibility View check box, and click 
Close.

■ For IE 9, after accessing Catalogue, click the “broken page” icon to the 
right of the Address bar to enable compatibility view.

■ For IE 10, see Microsoft’s instructions for compatibility mode.
■ 2 GB RAM
Note: Windows operating systems are supported. Catalogue may run fine in 
browsers on alternate operating systems, but OpenText does not support defects 
or issues that are unique to those non-Windows operating systems. 

Conventions Used in This Guide
This guide uses the following conventions:

This convention... Indicates... Example...
Bold text Button, or field names, 

menu options, and 
hyperlinks

Save



4 OpenText Active Catalogue CE 21.2 Browser Interface User Guide

Accessing Product Documentation

Accessing Product Documentation
You can access all of the OpenText product documentation for OpenText Active 
Catalogue from within the Catalogue application. Most documentation is delivered 
in Adobe Acrobat PDF format. To read and print the documents, you will need 
Adobe Acrobat Reader, a free product from Adobe Systems. For information about 
downloading and installing Acrobat Reader, see the section, “Installing Adobe 
Reader.”

To access the product documentation
1 Log in to OpenText Active Catalogue.
2 Click Product Documentation > All Documents.

The Product Documentation List page opens. A list of the documents is 
displayed.

3 You have the option to open the document or save it to your computer. Do one 
of the following:

■ To open a document, click the document link. The document opens in a 
separate window.

■ To save the document to your computer, right click the document link and 
select Save Target As. The Save As window opens. Navigate to the 
location where you want to save the document, and click Save. The 
document is saved to your computer.

Installing Adobe Reader
Since most OpenText product documentation is delivered in Adobe Acrobat PDF 
format, you will need Adobe Reader to read and print the documentation. Adobe 
Reader is a free product from Adobe Systems. 

To download and install Adobe Reader
1 Launch a Web browser and navigate to http://get.adobe.com/reader
2 Download and install Adobe Reader. Follow the screens, accepting the defaults.

You can now access OpenText product documentation by double-clicking the PDF 
file.

Retailers and Vendors 
In this guide the term retailers includes retailers, grocers, distribution centers, and 
third parties that extract data from OpenText Active Catalogue. An example of a 
third party is a company that makes tags attached to apparel. 
The term vendors includes vendors, manufacturers, distributors, brokers, and 
wholesalers.

http://get.adobe.com/reader
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Contacting Technical Support
To contact OpenText Cloud Support Services (CSS) for assistance in North America: 
■ Email cataloguesupport@opentext.com

■ Call 1-800-334-2255
To contact OpenText Cloud Support Services (CSS) for assistance in Europe, refer 
to the OpenText website at http://www.opentext.com for available phone numbers.

mailto:cataloguesupport@opentext.com
http://www.opentext.com
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Overview 1
This section provides an overview of the OpenText Active Catalogue browser 
interface and includes information about navigating the application, menus, 
buttons, logging in and out, entering dates, success and error messages, timing 
out, and other general matters.
This section is organized as follows: 
■ “OpenText Active Catalogue Browser Interface” on page 6.
■ “Logging In and Out of OpenText Active Catalogue” on page 7.
■ “Account Lock Out” on page 7
■ “Changing Your Password” on page 8.
■ “Resetting Your Password” on page 9.
■ “Login Page Links” on page 10.
■ “Navigating OpenText Active Catalogue” on page 10.
■ “Using Online Help” on page 18.
■ “Entering Dates” on page 18.
■ “Discarding Changes Before Saving” on page 19.
■ “Success and Error Messages” on page 19.
■ “Timing Out” on page 19.
■ “Printing from OpenText Active Catalogue” on page 19.

OpenText Active Catalogue Browser Interface
The OpenText Active Catalogue browser interface is a Web-based, hosted 
application. 
Use the application to do the following: 
■ Maintain and download catalogue data. 
■ Maintain retailer access to your catalogue. 
■ Maintain your own account information.
■ Create and apply attribute filters to restrict the display/export of GTIN attributes.
■ View, correct, and resubmit error transactions sent through the batch interface.
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Logging In and Out of OpenText Active Catalogue
To log in
1 Access the Internet by opening your preferred browser.
2 Type https://catalogue.gxs.com in the Address field. The Catalogue Login page 

opens. 

3 Enter your Network ID, User ID, and Password. All three fields are case-
sensitive. 
Note: Press Tab to move to the next field.

4 Press Enter or click Login. 
The Selection Code List page opens.
Note the following:

■ The first time you log into Catalogue after OpenText completes your 
account set up, the Change User Password page opens, and you are 
prompted to change your password. Thereafter, if your password has 
expired, or you have reset your password, you are also prompted to 
change your password. See “Changing Your Password” on page 8. 

■ After 5 invalid password attempts in 5 minutes, an error message displays, 
and you are locked out of your account for 15 minutes.

To log out
1 Click Logout in the upper right corner. 

A message box opens. 
2 To log out, click Yes. The OpenText Active Catalogue login page or customer 

interface page opens. 
Note: If you have records in the download basket, you will receive a message 
asking if you want to log out without downloading. To complete the download, 
click No. Navigate to the Download Basket page and complete the download. 
See “Completing a One-Time Batch File Download” on page 212. 

Account Lock Out
After 5 invalid password attempts in 5 minutes, an error message displays, and you 
are locked out of your account for 15 minutes.

https://catalogue.gxs.com
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Changing Your Password
You can change your password at any time using the procedure below (Account 
> Change Password).
There are also times when you must change your password. In the following 
situations, after you log in, the Change User Password page opens, and you are 
prompted to change your password.
■ You log into Catalogue for the first time after OpenText completes your account 

set up. 
■ Your password expired.
■ You reset your password.

To change your password
1 Click Account > Change Password. The Change User Password page 

opens. 

2 Type the current password in the Current Password box
3 Type the new password in the New Password box and again in Confirm 

New Password box. You must adhere to the password validation 
requirements described in “Password Requirements” on page 8.

4 To save the new password, click Save. A message indicates that your password 
was changed successfully.

Password Requirements
Passwords must meet the validation requirements described in the table below. If 
your password does not meet the requirements, you will be prompted to type a 
different password.

Password Description Requirement
Password different from User ID The password cannot be the same as the 

User ID that is defined for the browser 
interface user (UI).

Minimum number of characters 10 
Maximum number of characters 16
Minimum number of numeric 
characters

2

Minimum number of alpha characters 2
Maximum number of times a character 
can be used in a password

4
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Resetting Your Password
If you have forgotten your password, your password has expired, or your account 
has been locked, you can reset your password. A new randomly-generated 
password is sent in an email to the user’s email address (not the account’s email 
address).
Note: Do not use this procedure to change your password. See “Changing Your 
Password” on page 8 for information on changing your password.
1 Access the Internet by opening your preferred browser. 
2 Type https://catalogue.gxs.com in the Address field. The Catalogue Login page 

opens.

3 Enter your Network ID and User ID. Both fields are case-sensitive.
4 Click the Reset password link.
5 A dialog box asks you to confirm that you want to reset your password. Click 

OK if you want to reset your password. 
6 A message states that if you entered valid network and user IDs, an email with 

reset instructions was sent to your (the user’s) email address with the subject 
line: 

OpenText Active Catalogue - user password reset

Distinct password The new password must be different from 
the previous 5 passwords.

Case sensitivity Characters are case sensitive.
Upper and lower case alpha characters Both upper and lower case alpha characters 

are required, but a mix of both is not 
required.

Special characters Special characters are allowed as follows:
■ Characters allowed

~`!@#$%^&*()_+-={}|[ ]\:”;’,./?
■ Characters not allowed 

< >
Expiration time The browser interface user’s (UI) password 

will expire 90 days after being changed.

Password Description Requirement

https://catalogue.gxs.com
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Emails are sent from auto_notify@opentext.com to the user’s email address (set up 
by a OpenText administrator for individual users).
Note: If you do not have a user contact email address set up, the reset 
password is sent to OpenText Cloud Support Services (CSS) at 
cataloguesupport@opentext.com.

7 Check your email for your new password. The email contains the following 
information:

Password for user ID 'YourUserID' [accountId=YourAccountID] has been reset to 
'NewPassword'

where YourUserID, YourAccountID, and NewPassword are actual values.
8 Log into Catalogue using this new password. 
9 You will be prompted to change your password when you log in. See “Changing 

Your Password” on page 8.

Login Page Links
On the Login page, in the upper right corner, click OpenText to access the 
OpenText website. 

Navigating OpenText Active Catalogue
The following sections describes the navigation tools that are available for working 
in OpenText Active Catalogue: 
■ Navigation panel - See “Navigation Panel” on page 12.
■ Button Bar -See “Button Bar” on page 14.
■ Filter Bar - See “Filter Bar” on page 15.
■ Search Bar - See “Search Bar” on page 15.
■ Auto-Fill - See “Auto-Fill” on page 16.
■ Browse Bar - See “Browse Bar” on page 17.
■ Page Size - See “Page Size” on page 17
■ Hyperlinks - See “Hyperlinks” on page 17.
■ Sorting a List - See “Sorting a List” on page 17.
■ Find Link - See “Find Link” on page 17.

mailto:cataloguesupport@opentext.com
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Navigation Panel 
The navigation panel appears on the left side of the page. It is divided into 
categories. When you first log in to Catalogue, by default, the first two categories 
are expanded and the remaining categories are collapsed. To expand or collapse a 
category, click the category name (for example, Data Management).

To use the navigation panel
1 Click a category name to expand a category and display the list of headings 

below it. 
2 Click one of the headings to open the corresponding page. 

A shortcut notation will be used for procedures in this guide. For example, Click 
Data Management > Error Processing means that you click on the Data 
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Management category (if it is not already expanded) and then click on the Error 
Processing heading below it to open the Error Processing page.
Note: The navigation menu remains accessible from all pages. Categories 
and headings within a category vary by account and user access rights.

Category Headings
Catalogue ■ Selection Code List—View the list of selection codes in your 

catalogue.
See “Finding and Viewing Data” on page 76.

■ Advanced Search—Find a selection code, product, or GTIN.
See “Finding and Viewing Data” on page 76.

■ Download Basket—Select and download catalogue data on a 
one-time (also called ad hoc) basis.
See “Working with Downloads” on page 207.

Data Management ■ Error Processing—Display error sets.
See “Online Correction of Errors” on page 235.

■ EDI Management Console—Monitor EDI files sent to 
Catalogue and interpret resulting EDI errors. Submit sample EDI 
data in the demo environment for validation.
See “Working with EDI Data” on page 228.

■ Text File Upload—Upload small volumes of catalogue data 
using a comma separated values (CSV) text file.
See “Working with CSV Text Files to Upload Data” on page 196.

■ Text File Download—Display text file download results.
See “Working with Downloads” on page 207.

■ Compliance Checks—Validate Catalogue data against a set of 
pre-determined rules. View and edit compliance configuration 
settings. Review available options for data that is non-compliant.
See “Working with Compliance Checks” on page 120.

■ Compliance Reports—A one-time report run against the 
current state of data that exists within a catalogue. You can 
compare your catalogue to an attribute filter and obtain a report 
on the attributes that are not populated.
See “Analytics and Reports” on page 169.

Color/Size Codes ■ Color Codes—Access, search, synchronize, and download the 
latest GS1 US color code information.
See “Working with Color and Size Codes” on page 102.

■ Size Codes—Access, search, synchronize, and download the 
latest GS1 US size code information.
See “Working with Color and Size Codes” on page 102.

■ Request New Size Code—Request a new GS1 US size code.
See “Working with Color and Size Codes” on page 102.

Account ■ Account Details—Edit your account data, maintain/activate 
your GS1 company prefixes, create custom fields.
See “Working with Accounts” on page 49.

■ Change Password—Change your user password.
See “Changing Your Password” on page 8.
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Button Bar 
Click a button on the button bar to execute an action or open a page.

The following buttons are used in Catalogue. Move your cursor over a button to 
see its definition. 

Product 
Documentation

■ All Documents—Access all product documentation.

Administration ■ Trading Partner Access—Manage retailer access to your 
catalogue. View address, contact, and other information for 
retailers.
See “Working With Access Rights” on page 38.

■ TP Access Report—View a list of all trading partners who have 
accessed your catalogue.
See “Analytics and Reports” on page 169.

■ Account Attribute Filters—Display attribute filters.
See “Working with Attribute Filters” on page 68.

■ Item Search Ratio Report—Each time your trading partners 
(retailers) search your catalogue, Catalogue keeps track of the 
number of times they find and do not find the GTINs they are 
looking for. View the actual number of hits (GTINs found) and 
misses (GTINs not found) for each trading partner that searches 
your catalogue, as well as the hit and miss percentages.
Note: The report is available to vendors only if they have the 
option turned on and they have at least one retailer tracking 
missed GTINs.
See “Analytics and Reports” on page 169.

■ Attributes Analytics—View your account to see which 
attributes you are populating for your items (GTINs). Enables 
you to see the attribute data that a retailer sees.
See “Analytics and Reports” on page 169.

Button Description
Click Show/Hide to show or hide the navigation panel.

Click Add to add a new record to your catalogue.

Click Edit to update an existing record in your catalogue (including 
mass update).

Click Delete to delete a record from your catalogue.

Click Copy to copy an existing GTIN that used as the basis for a new 
GTIN.
Click Save to save changes.

Click Download to add a record to the download basket.
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Filter Bar 
Most pages have a filter bar. Filter options are specific to each page. Depending on 
the option, you can type a value in a field or choose a value from a drop-down list. 
To clear filter selections, click Clear Filter. Any filter criteria is removed and the 
full list of records is displayed on the page.
By default, for each new session of Catalogue, the filter bar is open (expanded) 
when you first log in and open a page; the filter options available for that page 
display. You can open or close the filter bar by clicking on it. If you open the search 
bar, the filter bar closes; you cannot use both at the same time. 
Note: The system remembers whether you have the filter bar or search bar open; 
when you navigate to other pages, the bar that was open remains open (for that 
session).

Search Bar
Most pages have a search bar. There are a few exceptions such as the color and 
size code pages. Also, except for the EQUAL MULTI option for a Product, the search 
bar displays the same search options that are available by clicking Catalogue > 

Click Download to download GS1 US color or size code information.

Click to mark an error document as Read (that is, change the 
typeface to plain).
Click to mark an error document as Unread (that is, change the 
typeface to bold).
Click Revert to return error functions to their previously submitted 
values. 
Click Move to move a Product and all of its GTINs and associated 
attributes from one Selection Code to a different Selection Code.
Click Copy Data to Table to copy the data displayed on a list page 
to a table so that you can copy and paste the data from the table to 
your own application or save the data to a CSV text file.
Click Container to view a list of container GTINs for the selected 
component. 
Click Components to view a list of component GTINs in the 
selected container GTIN.
Click Auto Calendar to display a calendar from which to select a 
date.

Click Cancel to cancel an EDI document from being processed.

Click Default Profile to view a default subscription profile.

Click Add to add a subscription profile.

Click Edit to edit a subscription profile.

Button Description
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Advanced Search (which opens the Find Catalogue Data page). Searches have 
no context or relation to the current page; searches are performed from the “top” 
level. Having the search bar on all pages provides a convenient way to search 
without having to go back to the Find Catalogue Data page.
By default, for each new session of Catalogue, the search bar is closed when the 
page opens. You can open or close the search bar by clicking on it. If you open the 
search bar, the filter bar closes; you cannot use both at the same time.
Note: The system remembers whether you have the filter bar or search bar open; 
when you navigate to other pages, the bar that was open remains open (for that 
session).
Even though the search functionality is identical on the search bar and the 
Advanced Search (Find Catalogue Data) page (except for this difference), the 
options are displayed slightly differently in the two places. On the search bar, when 
you select an option from the drop-down list, the appropriate corresponding 
options (drop-down lists and fields) display on the page. 
For example, if you select Selection Code from the drop-down list, EQUAL and 
BEGIN display in the adjacent drop-down list. 

However, if you select Product from the drop-down list, the Identifier, Description, 
and Compressed options appear.

Depending on which of these options you select (Identifier, Description, or 
Compressed), the drop-down list options for BEGIN, EQUAL, and CONTAINS will 
change. For example, if you select Description or Compressed, EQUAL is the only 
valid value that appears.
See “Finding and Viewing Data” on page 76 for information about using the 
specific search options.
Note: You cannot enter a copyright or registered trademark in a search field; no 
results are returned. 

Auto-Fill 
Some fields have an auto-fill feature. As you type a value in the field, a drop-down 
list appears and is automatically populated with choices (listed alphabetically) that 
match the values you are typing. A limited number of choices are displayed. If the 
choice you want is not displayed, enter more or different characters to narrow the 
choices. The more characters you type, the closer the match, and the less items 
that appear in the drop-down list. You can select an item from this list.
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Browse Bar 
Use the browse bar to display specific pages of data

Click any of the four angle buttons in the browse bar to display data as follows:
■ << the first page of data
■ < the previous page of data
■ > the next page of data
■ >> the last page of data
The numbers in the center indicate the numbers of the pages of data. Click a 
number to display a particular page of data. For example, click 4 to display data on 
page 4.

Page Size 
Use the Page Size drop-down list to select how many records you want to display 
on a single page.

Hyperlinks
Click underlined text hyperlinks to open a page that lists records referred to by the 
hyperlink (for instance, under Products, click 28 to display the 28 products that 
exist under the selection code 003). 

Sorting a List
You can sort a list by a column heading if the column heading is underlined. 
Click on the column heading to sort by ascending or descending order. Click on 
it again to reverse the order. An arrow next to the heading indicates that the list 
is sorted by that column. If the arrow points up, the list is sorted in ascending 
order. If the arrow points down, the list is sorted in descending sort order.

Find Link
You can use the Find link to help you populate the color and size codes when you 
add a GTIN. On the GTIN Detail (New) page, for the Color Code or Size Code 
fields, click the blue Find link to open a text box to the right of the link. Begin 
typing a description or code in the box. The drop-down list selections adjust to 
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show only those descriptions or codes that match your criteria. When you make a 
selection, the selection populates the actual field, and the Find text box 
disappears.

Using Online Help
To open the online help file, click Help in the upper right corner of OpenText Active 
Catalogue.

Note: In IE 8, IE 9, and IE 10, you must apply Compatibility View for the 
numbering and all text to display correctly in the online help system. 

■ For IE 8, click Tools > Compatibility View Settings. In the dialog box, 
either add the Catalogue URL to the Compatibility View, or select the 
Display all websites in Compatibility View check box, and click 
Close.

■ For IE 9, after accessing Catalogue, click the “broken page” icon to the 
right of the Address bar to enable compatibility view.

■ For IE 10, see Microsoft’s instructions for compatibility mode.

Contacting Support
To access information to contact support, click Support in the upper right corner 
of OpenText Active Catalogue.

Entering Dates
Select your preferred date format on the Account Details page (Account > 
Account Details). You must enter dates in this format, and dates will be 
displayed in this format. See “Maintaining Your Account” on page 49. 
Some date fields in Catalogue offer the option of using Auto Calendar to enter a 
date instead of typing in the date. If the Auto Calendar icon appears next to a date 
field, this option is available.

To use Auto Calendar
1 Click Auto Calendar to open Auto Calendar. 
2 Use the < > buttons in Auto Calendar to navigate to a month. 
3 Click a date to enter it in the field. 
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Discarding Changes Before Saving
To discard unsaved changes on a page (that is, restore the page to its status 
before you entered but did not save new data), click Discard. 

Success and Error Messages
After executing actions, a success or error message appears below the filter bar 
and above the main page area. 

Timing Out
OpenText Active Catalogue will automatically log you out after 20 minutes of 
inactivity. 

Printing from OpenText Active Catalogue
To print a page, click Print on the browser toolbar. 
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Working with User Profiles 2
This section explains how an administrator (super user) can add and maintain 
users for their Catalogue account. It also describes how an administrator can reset 
passwords, view permissions for defined roles, and view users assigned to a role.
This section is organized as follows:
■ “Overview” on page 21
■ “Self-Service Administration by Super Users” on page 22
■ “Adding a User” on page 22
■ “Updating User Information” on page 24.
■ “Deleting a User” on page 26.
■ “Activating a User” on page 27
■ “Deactivating a User” on page 28
■ “Changing a User’s Password” on page 29
■ “Copying User Data to a Table” on page 30
■ “Resetting Passwords for Multiple Users” on page 33
■ “Viewing Access Permissions for Role Profiles” on page 34
■ “Viewing Users Assigned to a Role” on page 35
■ “Changing a User’s Role” on page 36

Overview
There are two types of administrators:
■ The OpenText administrator (referred to as the super admin)
■ Retailer, vendor, and distributor administrators (referred to as super users). 

Only the OpenText administrator can create a super user for an account. There is a 
limit of three super users per account.
Contact OpenText Cloud Support Services (CSS) to create a super user for your 
account. See “Contacting Technical Support” on page 5. 
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Self-Service Administration by Super Users
Retailer, vendor and distributor administrators (super users) can add and maintain 
users for their account. They can also reset passwords, view permissions for 
defined roles, and view users assigned to a role.
There are two types of users:
■ Interactive—A retailer, vendor or distributor who uses the UI to access 

Catalogue.
■ Batch—A retailer who uses an EDI 832 document to send EDI requests to 

Catalogue to retrieve data, and a vendor or distributor who uses an EDI 832 or 
EDI 888b document to load their data into Catalogue.

Note: Super users can only add interactive users. They cannot add batch users. 
If a retailer wants to send EDI requests to Catalogue to retrieve data or a vendor 
or distributor wants use EDI 832 to load data into Catalogue, the OpenText 
administrator (super admin) must add a separate batch user for the account (with 
corresponding batch password). 
Contact OpenText Cloud Support Services (CSS) to add a batch user to your 
account. See “Contacting Technical Support” on page 5.

Adding a User
Use this procedure to add a user. 
Note: Super users can only add interactive users. They cannot add batch users or 
other super users.

To add a user
1 Click Account > User Profiles. 
The User Profiles - User List page opens displaying a list of all users for the account.

2 Click New User.
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The User Profile Setup and Maintenance page opens.

3 Complete the fields as described in the following table. 
Field Description

User ID Required. Must be unique. The following guidelines are recommended:
■ Type the first 2 letters of your company name and the last 3 numbers of the Service 

Order. The system allows both lowercase and uppercase letters. 
■ Add an A to the end of the first user ID. If you create more than one interactive user, 

add a B to the end of the second user ID, etc. 
Note: In the past, guidelines dictated that the letter C be used for the batch password 
(created by the OpenText super admin). In those cases where you want to continue with 
these guidelines, skip to the letter D for the third interactive user ID, E for the fourth 
interactive user ID, and so forth.

Network ID Required. From the drop-down list of network IDs defined by users already created under 
the account, select a network ID. 

User Name Required. Type the user’s first and last name.
User Type Required. Interactive is selected by default. Super users cannot create a batch user.
User Contact Email Required. Type the user’s email address. This is important. If the user forgets their 

password and clicks the Reset Password link on the Catalogue Login page, or if the 
super user admin resets the user’s password, the new temporary password is sent to this 
email address.

User Role Required. Select a role which determines the user’s edit and view permissions for various 
functional modules in their catalogue. Some of the most common roles are:

■ Vendor_Admin - This role allows the user to download, upload, view, edit, and delete 
data from the catalogue.

■ Vendor_bView - This role gives a user read-only access to the catalogue.
To view the existing roles in your Catalogue account, see “Viewing Access Permissions for 
Role Profiles” on page 34

Default Attribute Filter Required. Select a default attribute filter. The user can change their default filter in their 
account details.
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4 Repeat Steps 2 and 3 as needed to add additional interactive passwords.
5 Click Save. A message indicates if the information has been saved successfully. 

Updating User Information
Use this procedure to update the following user information:
■ Network ID
■ User Name
■ User Contact Email
■ User Role
■ Default Attribute Filter
■ User Status
■ Password
Note: Super users can only update interactive users. They cannot update batch 
users or other super users.

To update user information
1 Click Account > User Profiles. 

User Status Required.
■ Active - You want the user to be active. 
■ Inactive - You do not want the user to be active.

Password Expired Select the check box if you want to require the user to change the password when they 
first log in.

New Password Type a password that contains the following:
■ At least 10, but no more than 16 characters in length 
■ A minimum of 2 numeric characters
■ A minimum of 2 alpha characters
■ Both uppercase and lowercase alpha characters
■ Special characters are allowed as follows:

■ Characters allowed
~`!@#$%^&*()_+-={}|[ ]\:”;’,./?

■ Characters not allowed 
< >

Note: For more details, see “Password Requirements” on page 8.
Confirm New Password Re-type the password you entered for New Password. 

Field Description
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The User Profiles - User List page opens, displaying a list of all users for the account.

2 Filter the list by the User ID or User Name of the user you want to update.
a In the Filter bar, in the User ID box, type the user ID, or in the User 

Name box, type the user name.
b Click Filter. 

The page refreshes to display the results.
3 In the User ID column, click the hyperlink of the user you want to update.
The User Profile Setup and Maintenance page for the user opens.

4 Update the appropriate fields as described in the following table. 
Field Description

Network ID Required. From the drop-down list of network IDs defined by users already created under 
the account, select a network ID. 

User Name Required. Type the user’s first and last name.
User Type Required. Interactive is selected by default. Super users cannot create a batch user.
User Contact Email Required. Type the user’s email address. This is important. If the user forgets their 

password and clicks the Reset Password link on the Catalogue Login page, or if the 
super user admin resets the user’s password, the new temporary password is sent to this 
email address.
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5 Click Save. A message indicates if the information has been saved successfully.

Deleting a User
Use this procedure to delete a user.
Note: Super users can only delete interactive users. They cannot delete batch 
users or other super users.

To delete a user
1 Click Account > User Profiles. 

User Role Required. From the drop-down list, select a role which determines the user’s edit and 
view permissions for various functional modules in their catalogue. Some of the most 
common roles are:

■ Vendor_Admin - This role allows the user to download, upload, view, edit, and delete 
data from the catalogue.

■ Vendor_bView - This role gives a user read-only access to the catalogue.
To view the existing roles in your Catalogue account, see “Viewing Access Permissions for 
Role Profiles” on page 34.

Default Attribute Filter Required. Select a default attribute filter. The user can always change their default filter 
in their account details.

User Status Required.
■ Active - You want the user to be active. 
■ Inactive - You do not want the user to be active.

Password Expired Select the check box if you want to require the user to change the password when they 
first log in.

New Password Type a password that contains the following:
■ At least 10, but no more than 16 characters in length 
■ A minimum of 2 numeric characters
■ A minimum of 2 alpha characters
■ Both uppercase and lowercase alpha characters
■ Special characters are allowed as follows:

■ Characters allowed
~`!@#$%^&*()_+-={}|[ ]\:”;’,./?

■ Characters not allowed 
< >

Note: For more details, see “Password Requirements” on page 8.
Confirm New Password Re-type the password you entered for New Password. 

Field Description
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The User Profiles - User List page, displaying a list of all users for the account.

2 Filter the list by the User ID or User Name of the user you want to delete.
a In the Filter bar, in the User ID box, type the user ID, or in the User 

Name box, type the user name.
b Click Filter. 

The page refreshes to display the results.
3 Do one of the following:

■ In the column to the left of the User ID column, select one or more check 
boxes next to the user(s) you want to delete.

■ In the column to the left of the User ID column, select the check box at the 
top. This action selects all users on the page. Clear the check boxes of 
those users you do not want to delete.

Note: You cannot delete a batch user or other super users.
4 Click Delete. A dialog box asks you to confirm your action.
5 Click OK. The user(s) is deleted.

Activating a User
Use this procedure to activate a user. 

To activate a user
1 Click Account > User Profiles. 
The User Profiles - User List page, displaying a list of all users for the account.
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2 Filter the list by the User ID or User Name of the user you want to activate.
a In the Filter bar, in the User ID box, type the user ID, or in the User 

Name box, type the user name.
b Click Filter. 

The page refreshes to display the results.
3 Do one of the following:

■ In the column to the left of the User ID column, select one or more check 
boxes next to the user(s) you want to activate.

■ In the column to the left of the User ID column, select the check box at the 
top. This action selects all users on the page. Clear the check boxes of 
those users you do not want to activate.

Note: You cannot activate a batch user or other super users.
4 Click Activate. A dialog box asks you to confirm your action.
5 Click OK. The user(s) is activated.

Deactivating a User
Use this procedure to deactivate a user. 

To deactivate a user
1 Click Account > User Profiles. 
The User Profiles - User List page, displaying a list of all users for the account.

2 Filter the list by the User ID or User Name of the user you want to deactivate.
a In the Filter bar, in the User ID box, type the user ID, or in the User 

Name box, type the user name.
b Click Filter. 

The page refreshes to display the results.
3 Do one of the following:

■ In the column to the left of the User ID column, select one or more check 
boxes next to the user(s) you want to deactivate.
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■ In the column to the left of the User ID column, select the check box at the 
top. This action selects all users on the page. Clear the check boxes of 
those users you do not want to deactivate.

Note: You cannot deactivate a batch user or other super users.
4 Click Deactivate. A dialog box asks you to confirm your action.
5 Click OK. The user(s) is deactivated.

Changing a User’s Password
Use this procedure to change a user’s password. 

To change a user’s password
1 Click Account > User Profiles. 
The User Profiles - User List page, displaying a list of all users for the account.

2 Filter the list by the User ID or User Name of the user whose password you 
want to change.

a In the Filter bar, in the User ID box, type the user ID, or in the User 
Name box, type the user name.

b Click Filter. 
The page refreshes to display the results.

3 In the User ID column, click the hyperlink of the user whose password you 
want to change.
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The User Profile Setup and Maintenance page for the user opens.

4 In the Password Change section at the bottom of the page, complete the fields 
as described in the following table. 

5 Click Save. A message indicates if the information has been saved successfully. 
The user’s password is reset and a new temporary password is sent to the user’s 
email address specified in the User Contact Email field (see “Adding a User” on 
page 22).

Copying User Data to a Table
You can use the “Copy Data to Table” feature to download all users from an 
account into an application such as Excel.

Field Description

Password Expired Select the check box if you want to require the user to change the password when they 
first log in.

New Password Type a password that contains the following:
■ At least 10, but no more than 16 characters in length 
■ A minimum of 2 numeric characters
■ A minimum of 2 alpha characters
■ Both uppercase and lowercase alpha characters
■ Special characters are allowed as follows:

■ Characters allowed
~`!@#$%^&*()_+-={}|[ ]\:”;’,./?

■ Characters not allowed 
< >

Note: For more details, see “Password Requirements” on page 8.
Confirm New Password Re-type the password you entered for New Password. 
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The feature copies to a table the user data that displays on the User Profiles - User 
List page. You can view the data in the table or save the data to a CSV text file on 
your computer. With either method, you can copy the data from the table and 
paste it into another application, such as Excel.
Note: Be sure to set the required Internet Explorer options so you can 
successfully use this feature with IE. See “Setting Internet Explorer (IE) Options for 
Copy Data to Table” on page 98. 
If you do not set the IE options, you may experience inconsistent behavior when 
you use this feature. Sometimes the data table will appear and sometimes the 
page may flash momentarily, but there is no indication that your setting is not 
correct except that the table will not display.

To copy the user data
1 Click Account > User Profiles. 
The User Profiles - User List page, displaying a list of all users for the account.

2 On the User List page, click Copy Data to Table. 
Note: User data is copied for all pages regardless of the page that displays.
One of the following occurs:

■ A table opens displaying the user data. Go to Step 4 (you can skip Step 3 
unless the File Download dialog box opens).

■ The File Download dialog box opens asking if you want to open the file or 
save it to your computer.

Note: The File Download dialog box will always open unless you deselect the 
Always ask before opening this type of file check box. This prevents the 
“Do you want to open or save this file” question from being asked every time 
you want to copy data to a table. Continue with Step 3.
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3 Do one of the following:
■ Open - To display the Product data in a table format, click Open. Go to 

Step 4.
■ Save - To save the file as a CSV text file that you can open later in 

Microsoft Excel, click Save. The Save As dialog box opens.

Do all of the following:
■ Navigate to the location where you want to save the file.
■ In the File name box, enter a name for the file. The file name should 

have a .csv extension. For example, MensShirts.csv

■ Click Save. The file is saved to the location you selected. 
■ Cancel - To cancel your action, click Cancel.

4 Once the table is open, you can select rows and columns of Product data to 
copy. When you want to close the table, click the X in the upper right corner of 
the window. 
If you modified the table, a dialog box appears when you close the window and 
asks if you want to save your changes. 
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To save your changes, click Yes. The Save As dialog box opens. 

Do all of the following:
■ Navigate to the location where you want to save the file.
■ In the File name box, enter a name for the file. The file name should have 

a .csv extension. For example, MensShirts.csv 
■ Click Save. The file is saved to the location you selected. 

Resetting Passwords for Multiple Users 
You can use the “Reset Password” feature to reset the passwords of multiple users 
at the same time. To reset a password for a single user, see “Updating User 
Information” on page 24.

To reset passwords for multiple users
1 Click Account > User Profiles. 
The User Profiles - User List page, displaying a list of all users for the account.

Note: Passwords for multiple users can be reset only for the page that 
displays. If you have multiple pages of users, search for the users and/or 
navigate to the page of users whose passwords you want to reset. 
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2 Select the check boxes next to the names of the users whose passwords you 
want to reset.
Note: You cannot reset batch passwords or passwords for other super users. 
User IDs for which you can reset passwords display as blue links.

3 Click Reset Password. A dialog box asks if you are sure you want to reset the 
password for the selected user(s).

4 Click OK.
One or both of the following occur:

■ If an email address has been specified for a user(s), the password(s) is reset 
and an email is sent to each user’s email address specified in the User 
Contact Email field (see “Adding a User” on page 22). Each user’s email 
contains a new, unique temporary password. The user(s) is required to 
change their password the next time they log in.

■ If an email address has not been specified for a user(s) in the User Contact 
Email field, a message indicates that the password cannot be reset for that 
user(s).

Viewing Access Permissions for Role Profiles
You can view the access permissions for various functional modules in Catalogue for 
the roles defined for your account.
Note: Super users can only view existing roles. They cannot add, update, or 
delete any roles.

To view access permissions for role profiles
1 Click Account > Role Profiles. 
The Role List page opens, displaying a list of all roles defined for the account.

2 In the Role Name column, click the name of a role whose access permissions 
you want to view.
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The Role Maintenance page opens.

For various entities (functional modules) in Catalogue, you can view the access 
permissions for this role. A checked box indicates that the permission is enabled.

3 To close the page, click Cancel.

Viewing Users Assigned to a Role
You can view the users assigned to a role.

To view the users assigned to a role
1 Click Account > Role Profiles. 
The Role List page opens, displaying a list of all roles defined for the account.

2 In the Users column, click the icon for the role whose users you want to view.
The Roles - User List page opens, displaying the users assigned to this role.
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Changing a User’s Role
You can change the role assigned to a user.

To change a user’s role
1 Click Account > User Profiles. 

The User Profiles - User List page, displaying a list of all users for the account.

2 Filter the list by the User ID or User Name of the user whose role you want to 
change.

a In the Filter bar, in the User ID box, type the user ID, or in the User 
Name box, type the user name.

b Click Filter. 
The page refreshes to display the results.

3 In the User ID column, click the hyperlink of the user whose role you want to 
change.

The User Profile Setup and Maintenance page for the user opens.
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4 Complete the User Role field as described in the following table. 

5 Click Save. A message indicates if the information has been saved successfully.

Field Description

User Role Required. From the drop-down list, select a role which determines the user’s edit and 
view permissions for various functional modules in their catalogue. Some of the most 
common roles are:

■ Vendor_Admin - This role allows the user to download, upload, view, edit, and delete 
data from the catalogue.

■ Vendor_bView - This role gives a user read-only access to the catalogue.
To view the existing roles in your Catalogue account, see “Viewing Access Permissions for 
Role Profiles” on page 34
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Working With Access Rights 3
This section explains how access rights are set up and maintained for accounts and 
users in OpenText Active Catalogue. Access rights impact availability and 
functionality of pages and buttons in the application. 
This section is organized as follows: 
■ “Overview”
■ “Finding Trading Partner Access to Your Catalogue” on page 39
■ “Setting or Changing Trading Partner Access” on page 43
■ “Using Mass Update to Assign the Same Access” on page 45

Overview
Access rights can be set up for:
■ Accounts. See “Account Access”
■ Individuals. See “Individual Access” on page 39

Account Access
Account access rights are determined, set up, and maintained by the vendor. 
Vendors have access only to their own catalogues. For each of their trading 
partners (retailers), the vendor determines the data that the trading partner can 
access in the vendor’s catalogue. 
Vendors can set the degree of trading partner access to their data at one or more 
levels:
■ Account (trading partner)
■ Selection Code
■ Product
The flexibility of this feature allows a vendor to grant unrestricted access to some 
Selection Codes and or Products and restricted access to other Selection Codes 
and/or Products for each retailer.

Types of Access
For each retailer, vendors have a choice of access types that they can set at each 
level: 
■ Restricted—A retailer has no access to data at that level.
■ Unrestricted—A retailer has access to all data at that level.
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■ Selection Code—A retailer’s access to data is defined for each Selection Code.
■ Product—A retailer’s access to data is defined for each Product.

Individual Access
Individual users can have the following access rights: 
■ Edit—You can view, add, edit, delete, and download information.
■ View—You can only view information.
To find your individual user access, contact OpenText Cloud Support Services 
(CSS). See “Contacting Technical Support” on page 5. 

Finding Trading Partner Access to Your Catalogue
To find a trading partner’s current access rights to your catalogue
1 Click Administration > Trading Partner Access. The Trading Partner List 

page opens.

2 The table displays from left: 
■ Trading Partner Name—The trading partner’s name.
■ Account Number—The trading partner’s account number. 
■ Subscription Date—The date the trading partner subscribed to OpenText 

Active Catalogue.
■ Last Access Date—The date the trading partner last accessed your 

catalogue.
■ Access Type—The access type currently selected for the trading partner: 

■ Restricted—Trading partner has no access to your catalogue.
■ Selection Code—Trading partner’s access is restricted to specific 

Selection Codes.
■ Unrestricted—Trading partner has full access to your catalogue.

3 Find a trading partner in the list:
■ Click Filter to filter the list. See“Filtering the Trading Partner List” on 

page 41. 
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■ Scroll through the list.
■ Use the browse bar to move between pages.

4 Steps 4-7 are optional for drilling down to the Selection Code and Product 
levels. 
If a trading partner’s access is restricted to specific Selection Codes, you can 
view the access status for each Selection Code by clicking the Selection Code 
List hyperlink in the Access Type column. 
Note: If you have not yet defined trading partner access to the Selection 
Codes, a warning icon displays to remind you to define the access; by default, 
Selection Code access is Restricted. 
The Trading Partner Access - Selection Codes page opens. 

The access type currently selected for the Selection Code is shown in the 
Access Type column: 

■ Restricted—The trading partner has no access to this Selection Code.
■ Product—The trading partner’s access is restricted to specific Products 

under this Selection Code.
■ Unrestricted—The trading partner has full access to this Selection Code.

5 Step 5 is optional. To find a Selection Code in the list: 
■ Click Filter to filter the list. See “Filtering the Trading Partner Access - 

Selection Codes List” on page 42. 
■ Scroll through the list. 
■ Use the browse bar to move between pages.

6 Step 6 is optional for drilling down to the Product level. 
If a trading partner has Product access, you can view the access status for each 
Product by clicking the Product List hyperlink in the Access Type column.
Note: If you have not yet defined trading partner access to the Products, a 
warning icon displays to remind you to define the access; by default, Product 
access is Restricted. 
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The Trading Partner Access - Product page opens. 

The access type currently selected for the Product is shown in the Access Type 
column: 

■ Restricted—The trading partner has no access to this Product.
■ Unrestricted—The trading partner has full access to this Product.

7 Step 7 is optional. To find a Product in the list: 
■ Click Filter to filter the list. See “Filtering the Trading Partner Access 

Product List” on page 42. 
■ Scroll through the list. 
■ Use the browse bar to move between pages.

Filtering the Trading Partner List
You can use the filter to display a list of trading partners based on the criteria you 
specify. 

To filter the Trading Partner list
1 On the Trading Partner List page, enter the criteria for each of the options you 

want to filter by. You can filter on multiple options simultaneously.
■ Trading Partner Name—Enter a trading partner’s full or partial name. 
■ Account Number—Enter a trading partner’s full or partial OpenText 

account number.
■ Access Type—To display only trading partners with a specific access, from 

the drop-down list, select an access type.
■ Restricted—Show only trading partners with no access to your 

catalogue.
■ Selection Code—Show only trading partners whose access is 

restricted to specific Selection Codes.
■ Unrestricted—Show only trading partners with full access to your 

catalogue.
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■ Subscription Date on/after—To display a list of trading partners who 
subscribed to OpenText Active Catalogue on or after a specific date, enter 
that date.

2 Click Filter. The list that meets your criteria displays.
Note: To remove all filter criteria, click Clear Filter. 

Filtering the Trading Partner Access - Selection Codes List
You can use the filter to display a list of Selection Codes based on the criteria you 
specify. 

To filter the Trading Partner Access - Selection Codes list
1 On the Trading Partner Access - Selection Codes page, enter the criteria for 

each of the options you want to filter by. You can filter on multiple options 
simultaneously.

■ Selection Code—Enter a Selection Code. 
■ Selcode Description—Enter a Selection Code description.
■ Access Type—To display only Selection Codes with a specific access, from 

the drop-down list, select an access type.
■ Restricted—Show only Selection Codes in your catalogue that the 

trading partner has no access to.
■ Product—Show only Selection Codes for trading partners whose access 

is restricted to specific Products.
■ Unrestricted—Show only Selection Codes in your catalogue that the 

trading partner has full access to.
2 Click Filter. The list that meets your criteria displays.

Note: To remove all filter criteria, click Clear Filter. 

Filtering the Trading Partner Access Product List
You can use the filter to display a list of Products based on the criteria you specify. 

To filter the Trading Partner Access - Product list
1 On the Trading Partner Access - Product page, enter the criteria for each of the 

options you want to filter by. You can filter on multiple options simultaneously.
■ Product—Enter a Product. 
■ Product Description—Enter a Product description.
■ Access Type—To display only Products with a specific access, from the 

drop-down list, select an access type.
■ Restricted—Show only Products under this Selection Code that the 

trading partner has no access to.
■ Unrestricted—Show only Products under this Selection Code that the 

trading partner has full access to.
2 Click Filter. The list that meets your criteria displays.

Note: To remove all filter criteria, click Clear Filter. 
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Setting or Changing Trading Partner Access 
You can set up or change a trading partner’s access to your catalogue.

To set up or change trading partner access to your catalogue 
1 Click Administration > Trading Partner Access to find the trading partner’s 

current access. See “Finding Trading Partner Access to Your Catalogue” on 
page 39 for more details. The Trading Partner List page opens.

2 Click an option in the Access Type column to select that access for the trading 
partner: 

■ Restricted—Trading partner has no access to your catalogue.
■ Selection Code—Trading partner’s access is restricted to specific Selection 

Codes. 
■ Unrestricted—Trading partner has full access to your catalogue.

Note: The default trading partner access is either Restricted, Selection Code, 
or Unrestricted. See “Maintaining Your Account” on page 49 for more details.

3 Click Apply. 
If you selected Selection Code access, a warning icon reminds you to define 
trading partner access to Selection Codes; by default, all Selection Codes are 
Restricted.

4 Steps 4-12 are optional for drilling down to the Selection Code and Product 
levels. 
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For Selection Code access, click the Selection Code List hyperlink that 
appears in the Access Type column. The Trading Partner Access - Selection 
Codes page opens.

The table displays from left: 
■ Selection Code Name—Selection Codes in the vendor catalogue
■ Description—Selection Code Description for each Selection Code
■ Access Type—Trading partner’s current access for each Selection Code 
■ GTINs—Number of GTINs under the Selection Code
■ Images—Number of images for Products and GTINs under the Selection 

Code
5 To find a Selection Code in the list: 

■ Click Filter to filter the list. See “Filtering the Trading Partner Access - 
Selection Codes List” on page 42. 

■ Scroll through the list. 
■ Use the browse bar to move between pages.

6 Click an option in the Access Type column to select that access for the trading 
partner: 

■ Restricted—Trading partner has no access to this Selection Code.
■ Product—Trading partner’s access is restricted to specific Products under 

this Selection Code.
■ Unrestricted—Trading partner has full access to data for this Selection 

Code.
7 Click Apply.

If you selected Product access, a warning icon reminds you to define access to 
Products; by default, all Products are Restricted.

8 Steps 8-12 are optional for drilling down to the Product level. 
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For Product access, click the Product List hyperlink that appears in the Access 
Type column. The Trading Partner Access - Product page opens.

9 The table displays from left: 
■ Product Name—Products in the vendor catalogue
■ Description—Product Description for each Product
■ Access Type—Trading partner’s current access for each Product 
■ GTINs—Number of GTINs under the Product
■ Images—Number of images for GTINs under the Product

10 To find a Product in the list: 
■ Click Filter to filter the list. See“Filtering the Trading Partner Access 

Product List” on page 42. 
■ Scroll through the list. 
■ Use the browse bar to move between pages.

11 Click an option in the Access Type column to select that access for the Product: 
■ Restricted—Trading partner has no access to this Product.
■ Unrestricted—Trading partner has full access to this Product.

12 Click Apply to save changes. 

Using Mass Update to Assign the Same Access
To save time, you can assign the same access at the following levels:
■ Account (trading partner)—Assign the same access to all trading partners. See 

“To assign the same access to all trading partners using mass update” on 
page 46.

■ Selection Code—Assign the same access to all Selection Codes for a specific 
trading partner. See “To assign the same access to all Selection Codes using 
mass update” on page 46.
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■ Product—Assign the same access to all Products for a specific Selection Code. 
See “To assign the same access to all Products using mass update” on page 47.

To assign the same access to all trading partners using mass update
1 Click Administration > Trading Partners Access. 

The Trading Partner List page opens.
2 Click Mass Update. 

The Mass Update Account Access popup opens.

3 From the drop-down list, select an access to apply to all trading partners: 
■ Restricted—No trading partners have access to your catalogue.
■ Selection Code—All trading partners have specific Selection Code access 

to your catalogue which you must define.
■ Unrestricted—All trading partners have full access to your catalogue. 

Note: If you select Selection Code, don’t forget to define Selection Code 
access for each trading partner; by default, all Selection Codes are Restricted.

4 Click Apply to make the change. 
Note: If you decide you do not want to apply the change, click close to close 
the popup, and no changes will be made.

To assign the same access to all Selection Codes using mass update
1 Click Administration > Trading Partners Access. 

The Trading Partner List page opens.
2 Filter the list to display the trading partner whose Selection Code access you 

want to assign. See “Filtering the Trading Partner List” on page 41.
3 Click the Selection Code List hyperlink that appears in the Access Type 

column. 
The Trading Partner Access - Selection Codes page opens.

4 Click Mass Update. 
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The Mass Update SelCode Access popup opens.

5 From the drop-down list, select the access to apply to all Selection Codes for 
this trading partner: 

■ Restricted—This trading partner does not have access to any Selection 
Codes in your catalogue.

■ Product—This trading partner has specific Product access for each 
Selection Code in your catalogue.

■ Unrestricted—This trading partner has full access to all Selection Codes in 
your catalogue.

Note: If you select Product, don’t forget to define Product access for each 
Selection Code; by default, all Products are Restricted. 

6 Click Apply to make the change. 
Note: If you decide you do not want to apply the change, click close to close 
the popup, and no changes will be made.

To assign the same access to all Products using mass update
1 Click Administration > Trading Partners Access. 

The Trading Partner List page opens.
2 Filter the list to display the trading partner whose Selection Code access you 

want to assign. See “Filtering the Trading Partner List” on page 41.
3 Click the Selection Code List hyperlink that appears in the Access Type 

column. 
The Trading Partner Access - Selection Codes page opens.

4 Filter the list to display the Selection Code whose Product access you want to 
assign. See “Filtering the Trading Partner Access - Selection Codes List” on 
page 42.
The Trading Partner Access - Products page opens.

5 Click the Product List hyperlink that appears in the Access Type column. 
The Trading Partner Access - Product page opens.

6 Click Mass Update. 
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The Mass Update Product Access popup opens.

7 From the drop-down list, select the access to apply to all Products for this 
Selection Code: 

■ Restricted—This trading partner does not have access to any Products for 
this Selection Code.

■ Unrestricted—This trading partner has full access to all Products for this 
Selection Code.

8 Click Apply to make the change. 
Note: If you decide you do not want to apply the change, click close to close 
the popup, and no changes will be made.
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This section explains how to maintain your own account information and view the 
account information of your trading partners. 
Account information includes:
■ Account details (for you and your trading partners) such as address and contact 

data
■ Your GS1 (UCC/EAN) Company Prefix List
■ Custom field information
This section is organized as follows:
■ “Maintaining Your Account” on page 49.
■ “Viewing Your GS1 (UCC/EAN) Company Prefixes” on page 52.
■ “Viewing a Retailer’s Account and Detail Information” on page 53.
■ “Filtering the Trading Partner List” on page 53.
■ “Filtering the GS1 (UCC/EAN) Company Prefix List” on page 54.
■ “Custom Fields” on page 54.
■ “Using an EDI 888 Document to Populate Custom Field Values” on page 55
■ “Custom Field Definition Examples” on page 56.
■ “Adding a Custom Field Definition” on page 60.
■ “Editing a Custom Field Definition” on page 62.
■ “Viewing a Custom Field Definition” on page 64.
■ “Deleting a Custom Field Definition” on page 66.

Maintaining Your Account
Use the Account Setup and Maintenance page, Account Details tab to: 
■ View your account and catalogue information (for example, quantity of Products 

and GTINs).
■ Maintain your account address and contact information (available to trading 

partners).
■ Select a default attribute filter.
■ Select a preferred currency.
■ Select a preferred date format.



50 OpenText Active Catalogue CE 21.2 Browser Interface User Guide

W O R K I N G  W I T H  A C C O U N T S

Maintaining Your Account

■ Select a default email address.
■ Provide your company’s GLN (Global Location Number).
Note: If you change any information at the account level, and you have other 
information at this level that contains an asterisk, you must update that 
information by removing the asterisk before the system will allow you to save your 
changes. The following characters should not appear in any data loaded to 
OpenText Active Catalogue > ^ ` [ ] * ~ 

To view or maintain account details
1 Click Account > Account Details. 

The Account Setup and Maintenance page opens, displaying the Account 
Details tab.

2 In the Account Preferences panel, select preferences from the following drop-
down lists: 

■ Date Format—Format to view and enter dates in the browser interface.
■ Currency—Preferred monetary currency. All vendors and retailers can 

change their currency.
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■ Default Attribute Filter—Applies to all new users for the account but will 
not change default filters assigned to existing users. See “About Default 
Attribute Filters” on page 69.

3 In the Account Preferences panel select a Default Trading Partner Access 
to allow retailers to automatically have one of the following types of access to 
your catalogue:

■ Restricted—Retailers have no access to your catalogue. The default 
setting is Restricted. 

■ Selection Code—Retailers have access to only to specific Selection Codes 
in your catalogue. 

■ Unrestricted—Retailers have full access to your catalogue.
To set exceptions to the default access for individual retailers, see “Setting or 
Changing Trading Partner Access” on page 43. 
Note: If any exceptions to the default access have been granted to individual 
retailers, the Default Trading Partner Access options become read-only. 
This protects against the loss of all lower level access settings, since changing 
the default would discard the lower level settings. 
The mass update option on the Trading Partner Access screen (Administration 
> Trading Partner Access) allows mass access updates, and if there are no 
exceptions set, the Default Trading Partner Access options are re-enabled.

4 In the Account Preferences panel, in the MSRP Disclaimer box, enter text for 
an MSRP disclaimer if you want to display a disclaimer with the Suggested 
Retail Price attribute (displays on the GTIN detail page).

5 In the Company Information panel, complete the following:
■ Your company’s information - Type in your company’s information. You 

can enter only one email address in the E-mail Address field (maximum of 
1024 characters).

Note: The following characters should not appear in any data loaded 
to OpenText Active Catalogue > ^ ` [ ] * ~ For telephone and fax 
numbers, do not use dashes, decimals, or parentheses.

■ The GLN (Global Location Number) - (Optional) Type in your 
company’s GLN.

6 In the Contact panel, type in your company’s contact information. You can 
enter multiple email addresses as long as each address is separated by a 
semicolon (maximum of 1024 characters for the entire field). 
Note that the Primary contact email address you enter is the address to which 
Catalogue:

■ Sends a separate email for each EDI document that contains errors 
(refer to “Step 7 in the section “How Catalogue Processes Batch Files” 
on page 235).

■ Notifies you by email when data is non-compliant (refer to “Email 
Notifications for Compliance Checks” on page 122)
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■ Sends a Load Status Report (LSR) if you have the LSR and the LSR 
email option enabled for your account (refer to “Load Status Report” on 
page 184).

Note: The following characters should not appear in any data loaded to 
OpenText Active Catalogue > ^ ` [ ] * ~ For telephone and fax numbers, do 
not use dashes, decimals, or parentheses.

7 Click Save. A message indicates if the information has been saved successfully. 

Viewing Your GS1 (UCC/EAN) Company Prefixes
GS1 (UCC/EAN) company prefixes are also called Manufacturer Block IDs. Vendors 
can view a list of their prefixes. Only OpenText Administrators can add, change, or 
delete prefixes in OpenText Active Catalogue.
Note: Check your GS1 company prefixes to be sure that they are valid. OpenText 
does not recommend using invalid GS1 company prefixes, as it may result in 
chargebacks from some of your retailers.

To view your GS1 (UCC/EAN) prefixes
1 Click Account > Account Details. 

The Account Setup and Maintenance page opens, displaying the Account 
Details tab.

2 Click the GS1 (UCC/EAN) Company Prefixes tab. 
The GS1 (UCC/EAN) Company Prefixes page displays prefixes for your account 
and indicates whether or not they are active prefixes. An “inactive” prefix 
means the prefix is no longer used.

You should be aware of the following:
■ If the Prefix Validation compliance check is turned on, and a GTIN uses a GS1 

company prefix that is not associated with your account, you cannot add or 
modify the GTIN. 
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■ If the Prefix Validation compliance check is turned off, a GTIN using a GS1 
company prefix that is not associated with your account can be added or 
modified (resulting in non-compliant data). 

See Chapter 8, "Working with Compliance Checks," on page 120 for detailed 
information.

Viewing a Retailer’s Account and Detail Information
To find a retailer’s account and detail information
1 Click Administration > Trading Partner Access. 

The Trading Partner List page opens. The table displays from left: 
■ Trading Partner Name—The retailer’s name 
■ Account Number—The retailer’s account number 
■ Subscription Date—The date the retailer subscribed to OpenText Active 

Catalogue
■ Last Access Date—The date the retailer last accessed your catalogue
■ Access Type—The access type currently selected for the retailer

■ Restricted—Retailers with no access to your catalogue
■ Unrestricted—Retailers with full access to your catalogue
■ Selection Code—Retailers with access restricted to specific Selection 

Codes 
2 To locate a retailer in the list, do any of the following:

■ Filter the list. See “Filtering the Trading Partner List” on page 53. 
■ Scroll through the list.
■ Use the browse bar to move between pages.

3 To view details such as a retailer’s address and contact information, click the 
retailer’s account name hyperlink in the Trading Partner Name column. 

Filtering the Trading Partner List 
You can use the filter to display a list of retailers based on the criteria you specify. 

To filter the Trading Partner list
1 On the Trading Partner List page, enter the criteria for each of the options you 

want to filter by. You can filter on multiple options simultaneously.
■ Trading Partner Name—Enter a retailer’s full or partial name. 
■ Account Number—Enter a retailer’s full or partial OpenText Active 

Catalogue account number.
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■ Subscription Date on/after—To display a list of retailers who opened 
OpenText Active Catalogue accounts on or after a specific date, enter that 
date.

■ Access Type—To display only retailers with a specific access, select an 
access type from the drop-down list:

■ Restricted—Show only retailers who have no access to your catalogue.
■ Unrestricted—Show only retailers who have full access to your 

catalogue.
■ Selection Code—Show only retailers whose access is restricted to 

specific Selection Codes. 
2 Click Filter. 

The list that meets your criteria displays.
Note: To remove all filter criteria, click Clear Filter.

Filtering the GS1 (UCC/EAN) Company Prefix List
Filter a GS1 (UCC/EAN) Company Prefix list to display only certain prefixes. 

To filter a GS1 (UCC/EAN) Company Prefix list
1 Navigate to the Account Setup and Maintenance page, and click the GS1 

(UCC/EAN Company Prefixes tab. 
See “Viewing Your GS1 (UCC/EAN) Company Prefixes” on page 52.

2 From the Active drop-down list, select one of the following:
■ Yes—Show only active prefixes
■ No—Show only inactive prefixes (no longer used by the vendor)

3 Click Filter. The list that meets your criteria displays.
Note: To remove all filter criteria, click Clear Filter.

Custom Fields
Catalogue supports account-specific custom fields (attributes) at the Product level, 
thereby allowing Intelligent Web Forms (IWF) integration with Catalogue. 
The vendor must first add the custom fields (called custom field definitions) using 
the browser user interface (UI). Once the fields are added, they can be populated 
by either the vendor (using the UI, an EDI 888 document, or web services) or the 
retailer (using the UI or web services).
For more information about Catalogue’s web service capability, see the OpenText 
Active Catalogue Web Services Guide.
Use the following topics to understand and work with custom field definitions and 
values: 
■ “Using an EDI 888 Document to Populate Custom Field Values” on page 55
■ “Custom Field Definition Examples” on page 56
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■ “Adding a Custom Field Definition” on page 60
■ “Editing a Custom Field Definition” on page 62
■ “Viewing a Custom Field Definition” on page 64
■ “Deleting a Custom Field Definition” on page 66
■ “Adding and Editing Custom Field Values for a Product” on page 131

Using an EDI 888 Document to Populate Custom Field Values
If you are going to use an EDI 888 document to populate the values of your 
custom fields, you must indicate the specific EDI location that will provide those 
values; you specify this EDI location at the time you create the custom field 
definition. 
If you want the EDI location to accommodate different values depending on a 
qualifier, you can specify an EDI qualifier location/value pair. You complete these 
fields when you create (add) a custom field definition. The fields are defined as 
follows:
■ EDI Location - The EDI Location field (segment and position) holds the 

custom field value associated with the Product for a specific vendor/retailer 
relationship. For example, N102 (N1 is the segment and 02 is the position) holds 
the custom field value.

■ EDI Qualifier Location/Value pair - If you want the EDI Location field to 
accommodate multiple values depending on a qualifier, you can specify an EDI 
qualifier location/value pair. The EDI Qual. Loc. field holds the EDI location of 
the EDI qualifier value (EDI Qual. Value field) which determines the custom 
field value to associate with the Product for a specific vendor/retailer 
relationship. 

For example, you create two custom field definitions (CustomFieldOne and 
CustomFieldTwo), both with an EDI Location of N102 and an EDI Qual. Loc. of 
N101. 
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CustomFieldOne has an EDI Qual. Value of CD and CustomFieldTwo has an EDI 
Qual. Value of EF.

If N101=CD, then N102 is the custom field value for CustomFieldOne.
If N101=EF, then N102 is the custom field value for CustomFieldTwo.
For additional examples, see “Custom Field Definition Examples” on page 56.

EDI Location from Header Segment
When you create custom field definitions, there might be a situation where there 
are two custom field definitions that both have the same EDI Location (for 
example, N104), but one custom field definition refers to the Header level and one 
refers to the Detail level. 
In these cases, you can select the EDI Location from Header Segment check 
box to indicate that the EDI Location for one of the definitions is determined by 
the segment at the Header level (implying that one retailer-specific custom value 
applies to all of the products named in a particular loop). 
For the other definition, you do not select the check box. This indicates that the 
EDI Location is determined by the segment at the Detail level (another N104 in 
the loop at the detail level has a value that is specific to each product for each 
retailer).

Custom Field Definition Examples
This section provides several examples of custom field definitions:
■ “Using EDI Location to Determine the Custom Field Value” on page 57
■ “Using EDI Qualifier Location/Value Pair to Determine the Custom Field Value” on 

page 57
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■ “Using EDI Qualifier Location/Value Pairs to Determine Multiple Custom Field 
Values” on page 59

Using EDI Location to Determine the Custom Field Value
This example shows how to use EDI Location to provide the custom field value.
You define a custom field with the specifications shown and name it Retailer 
Info.

Here is an example of a line from an EDI 888 document showing the G39 segment:

G39***STNP22Y********************VN*220172TSITC

Catalogue looks in the G3903 element (position 03 of the G39 segment) for the 
value to store in this custom field. 
In this example, Catalogue finds the value STNP22Y in the G3903 element. 
Catalogue stores STNP22Y in this custom field (Retailer Info) for the retailer that is 
specified in the N1 header segment (GROCRET, account number 125106201800), 
as shown below.

ISA*00*          *01*R7155D    *01*0036051840     *12*5109654406     
*101228*2304*^*00403*460000099*0*T*>
GS*QG*0036051840*5109654406*20101228*2304*6*X*004030
ST*888*1001
N1*ST*GROCRET*91*125106201800

Using EDI Qualifier Location/Value Pair to Determine the 
Custom Field Value

This example shows how to use EDI Location to provide the custom field value 
based on the values in the EDI Qual. Loc. and EDI Qual. Value fields.
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Define a custom field with the specifications shown, and name it DE7973.

The EDI Qual. Loc. is the location of the qualifier. For this custom field, it is G3902.
The EDI Qual. Value is the value of the qualifier. For this custom field, it is CB.
Here is an example of a line from an EDI 888 document showing the G39 segment:

G39**CB*STNP22Y********************VN*220172TSITC

Catalogue looks in the G3902 element (position 02 of the G39 segment). If the 
value is CB, Catalogue looks in the G3903 element (position 03 of the G39 
segment) for the value to store in this custom field. 
In this example, Catalogue finds the value STNP22Y in the G3903 element. 
Catalogue stores STNP22Y in this custom field (DE7973) for the retailer that is 
specified in the N1 header segment (GROCRET, account number 125106201800), 
as shown below.

ISA*00*          *01*R7155D    *01*0036051840     *12*5109654406     
*101228*2304*^*00403*460000099*0*T*>
GS*QG*0036051840*5109654406*20101228*2304*6*X*004030
ST*888*1001
N1*ST*GROCRET*91*125106201800

Note: The N1 segment at the header level, immediately following the ST 
segment, is the segment that is used to determine the retailer to whom the custom 
field applies (N1*ST*GROCRET*91*125106201800).
If there is another retailer account specified in the 03/04 positions in the N1 
segment within the G39 loop, it is ignored (N1*ST*RETAILER*91*125106201811). Refer 
to the sample code below.

ISA*00*          *01*R7155D    *01*0036051840     *12*5109654406     
*101228*2304*^*00403*460000099*0*T*>
GS*QG*0036051840*5109654406*20101228*2304*6*X*004030
ST*888*1001
N1*ST*GROCRET*91*125106201800
G62*09*20101228*W*230426
G53*003
LX*1
G39**CB*STNP11********************VN*220007SITC
N9*PA*P11STN
N9*CN*P21STN
N9*6O*P22STN
N1*ST*RETAILER*91*125106201811
SE*11*1001
GE*1*6
IEA*1*460000099

Catalogue uses the account
information in this segment.

Catalogue ignores the account
information in this segment.
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Using EDI Qualifier Location/Value Pairs to Determine 
Multiple Custom Field Values

This example shows how you can obtain more than one custom field value from 
the same EDI Location, depending on the values in the EDI Qual. Loc. and EDI 
Qual. Value fields.
Define a custom field with the specifications shown, and name it Retailer-
Specific-PID.

The EDI Qual. Loc. is the location of the qualifier. For this custom field, it is G3902.
The EDI Qual. Value is the value of the qualifier. For this custom field, it is CB.
Define another custom field with the specifications shown, and name it Ship-To-
Number. 

The EDI Qual. Loc. is the location of the qualifier. For this custom field, it is G3902.
The EDI Qual. Value is the value of the qualifier. For this custom field, it is ST.
Here is an example of a line from an EDI 888 document showing the G39 segment:

G39**CB*STNP22Y********************VN*220172TSITC

Catalogue looks in the G3902 element (position 02 of the G39 segment). 
If the value is CB, Catalogue looks in the G3903 element (position 03 of the G39 
segment) for the value to store in this custom field. In this case, the value 
corresponds to STNP22Y.
In this example, Catalogue finds the value STNP22Y in the G3903 element. 
Catalogue stores STNP22Y in this custom field (Retailer-Specific-PID) for the 
retailer that is specified in the N1 header segment (GROCRET1, account number 
125106201800), as shown below.
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ISA*00*          *01*R7155D    *01*0036051840 *12*5109654406     
*101228*2304*^*00403*460000099*0*T*>
GS*QG*0036051840*5109654406*20101228*2304*6*X*004030
ST*888*1001
N1*ST*GROCRET1*91*125106201800

Here is an example of a line from a different EDI 888 document showing the G39 
segment:

G39**ST*STNP35W********************VN*220172TSITC

Catalogue looks in the G3902 element (position 02 of the G39 segment). 
If the value is ST, Catalogue looks in the G3903 element (position 03 of the G39 
segment) for the value to store in this custom field. In this case, the value 
corresponds to STNP35W.
In this example, Catalogue finds the value STNP35W in the G3903 element. 
Catalogue stores STNP35W in this custom field (Ship-To-Number) for the retailer 
that is specified in the N1 header segment (GROCRET2, account number 
135107204808), as shown below.

ISA*00*          *01*R7155D    *01*0036051841 *12*5109654407 
*101228*2304*^*00403*460000099*0*T*>
GS*QG*0036051840*5109654407*20101228*2304*6*X*004030
ST*888*1001
N1*ST*GROCRET2*91*135107204808

Adding a Custom Field Definition
To add a custom field definition
1 Click Account > Account Details. The Account Setup and Maintenance page 

opens, displaying the Account Details tab.
2 Click the Custom Field Definitions tab. 

Custom field information displays for existing custom fields.



W O R K I N G  W I T H  A CC O U N T S
Adding a Custom Field Definition

OpenText Active Catalogue CE 21.2 Browser Interface User Guide  61

4

3 Click Add. 
The Custom Field Definitions pop-up opens.

4 Complete the following fields:
■ Name—Required. Type the name of the custom field.
■ Label—Optional, but if you leave it blank, the system creates a label that is 

identical to the name. Type a description for the custom field that identifies 
the field and has meaning to you. The description does not need to be 
unique.

■ EDI Qual. Loc.—Optional, but must be present if EDI Qual. Value is 
present.
Type the EDI location for the qualifier. The location consists of the EDI 
segment and position. For example, type N101. N1 refers to the segment 
and 01 refers to the field position.

■ EDI Qual. Value—Optional, but must be present if EDI Qual. Loc. is 
present.
Type a value for the EDI qualifier. For example, type ST.

■ EDI Location—Required if an EDI 888 document is used to populate 
custom field values (optional, if the UI is used to populate values). 
Type the EDI location (segment and position) that holds the value 
associated with this Product for a specific vendor/retailer relationship. For 
example, type N102. 

■ EDI Location from Header segment?—Optional. Select the check box 
to indicate that you want EDI Location (segment and position) to be 
determined by the Header level (not the Detail level).

Note: Use this check box for situations where there are two custom 
field definitions that both have the same EDI Location (for example, 
N104), but one custom field definition refers to the Header level and 
one refers to the Detail level. The custom definition that refers to the 
Header level has this check box selected.

■ Type—Required. From the drop-down list, select the data type for the 
value associated with this Product for a specific vendor/retailer 
relationship. The value resides in the location specified by EDI Location 
(for example, N102):

■ Text—Indicates that the value is alphanumeric
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■ Number—Indicates that the value is numeric
■ Length—Required. Type the maximum length for the value. 
■ Precision—If you selected Number in the Type field, enter the maximum 

number of digits that are allowed to the right of the decimal point for the 
value. If the number is not a decimal, leave this field blank.

■ Supports multiline values—Optional. Select the check box to create a 
custom field definition that allows you to define multiple lines of custom 
field values for a single custom field.

Note: If you select the check box, and then clear it, a dialog box asks 
you to verify that you want to make the change. If you click OK and 
save your changes, you are effectively changing the custom field from 
supporting multiline values to only supporting a single value. This 
results in the deletion of all custom field values except the first one for 
each account, for all accounts in which the custom field definition is 
being used.

See “Using an EDI 888 Document to Populate Custom Field Values” on page 55 
for a more detailed explanation of how some of these fields are used.

5 Click Save.
The new custom field is added and displays in the table on the Custom Field 
Definitions tab.

Editing a Custom Field Definition
To edit a custom field definition
1 Click Account > Account Details. The Account Setup and Maintenance page 

opens, displaying the Account Details tab.
2 Click the Custom Field Definitions tab. 

Custom field information displays for existing custom fields.
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3 In the Name column, click the hyperlink of the custom field definition that you 
want to edit.
The Custom Field Definitions pop-up opens.

4 Edit the following fields:
■ Name—Required. Type the name of the custom field.
■ Label—Optional, but if you leave it blank, the system creates a label that is 

identical to the name. Type a description for the custom field that identifies 
the field and has meaning to you. The description does not need to be 
unique.

■ EDI Qual. Loc.—Optional, but must be present if EDI Qual. Value is 
present.
Type the EDI location for the qualifier. The location consists of the EDI 
segment and position. For example, type N101. N1 refers to the segment 
and 01 refers to the field position.

■ EDI Qual. Value—Optional, but must be present if EDI Qual. Loc. is 
present.
Type a value for the EDI qualifier. For example, type ST.

■ EDI Location—Required if an EDI 888 document is used to populate 
custom field values (optional, if the UI used to populate values).
Type the EDI location (segment and position) that holds the value 
associated with this Product for a specific vendor/retailer relationship.

■ EDI Location from Header segment?—Optional. Select the check box 
to indicate that you want EDI Location (segment and position) to be 
determined by the Header level (not the Detail level).

Note: Use this check box for situations where there are two custom 
field definitions that both have the same EDI Location (for example, 
N104), but one custom field definition refers to the Header level and 
one refers to the Detail level. The custom definition that refers to the 
Header level has this check box selected.

■ Type—Required. From the drop-down list, select the data type for the 
value associated with this Product for a specific vendor/retailer 
relationship. The value resides in the location specified by EDI Location 
(for example, N102):

■ Text—Indicates that value is alphanumeric
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■ Number—Indicates that the value is numeric
■ Length—Required. Type the maximum length for the value you want to 

associate with the Product. 
■ Precision—If you selected Number in the Type field, enter the maximum 

number of digits that are allowed to the right of the decimal point for the 
value you want to associate with the Product. If the number is not a 
decimal, leave this field blank.

■ Supports multiline values—Optional. Select the check box to create a 
custom field definition that allows you to define multiple lines of custom 
field values for a single custom field definition.

Note: If the check box was originally selected and you clear it, a 
dialog box asks you to verify that you want to make the change. If you 
click OK and save your changes, you are effectively changing the 
custom field from supporting multiline values to only supporting a single 
value. This results in the deletion of all custom field values except the 
first one for each account, for all accounts in which the custom field 
definition is being used.

See “Using an EDI 888 Document to Populate Custom Field Values” on page 55 
for a more detailed explanation of how some of these fields are used.

5 Click Save.
The custom field definition is saved and displays in the table on the Custom 
Field Definitions tab.

Viewing a Custom Field Definition
To view a custom field definition
1 Click Account > Account Details. The Account Setup and Maintenance page 

opens, displaying the Account Details tab.
2 Click the Custom Field Definitions tab. 

Custom field information displays for existing custom fields.
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3 In the Name column, click the hyperlink of the custom field definition you want 
to view.
The Custom Field Definitions pop-up opens.

4 View the following fields:
■ Name—The name of the custom field.
■ Label—The description for the custom field.
■ EDI Qual. Loc.—Present if EDI Qual. Value is present.

The EDI location for the qualifier. The location consists of the EDI segment 
and position. For example, N101. N1 refers to the segment and 01 refers to 
the field position.

■ EDI Qual. Value—Present if EDI Qual. Loc. is present.
The value for the EDI qualifier.

■ EDI Location—Specified if an EDI 888 document is used to populate 
custom field values (optional, if the UI used to populate values).The EDI 
location (segment and position) that holds the value associated with this 
Product for a specific vendor/retailer relationship. 

■ EDI Location from Header segment?—If the check box is selected, 
EDI Location (segment and position) is determined by the Header level 
(not the Detail level).

Note: This check box is used for situations where there are two 
custom field definitions that both have the same EDI Location (for 
example, N104), but one custom field definition refers to the Header 
level and one refers to the Detail level. The custom definition that refers 
to the Header level has this check box selected.

■ Type—The data type for the value associated with this Product for a 
specific vendor/retailer relationship. The value resides in the location 
specified by the EDI Location field (for example, N102):

■ Text—Indicates that the value is alphanumeric
■ Number—Indicates that the value is numeric

■ Length—The maximum length for the value you want to associate with 
the Product. 

■ Precision—If Number is selected in the Type field, this value is the 
maximum number of digits that are allowed to the right of the decimal 
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point for the value that is associated with the Product. If the number is not 
a decimal, this field is blank.

■ Supports multiline values—If the check box is selected, the custom 
field definition allows you to define multiple lines of custom field values for 
a single custom field definition.

See “Using an EDI 888 Document to Populate Custom Field Values” on page 55 
for a more detailed explanation of how some of these fields are used.

Deleting a Custom Field Definition
When you delete a custom field definition, all custom field values associated with 
that custom field definition are also deleted. A retailer will not be able to view 
deleted custom field definitions or deleted custom field values.

To delete a custom field definition
1 Click Account > Account Details. The Account Setup and Maintenance page 

opens, displaying the Account Details tab.
2 Click the Custom Field Definitions tab. 

Custom field information displays for existing custom fields.

3 Select the check box to the left of the custom field definition you want to 
delete. 

4 Click Delete. A message asks if you want to proceed with deletion of the 
custom field definition. 

5 Do one of the following:
■ To delete the custom field definition, click OK. A message confirms the 

deletion or reports an error. 
■ To cancel the deletion, click Cancel.

Note: When you delete a custom field definition, all custom field values 
associated with that custom field definition are also deleted. A retailer will not 
be able to view deleted custom field definitions or deleted custom field values.
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Working with Attribute 
Filters 5

OpenText Active Catalogue supports hundreds of GTIN attributes, many of which 
are not applicable to each GTIN. For example, a merchandise and apparel account 
typically will use an attribute filter that does not include nutritional facts attributes.
This section explains how to apply, create, and modify attribute filters to restrict 
the display and export of attributes to only those attributes relevant to your 
business.  
The currently active attribute filter is displayed at the top of the pages listing GTIN 
attributes. 
The two types of attribute filters are: 
■ System filters—Maintained by OpenText Administrators 
■ Account filters—Created, maintained, and applied by users in the account
Some accounts may use only System filters. 
This section is organized as follows:
■ “Attribute Filter Access Rights” on page 68.
■ “GTIN Attribute Groups” on page 69.
■ “About Default Attribute Filters” on page 69.
■ “Finding Attribute Filters” on page 70.
■ “Filtering the Attribute Filter List” on page 71.
■ “Viewing an Attribute Filter” on page 71.
■ “Applying an Attribute Filter to Your Current Session” on page 72.
■ “Assigning a User Default Attribute Filter for Future Sessions” on page 72.
■ “Adding an Attribute Filter” on page 73.
■ “Adding an Attribute Filter By Copying and Modifying an Existing Filter” on 

page 74.
■ “Editing an Attribute Filter” on page 74.
■ “Deleting an Attribute Filter” on page 75.

Attribute Filter Access Rights
The following user access rights apply to working with attribute filters:
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■ Edit—You can add, edit, delete and apply Account attribute filters, apply System 
attribute filters, and select a filter for a download or subscription profile.

■ View—You cannot add, edit, or delete filters, but can apply filters and select a 
filter for a download or subscription profile. 

■ Restricted—You can view but not work with or apply attribute filters.

GTIN Attribute Groups
The hundreds of GTIN attributes supported by OpenText Active Catalogue are 
organized in Attribute Groups.
An attribute filter contains one or more Attribute Groups. The filter may or may not 
include all of the attributes in an Attribute Group. 
The GTIN details pages list all attributes contained in an Attribute Group and 
included in the attribute filter currently applied during the browser session. See 
“Viewing GTIN Details” on page 95. 
The OpenText Active Catalogue Attribute Groups are as follows: 

About Default Attribute Filters 
OpenText assigns the account's default attribute filter to all new users. The default 
filter is automatically applied when you log on.
Accounts interfacing with the GDS network generally use the GDSN filter as the 
default attribute filter when creating and viewing the GTIN information.
Default filters exist at the account level, not the individual user level. 
Note: If you change your account's default attribute filter, the change will apply 
only to users added to your account after the change. Existing users will retain 
their existing default filter. 
After logging on, you can temporarily override the default attribute filter by 
applying a filter. See “Applying an Attribute Filter to Your Current Session” on 
page 72. 
You can change the default attribute filter from two locations:
■ Account > Account Details
■ Administration > Account Attribute Filters

■ Common Logistics ■ Hardlines
■ Common Retail ■ Nutrition
■ Extended Logistics ■ Nutritional Supplements
■ Extended Retail ■ Pet Food
■ GDSN ■ Pharmaceutical
■ GDSN Optional
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To change the account default attribute filter from Account category
1 Click Account > Account Details. The Account Details page opens.
2 On the Account Details tab, from the Default Attribute Filter drop-down list, 

select an attribute filter.
3 Click Save. 

To change the account default attribute filter from Administration 
category
1 Click Administration > Account Attribute Filters. The Attribute Filter List 

page opens.
2 Select the attribute filter you want to assign as your account default attribute 

filter.
3 Click Account. A message indicates that the attribute filter was successfully set 

as your account default filter.

Finding Attribute Filters
Find an attribute filter so that you can do one of the following:
■ View the attributes it contains
■ Apply it as the account default attribute filter. See “About Default Attribute 

Filters” on page 69.
■ Apply it as your own temporary filter during the current session. See “Applying 

an Attribute Filter to Your Current Session” on page 72

To find an attribute filter
1 Click Administration > Account Attribute Filters. The Attribute Filter List 

page opens listing all System and Account attribute filters. 

The table displays from left:
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■ Check box to select an attribute filter to delete, copy, or assign as an 
account or user default attribute filter.

■ Filter Name—The name of the filter.
■ Filter Description—The description of the filter.
■ Filter Type—Whether the filter is a system or account filter

2 To find an attribute filter, do any of the following: 
■ Click Filter to filter the Attribute Filter List. See “Filtering the Attribute 

Filter List” on page 71.
■ Scroll through the list.
■ Use the browse bar to move between pages.

Filtering the Attribute Filter List
You can use the filter to display a list of attribute filters based on the criteria you 
specify. 

To filter the Attribute Filter list
1 On the Attribute Filter List page, enter the criteria for each of the options you 

want to filter by. You can filter on multiple options simultaneously.
■ Filter Name—Enter an attribute filter’s full or partial name. 
■ Filter Type—To display only attribute filters of a specific type, from the 

drop-down list, select a filter type.
■ System—Show only system attribute filters.
■ Account—Show only account attribute filters.

2 Click Filter. The list that meets your criteria displays.
Note: To remove all filter criteria, click Clear Filter. 

Viewing an Attribute Filter
By viewing an attribute group, you see the following:
■ A list of attribute groups that are included in a filter
■ The attributes that are in included in a filter
■ The order in which the attribute groups are displayed on the page in the filter
To change a filter’s characteristics, see “Editing an Attribute Filter” on page 74.

To view an attribute filter
1 Find the attribute filter. See “Finding Attribute Filters” on page 70. 
2 Click the attribute filter name hyperlink in the Filter Name column. The 

Attribute Filter List (tree view) page opens displaying a tree view of the 
attribute groups. 
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3 Click the arrow next to All Attributes to expand the tree to see the attribute 
groups. A check mark next to an attribute group indicates that the attribute 
group is included in the filter (although not all attributes in a group are 
necessarily selected to be in the filter).

4 To view an group’s attributes and their format and definition, and to see which 
attributes are included in the filter, click the arrow next to an attribute group to 
expand the tree. A check mark next to an attribute indicates that the attribute 
is in the filter. Move your cursor over an attribute to view an attribute’s format 
(allowable data type and length) and definition. 

5 The order in which the attribute groups are displayed in the filter is the order 
that they are displayed on a page (not in exports) when the filter is used.

Applying an Attribute Filter to Your Current Session
To use a different filter in your current session 
1 Click Administration > Account Attribute Filters. The Attribute Filter List 

page opens. 
2 Find the attribute filter you want to use. See “Finding Attribute Filters” on 

page 70. 
3 Select the check box next to the attribute filter you want to apply to your 

current session.
4 Click Apply. The selected filter is active until you apply a different filter or log 

out. When you log in again, your account default attribute filter is applied. 

Assigning a User Default Attribute Filter for Future Sessions
To assign a user default filter for future sessions 
1 Click Administration > Account Attribute Filters. The Attribute Filter List 

page opens. 
2 Find the attribute filter you want to assign as your user default filter. See 

“Finding Attribute Filters” on page 70. It will be applied each time you log in. It 
is active until you apply a different filter.
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3 Click User. A message indicates that the attribute filter was successfully set as 
your user default filter. 

Adding an Attribute Filter
You can create an attribute filter from scratch or copy an existing filter and modify 
it. See “Adding an Attribute Filter By Copying and Modifying an Existing Filter” on 
page 74.

To add an attribute filter
1 Click Administration > Account Attribute Filters. The Attribute Filter List 

page opens. 
2 Click Add. The Attribute Filter List (tree view) page opens. 

3 Enter a Filter Name and a Filter Description. The filter name must be 
unique and cannot be changed once the filter is saved. 

4 The order in which the attribute groups are displayed in the filter is the order 
that they are displayed on a page (not in exports) when the filter is used. To 
change the sequence position, click the up and down arrows to the right of the 
attribute group to move it up or down in the list.

5 Click the arrow next to an attribute group to expand the tree and display the 
attributes that are in that group. 

6 To include an attribute in your filter, select the check box next to the attribute. 
Move your cursor over an attribute to view an attribute’s format (allowable data 
type and length) and definition.
Note: Selecting a check box at the attribute group level selects all attributes 
in that group. You can clear the attributes you do not want to include in the 
filter by deselecting individual attributes. Clearing a check box at the attribute 
group level clears all attributes in that group.

7 Click Save to save the filter. 
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Adding an Attribute Filter By Copying and Modifying an 
Existing Filter

To save time adding a new filter, you can copy an existing filter and modify it. The 
Attribute Groups, their display order, and the attributes in the selected filter will be 
copied for the new filter. You can modify these as needed. 

To add an attribute filter by copying and modifying an existing filter
1 Click Administration > Account Attribute Filters. The Attribute Filter List 

page opens. 
2 Find the Attribute Filter that you want to copy and modify for the new filter. See 

“Finding Attribute Filters” on page 70. 
3 Click Copy. The Attribute Filter List (tree view) page opens. 

4 Change the Filter Name and Filter Description. The filter name must be 
unique and cannot be changed once the filter is saved. 

5 The order in which the attribute groups are displayed in the filter is the order 
that they are displayed on a page (not in exports) when the filter is used. To 
change the sequence position, click the up and down arrows to the right of the 
attribute group to move it up or down in the list.

6 Click the arrow next to an attribute group to expand the tree and display the 
attributes that are in that group. To add or remove attributes in your filter, 
select or clear the check box next to the attribute. Move your cursor over an 
attribute to view an attribute’s format (allowable data type and length) and 
definition.

7 Selecting a check box at the attribute group level selects all attributes in that 
group. You can clear the attributes you do not want to include in the filter by 
deselecting individual attributes. Clearing a check box at the attribute group 
level clears all attributes in that group.Click Save to save the filter. 

Editing an Attribute Filter
You can edit Account filters, but not System filters. You cannot edit a filter name. 

To edit an Account attribute filter
1 Click Administration > Account Attribute Filters. The Attribute Filter List 

page opens.



W O RK I N G  W I T H A T T R I B U T E  F I L T E R S
Deleting an Attribute Filter

OpenText Active Catalogue CE 21.2 Browser Interface User Guide  75

5

2 Click the attribute filter name hyperlink in the Filter Name column. The 
Attribute Filter List (tree view) page opens displaying a tree view of the 
attribute groups. 

3 Find the attribute filter to edit. See “Finding Attribute Filters” on page 70. 
4 The order in which the attribute groups are displayed in the filter is the order 

that they are displayed on a page (not in exports) when the filter is used. To 
change the sequence position, click the up and down arrows to the right of the 
attribute group to move it up or down in the list.

5 Click the arrow next to an attribute group to expand the tree and display the 
attributes that are in that group. To add or remove attributes in your filter, 
select or clear the check box next to the attribute. Move your cursor over an 
attribute to view an attribute’s format (allowable data type and length) and 
definition.
Note: Selecting a check box at the attribute group level selects all attributes 
in that group. You can clear the attributes you do not want to include in the 
filter by deselecting individual attributes. Clearing a check box at the attribute 
group level clears all attributes in that group.

6 Click Save to save the edited filter.

Deleting an Attribute Filter
Users can delete an Account attribute filter if the filter is not the current default 
attribute filter for the account. Only OpenText Administrators can delete System 
filters.

To delete an attribute filter

1 Click Administration > Account Attribute Filters. The Attribute Filter List 
page opens. 

2 Find the attribute filter to delete. See “Finding Attribute Filters” on page 70. 
3 Select the check box to the left of the filter name.
4 Click Delete. A message box asks if you want to delete the selected filter. 
5 To permanently delete the filter, click OK. 
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This section explains how to find and view vendor catalogue data. Vendors can 
search only their own catalogues. Retailers can search all catalogues to which they 
have access (either full catalogue access, or access only to specific Selection 
Codes).
Product data in a vendor catalogue is organized in a three-level structure: 
■ Selection Codes—3-digit identifiers for the broadest product groups in a 

catalogue, (for example, 300 is men's clothing); also used to restrict retailer 
access when retailer does not have unrestricted access to a catalogue

■ Products—Specific Products under a Selection Code (for example, Vendor Item 
No., Style No.)

■ GTINs—Specific items under a Product (for example, 123456123456, a 36-inch, 
leather belt) 

Vendors create and maintain their own Selection Codes, Products, and GTINs. 
Retailers with access to a vendor catalogue can view, download, and subscribe to 
automatic updates of vendor data. They can also add or edit custom field values 
for custom fields that have been previously defined by a vendor.
Both vendors and retailers can view an Item Search Ratio Report (see “Item 
Search Ratio Report” on page 182) which shows the ratio of found versus missed 
GTINs. The report is based on accounts for which there is data (with a maximum 
of 12 months of data). 
■ Retailers can view the ratio of found versus missed GTINs when they search 

vendors’ or distributors’ catalogues to which they have access.
■ Vendors can view the ratio of found versus missed GTINs when they search 

retailer’s catalogues.
This section is organized as follows: 
■ “Using the Find Catalogue Data Page” on page 77.
■ “Finding Selection Codes” on page 77.
■ “Filtering a Selection Code List” on page 79.
■ “Viewing Selection Code Details” on page 79.
■ “Finding Products Across Selection Codes” on page 80.
■ “Finding Products Under One Selection Code” on page 82.
■ “Filtering a Product List” on page 84.
■ “Copying Product Data that Displays on a Product List Page” on page 84.
■ “Viewing Product Details” on page 86.
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■ “Viewing Product Media” on page 87.
■ “Finding GTINs Across Selection Codes” on page 88.
■ “Finding GTINs Under One Product” on page 90.
■ “Filtering a GTIN List” on page 92.
■ “Copying GTIN Data that Displays on a GTIN List Page” on page 92.
■ “Viewing GTIN Details” on page 95.
■ “Viewing Item Media” on page 96.
■ “Finding Container GTINs for a Component GTIN” on page 97.
■ “Finding Component GTINs for a Container GTIN” on page 97.
■ “Setting Internet Explorer (IE) Options for Copy Data to Table” on page 98.

Using the Find Catalogue Data Page
The Find Catalogue Data page is used in many of the following procedures for 
retrieving product data from your catalogue. The following procedures include 
partial page shots. To view the full page, refer back to the page shot below. 
Open the Find Catalogue Data page by clicking Catalogue > Advanced Search.

Note: For your convenience, a search bar is available on most pages. By default, 
the search bar is closed when a page opens. You can open or close the search bar 
by clicking on it. 
Except for the EQUAL MULTI option for a Product, the search bar displays the same 
search options that are available on the Find Catalogue Data page. Even though 
the search functionality is identical on the search bar and the Find Catalogue Data 
page (except for this difference), the options are displayed slightly differently in the 
two places. For specific information about the search bar, see “Search Bar” on 
page 15.
Note: You cannot enter a copyright or registered trademark in a search field; no 
results are returned. 

Finding Selection Codes
This section describes how to retrieve a list of Selection Codes.

To retrieve a Selection Code
1 Do one of the following:
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■ To view a list of all Selection Codes, click Catalogue > Selection Code 
List. The Selection Code List page opens. To filter the list, see “Filtering a 
Selection Code List” on page 79. Go to Step 4.

■ To begin the Selection Code list with a specific value, click Catalogue > 
Advanced Search. The Find Catalogue Data page opens. 

2 Select Selection Code.
3 Do one of the following:

■ To begin the list of Selection Codes with a specific value, select BEGIN 
from the drop-down list, and type those digits in the Selection Code field.

■ To open the Product List for a specific Selection Code, select EQUAL from 
the drop-down list, and type the full Selection Code in the Selection 
Code field. 

4 Click Search. The Selection Code List page opens. 

The table displays from left for each Selection Code:
■ Check box to select Selection Code for download
■ Selection Code—The Selection Code identifier
■ Description—The description of the Selection Code
■ Products—The number of Products under the Selection Code (click the 

hyperlink to display the list of Products)
■ GTINs—The number of GTINs under the Selection Code (click the 

hyperlink to display the list of GTINs)
5 To locate a Selection Code in the list, do any of the following: 

■ Filter the Selection Code List. See “Filtering a Selection Code List” on 
page 79.
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■ Scroll down the list.
■ Use the browse bar to move between pages.

6 To display additional information, do any of the following:
■ To view Selection Code details, click a Selection Code’s hyperlink (in the 

Selection Code column). 
■ To view a list of Products under a specific Selection Code, click the Product 

hyperlink (in the Products column) for that Selection Code.
■ To view a list of GTINs under a specific Selection Code, click the GTIN 

hyperlink (in the GTIN column) for that Selection Code.

Filtering a Selection Code List
You can use the filter to display a list of Products based on the criteria you specify. 

To filter a Selection Code list
1 To view a list of all Selection Codes, click Catalogue > Selection Code List. 

The Selection Code List page opens.

2 Enter the criteria for each of the options you want to filter by. You can filter on 
multiple options simultaneously.

■ Selection Code—Enter a full or partial Selection Code (3-digits)
■ Description—Enter a full or partial Selection Code description.

3 Click Filter. The list that meets your criteria displays.
Note: To remove all filter criteria, click Clear Filter.

Viewing Selection Code Details
Selection Code details include the Selection Code identifier, Selection Code 
description, the quantity of Products and GTINs under the Selection Code, and 
other information. 

To view Selection Code details
1 Find the Selection Code. See “Finding Selection Codes” on page 77.
2 On the Selection Code List page, click a Selection Code’s hyperlink. The 

Selection Code Details popup opens. You can edit the description.
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Note: Catalogue Last Update is the date that the catalogue, not the Selection 
Code, was last updated. 
To close the popup, click the close in the top right corner. 

 Finding Products Across Selection Codes
Use this procedure to retrieve Products. 

To find Products across Selection Codes
1 Click Catalogue > Advanced Search. The Find Catalogue Data page opens.

2 Select Product.
3 Select one of the following Product search options:

■ Identifier - The Product identifier. Use Identifier with EQUAL MULTI in 
Step 4 to search for up to 10 products at once.

■ Description - The description of the Product
■ Compressed - The compressed Product identifier (leading zeros, spaces, 

and special characters are ignored)
If you perform a Compressed Product search, the system retrieves all 
Products with compressed product values that exactly match the value you 
type in the Product field. Compressed Product identifiers omit leading 
zeroes, spaces, and special characters in Product identifiers for purposes of 
the Product search. 
For example, the Compressed Product identifier for 000324 MENS SHOES is 
324MENSSHOES. Sending 324MENSSHOES in a Compressed Product 
search returns all Products with that sequence of characters, ignoring 
leading zeroes, spaces, and special characters in the actual Product 
identifiers.

4 Select one of the following:
■ BEGIN - To return all Products that begin with a specific alphanumerical 

value, select BEGIN from the Product drop-down list, and type a full or 
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partial Product identifier or description in the field. This field has auto-fill. 
See “Auto-Fill” on page 16.

■ EQUAL - To display only a specific Product, select EQUAL from the 
Product drop-down list (EQUAL is automatically selected and is the only 
option for Compressed), and type the full Product identifier, exact 
description, or full compressed Product identifier in the field. 

■ CONTAINS - To return all Products that contain a specific alphanumerical 
value, select CONTAINS from the Product drop-down list, and type a full 
or partial Product identifier or description in the field. This field has auto-
fill. See “Auto-Fill” on page 16.

■ EQUAL MULTI - To display up to 10 Products, select EQUAL MULTI from 
the Product drop-down list (EQUAL MULTI can only be selected if Identifier 
is selected in Step 3), and type the full Product identifiers, one in each 
field, for up to 10 Products. To clear all Product identifier fields, click Clear 
Product Values.

5 Click Search. The Cross Selcode Product List page opens. 

Note: Only products that exist are listed. If no Products exist, an error 
message is displayed.
The table displays from left: 

■ Check box to select the Product for the download basket
■ Product—The Product identifier
■ Description—The description of the Product
■ Selcode Name—The Selection Code above the Product
■ Selcode Description—The description of the Selection Code above the 

Product
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■ Create Date—The date the Product was loaded into OpenText Active 
Catalogue

■ Last Update Date—The date the Product was last updated
■ GTINs—The number of GTINs under the Product (click the hyperlink to 

display the list of GTINs). 
■ GTIN Filter—The number of GTINs under the Product (click the hyperlink 

to display a blank GTIN list screen; you can then filter to display only those 
GTINs whose criteria you specify). See “Filtering a GTIN List” on page 92.

■ Images—The number of images associated with the Product (click the 
hyperlink to display the list of images)

6 To locate a Product in the list: 
■ Filter the Product list. See “Filtering a Product List” on page 84.
■ Scroll down the list. 
■ Use the browse bar to move between pages.

7 To display additional information, do any of the following:
■ To view Product details, click a Product hyperlink (in the Product column).
■ To view a list of GTINs under a specific Product, click the GTIN hyperlink (in 

the GTIN column) for that Product.
■ To view a list of images under a specific Product, click the image hyperlink 

(in the Image column) for that Product.

Finding Products Under One Selection Code
Use this procedure to display a list of Products for a specific Selection Code. As an 
optional method, on the Selection Code List page, click a hyperlink in the Products 
column. The Product List page will open. 

To find Products under one Selection Code
1 Click Catalogue > Advanced Search. The Find Catalogue Data page opens.

2 Select Selection Code.
3 Select EQUAL from the Selection Code drop-down list and type the full 

Selection Code identifier.
4 Click Search. The Product List page opens listing Products under the Selection 

Code. 
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If no Products exist, the Add Products page opens to prompt you to add 
Products under the Selection Code.

The table displays from left: 
■ Check box to select the Product for the download basket
■ Product—The product identifier
■ Description—The description of the Product
■ Create Date—The date the Product was loaded into OpenText Active 

Catalogue
■ Last Update Date—The date the Product was last updated
■ GTINs—The number of GTINs under the Product (click the hyperlink to 

display the list of GTINs). 
■ GTIN Filter—The number of GTINs under the Product (click the hyperlink 

to display a blank GTIN list screen; you can then filter to display only those 
GTINs whose criteria you specify). See “Filtering a GTIN List” on page 92.

■ Images—The number of images associated with the Product (click the 
hyperlink to display the list of images) 

5 To locate a Product in the list: 
■ Filter the Product list. See “Filtering a Product List” on page 84.
■ Scroll down the list. 
■ Use the browse bar to move between pages.

6 To display additional information, do any of the following:
■ To view Selection Code details, click the details hyperlink in the header 

information next to Selection Code Name.
■ To view Product details, click a Product hyperlink (in the Product column).
■ To view a list of GTINs under a specific Product, click the GTIN hyperlink (in 

the GTIN column) for that Product.
■ To view a list of images under a specific Product, click the image hyperlink 

(in the Image column) for that Product.
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Filtering a Product List
You can use the filter to display a list of Products based on the criteria you specify. 

To filter a Product list
1 On the Product List page, enter the criteria for each of the options you want to 

filter by. You can filter on multiple options simultaneously.
■ Product—Enter a Product’s full or partial Product identifier.
■ Description—Enter a Product’s full or partial description. 
■ Compressed Name—Enter the Product’s full or partial compressed 

Product identifier (leading zeros, spaces, and special characters are 
ignored) 
If you perform a Compressed Product search, the system retrieves all 
Products with compressed product values that exactly match the value you 
type in the Product field. Compressed Product identifiers omit leading 
zeroes, spaces, and special characters in Product identifiers for purposes of 
the Product search. 
For example, the Compressed Product identifier for 000324 MENS SHOES is 
324MENSSHOES. Sending 324MENSSHOES in a Compressed Product 
search returns all Products with that sequence of characters, ignoring 
leading zeroes, spaces, and special characters in the actual Product 
identifiers.

2 Click Filter. The list that meets your criteria displays.
Note: To remove all filter criteria, click Clear Filter.

Copying Product Data that Displays on a Product List Page
You can use the “Copy Data to Table” feature to copy to a table the Product data 
that displays on any Product List page. You can view the data in the table or save 
the data to a CSV text file on your computer. With either method, you can copy the 
data from the table and paste it into another application.
Note: Be sure to set the required Internet Explorer options so you can 
successfully use this feature. See “Setting Internet Explorer (IE) Options for Copy 
Data to Table” on page 98. 
If you do not set the IE options, you may experience inconsistent behavior when 
you use this feature. Sometimes the data table will appear and sometimes the 
page may flash momentarily, but there is no indication that your setting is not 
correct except that the table will not display.
The Copy Data to Table icon appears on the button bar of the following Product 
List pages: 
■ Product List page - All data from this page is copied to the table.
■ Cross Selection Code Product List page - All data from this page is copied to the 

table.

To copy the Product data that displays on a Product List page
1 On a Product List page, click Copy Data to Table. 
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One of the following occurs:
■ A table opens displaying the Product data. Go to Step 3 (you can skip Step 

2 unless the File Download dialog box opens).
■ The File Download dialog box opens asking if you want to open the file or 

save it to your computer.

Note: The File Download dialog box will always open unless you deselect the 
Always ask before opening this type of file check box. This prevents the 
“Do you want to open or save this file” question from being asked every time 
you want to copy data to a table. Continue with Step 2.

2 Do one of the following:
■ Open - To display the Product data in a table format, click Open. Go to 

Step 3.
■ Save - To save the file as a CSV text file that you can open later in 

Microsoft Excel, click Save. The Save As dialog box opens.

Do all of the following:
■ Navigate to the location where you want to save the file.
■ In the File name box, enter a name for the file. The file name should 

have a .csv extension. For example, MensShirts.csv

■ Click Save. The file is saved to the location you selected. 
■ Cancel - To cancel your action, click Cancel.

3 Once the table is open, you can select rows and columns of Product data to 
copy. When you want to close the table, click the X in the upper right corner of 
the window. 
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If you modified the table, a dialog box appears when you close the window and 
asks if you want to save your changes. 

To save your changes, click Yes. The Save As dialog box opens. 

Do all of the following:
■ Navigate to the location where you want to save the file.
■ In the File name box, enter a name for the file. The file name should have 

a .csv extension. For example, MensShirts.csv 
■ Click Save. The file is saved to the location you selected. 

Viewing Product Details
Product details include the Product name (identifier), Product description, 
extended description, the quantity of GTINs under the Product, and other 
information.

To view Product details
1 Find the Product: 

■ See “Finding Products Across Selection Codes” on page 80.
■ See “Finding Products Under One Selection Code” on page 82.

2 On the Product List page, click a Product’s hyperlink (in the Product column). 
The Edit Product page opens. You can edit the description and extended 
description.
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Viewing Product Media
Product media includes image attribute information at the Product level, such as 
the image description and image filename, as well as any physical image.

To view Product media
1 Find the Product. See one of the following:

■ “Finding Products Across Selection Codes” on page 80.
■ “Finding Products Under One Selection Code” on page 82.

The Product List page opens.
2 Click the image hyperlink (in the Image column) for the Product. 

The Product Media page opens. 
The image attribute information displays. If a physical image has been 
uploaded, a watermarked image displays. If no physical image has been 
uploaded, a OpenText watermark displays, as shown in this example. 
Note: If you an download image, it will have a higher resolution and will not 
be watermarked. Downloading an image (or other data) is a billable action.
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If there is additional Product media associated with this Product, you can view 
more image attribute information by using the scroll bar. 

3
■

■

Finding GTINs Across Selection Codes 
Use this procedure to retrieve a list of GTINs across Selection Codes. 

To find GTINs by searching across Selection Codes
1 Click Catalogue > Advanced Search. The Find Catalogue Data page opens. 
2 Select GTIN. 
3 Do one of the following:

■ To display only a specific GTIN, select EQUAL from the GTIN drop-down 
list and type the full GTIN in the field. If you use the option below to search 
for GTINs created/updated after a certain date, you can leave this field 
blank.
Optionally, type a date (MM/DD/YYYY format) in the Create/Update 
Date on/after field (or click Auto Calendar and select a date from the 
calendar).

■ To return all GTINs that numerically follow a value, select BEGIN from the 
GTIN drop-down list, and type a partial GTIN (at least the first six digits) in 
the field. If you use the option below to search for GTINs created/updated 
after a certain date, you can leave this field blank. Then select the GTIN 
Type from the drop-down list. See “GTIN Number Structures” on 
page 256. 
Optionally, type a date (MM/DD/YYYY format) in the Create/Update 
Date on/after field (or click Auto Calendar and select a date from the 
calendar).
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4 Click Search. The Cross-Selection Code GTIN List page opens.

The table includes from left for each GTIN: 
■ Check box to select the GTIN for download
■ Component—The number of components for a GTIN (to view the GTIN 

components, click the hyperlink)
■ Container—The number of containers for a GTIN (to view the GTIN 

containers, click the hyperlink)
■ GTIN—The GTIN identifier (to view GTIN details, click the GTIN hyperlink)
■ GTIN Type—The type of GTIN. See “GTIN Number Structures” on 

page 256. 
■ Pack—Container code or component indicator. See “Container and 

Component GTIN Codes” on page 258.
■ Selection Code—The Selection Code above the GTIN (click the hyperlink 

to view the Selection Code details
■ Description—The description of the Selection Code above the GTIN
■ Product—The Product identifier above the GTIN (click the hyperlink to 

view the Product details
■ Product Description—The description of the Product above the GTIN
■ Color—Color code for the GTIN
■ Color Description—Color description for the GTIN
■ Size—Size code for the GTIN
■ Size Description—Size description for the GTIN

5 To locate a GTIN in the list, do any of the following: 
■ Filter the GTIN list. See “Filtering a GTIN List” on page 92. 
■ Scroll down the list. 
■ Use the browse bar to move between pages.

6 To view GTIN information, do any of the following:
■ To view GTIN details, click the GTIN hyperlink in the GTIN column. 
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■ To view GTIN components for a GTIN click the hyperlink in the 
Components column

■ To view GTIN containers for a GTIN, click the hyperlink in the Containers 
column.

Finding GTINs Under One Product
Use this procedure to retrieve GTINs under a specific Product if you already know 
the Product. 

To find GTINs under a specific Product
1 Click Catalogue > Advanced Search. The Find Catalogue Data page opens. 
2 Select Product.
3 Select one of the following Product search options:

■ Identifier—The Product identifier 
■ Description—The description of the Product
■ Compressed—The compressed Product identifier (leading zeros, spaces, 

and special characters are ignored)
If you perform a Compressed Product search, the system retrieves all 
Products with compressed product values that exactly match the value you 
type in the Product field. Compressed Product identifiers omit leading 
zeroes, spaces, and special characters in Product identifiers for purposes of 
the Product search. 
For example, the Compressed Product identifier for 000324 MENS SHOES is 
324MENSSHOES. Sending 324MENSSHOES in a Compressed Product 
search returns all Products with that sequence of characters, ignoring 
leading zeroes, spaces, and special characters in the actual Product 
identifiers.

4 Select EQUAL from the Product drop-down list (EQUAL is automatically 
selected and is the only option for Description and Compressed), and type the 
full Product identifier, description, or compressed Product identifier in the field.

5 Click Search. The GTIN List page opens. 
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The table displays from left the following for each GTIN: 
■ Check box to select the GTIN for download
■ Component—The number of components for a GTIN (to view the GTIN 

components, click the hyperlink)
■ Container—The number of containers for a GTIN (to view the GTIN 

containers, click the hyperlink)
■ GTIN—The GTIN identifier (to view GTIN details, click the GTIN hyperlink)
■ GTIN Type—The type of GTIN. See “GTIN Number Structures” on 

page 256. 
■ Pack—The container code or component indicator. See “Container and 

Component GTIN Codes” on page 258.
■ Color—Color code for the GTIN
■ Color Description—Color description for the GTIN
■ Size—Size code for the GTIN
■ Size Description—Size description for the GTIN
■ Published Cost—The unit cost of the GTIN
■ Suggested Retail— The suggested retail price of the GTIN
■ Create Date—The date the GTIN was loaded to OpenText Active 

Catalogue
■ Last Update Date—The date the GTIN was last updated
■ Discontinue Date—The date the GTIN will be discontinued in OpenText 

Active Catalogue
■ Images—The number of images associated with the GTIN (click the 

hyperlink to display the list of images)
6 To locate a GTIN in the list, do any of the following: 

■ Filter the GTIN list. See “Filtering a GTIN List” on page 92.
■ Scroll down the list. 
■ Use the browse bar to move between pages.

7 To view GTIN information, do any of the following:
■ To view GTIN details, click the GTIN hyperlink in the GTIN column. 
■ To view GTIN components for a GTIN click the hyperlink in the 

Components column
■ To view GTIN containers for a GTIN, click the hyperlink in the Containers 

column.
■ To view all of the GTINS that are under the same Product as this GTIN, 

click the Product link in the header (to view Product details, click the details 
link).

■ To view all of the Products that are under the same Selection Code as this 
GTIN, click the Selection Code link in the header (to view Selection Code 
details, click the details link).
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Filtering a GTIN List
You can use the filter to display a list of GTINs based on the criteria you specify. 

To filter a GTIN list
1 On the GTIN List page, enter the criteria for each of the options you want to 

filter by. You can filter on multiple options simultaneously.

■ GTIN—Enter a full or partial GTIN
■ GTIN Type—To display only GTINs of a selected type (UP, EN, EO, UA, UK, 

UE), select a GTIN type from the drop-down list
■ Pack—To display GTINs with a particular container designation, select one 

of the following from the drop-down list
■ Container—Display only GTINs that are containers
■ Not a Container—Display only GTINs that are not containers

■ Color—To display GTINs with a specific color code, select a color code 
from the drop-down list.

■ Size—To display GTINs with a specific size code, select a size code from 
the drop-down list

■ Last Update Date on/after—To display only GTINs added or updated on 
or after this date, enter a date (MM/DD/YYY Y format) or click Auto 
Calendar and select a date. 

■ Discontinue Date—To display only GTINs discontinued on/before or after 
a date, select the appropriate choice from the drop-down list and enter a 
date (MM/DD/YYY Y format) or click Auto Calendar and select a date.
Note: You cannot enter a date greater than 12-31-2049.

■ On or Before—Display only GTINs that are discontinued on or before 
the specified date

■ After—Display only GTINs that are discontinued after the specified date
2 Click Filter. The list that meets your criteria displays.

Note: To remove all filter criteria, click Clear Filter.

Copying GTIN Data that Displays on a GTIN List Page
You can use the “Copy Data to Table” feature to copy to a table the GTIN data that 
displays on any GTIN List page. You can view the data in the table or save the data 
to a CSV text file on your computer. With either method, you can copy the data 
from the table and paste it into another application. 
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Be sure to see “Setting Internet Explorer (IE) Options for Copy Data to Table” on 
page 98 to set the required Internet Explorer options so you can successfully use 
this feature.
Note: If you do not set the IE options, you may experience inconsistent behavior 
when you use this feature. Sometimes the data table will appear and sometimes 
the page may flash momentarily, but there is no indication that your setting is not 
correct except that the table will not display.
The Copy Data to Table icon appears on the button bar of the following GTIN List 
pages. 
■ GTIN List page - In addition to all data on the page, the following values are 

copied to the table: Published Cost and Suggested Retail.
■ Cross Selection Code GTIN List page - In addition to all data on the page, the 

following values are copied to the table: Published Cost, Suggested Retail, 
Discontinue Date, Create Date, and Last Update Date.

To copy the GTIN data that displays on a GTIN List Page
1 On a GTIN List page, click Copy Data to Table. 

One of the following occurs:
■ A table opens displaying the GTIN data. Go to Step 3 (you can skip Step 2 

unless the File Download dialog box opens).
■ The File Download dialog box opens asking if you want to open the file or 

save it to your computer.

Note: The File Download dialog box will always open unless you deselect the 
Always ask before opening this type of file check box. This prevents the 
“Do you want to open or save this file” question from being asked every time 
you want to copy data to a table. Continue with Step 2.

2 Do one of the following:
■ Open - To display the GTIN data in a table format, click Open. Go to Step 

3.
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■ Save - To save the file as a CSV text file that you can open later in 
Microsoft Excel, click Save. The Save As dialog box opens.

Do all of the following:
■ Navigate to the location where you want to save the file.
■ In the File name box, enter a name for the file. The file name should 

have a .csv extension. For example, BlackShirt.csv

■ Click Save. The file is saved to the location you selected. 
■ Cancel - To cancel your action, click Cancel.

3 Once the table is open, you can select rows and columns of GTIN data to copy. 
When you want to close the table, click the X in the upper right corner of the 
window. 
If you modified the table, a dialog box appears when you close the window and 
asks if you want to save your changes. 

To save your changes, click Yes. The Save As dialog box opens. 

Do all of the following:
■ Navigate to the location where you want to save the file.



F I N D I N G  A N D  V I E W I N G  D A T A
Viewing GTIN Details

OpenText Active Catalogue CE 21.2 Browser Interface User Guide  95

6

■ In the File name box, enter a name for the file. The file name should have 
a .csv extension. For example, BlackShirt.csv 

■ Click Save. The file is saved to the location you selected. 

Viewing GTIN Details
GTIN details are the attributes of the GTIN. Examples include color code and 
booking date. Only attributes in the selected attribute filter will be displayed. 

To view a GTIN’s attributes
1 Find the GTIN: 

■ See “Finding GTINs Across Selection Codes” on page 88.
■ See “Finding GTINs Under One Product” on page 90.

2 On the GTIN list page, click a GTIN’s hyperlink. 
The GTIN Detail page opens displaying all attributes in the filter, both populated 
and unpopulated. Above the table is general information about the GTIN. 

3 To find a specific attribute for the GTIN, do any of the following:
■ Use the scroll bar.
■ Above the table, in the Jump to Group drop-down list, select the Attribute 

Group that seems likely to contain the attribute (for example, Available 
Date is in the Ordering Information Attribute Group). The page resets to 
show that Attribute Group. 
See “GTIN Attribute Groups” on page 69. 

4 To view attributes for other GTINs in the list, do one of the following:
■ Click Prev to view the attributes for the previous GTIN in the list. 
■ Click Next to view the attributes for the next GTIN. in the list

5 To view all of the components that belong to this GTIN, click the Components 
link in the header. The View Components popup lists all of the components that 
are part of the GTIN.
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6 To view all of the containers that this component belongs to, click the 
Containers link in the header. The View Containers popup lists all of the 
containers for the GTIN.

Viewing Item Media
Item media includes image attribute information at the GTIN level, such as the 
image description and image filename, as well as any physical image.

To view Item media
1 Find the GTIN. See one of the following:

■ “Finding GTINs Across Selection Codes” on page 88.
■ “Finding GTINs Under One Product” on page 90.

The GTIN List page opens.
2 Click the image hyperlink (in the Image column) for the GTIN. 

The Item Media page opens. 
The image attribute information displays. If a physical image has been 
uploaded, a watermarked image displays. If no physical image has been 
uploaded, a OpenText watermark displays.
Note: If you an download image, it will have a higher resolution and will not 
be watermarked. Downloading an image (or other data) is a billable action.

If there is additional GTIN media associated with this GTIN, you can view more 
image attribute information by using the scroll bar. 
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Finding Container GTINs for a Component GTIN
Container GTINs contain component GTINs and sometimes other container GTINs. 

To find a container GTIN for a component GTIN
1 If you are on a GTIN List page, go to Step 2. Otherwise, find a GTIN by doing 

one of the following
■ See “Finding GTINs Across Selection Codes” on page 88.
■ See “Finding GTINs Under One Product” on page 90.

Note: You may find want to filter the GTIN list to display only Not 
Containers. See “Filtering a GTIN List” on page 92. In the Pack column, a 
GTIN that is sold only as a component is indicated by PP.

2 Click the hyperlink in the Containers column. The View Containers popup lists 
all of the containers for the selected GTIN.

The table lists from left for each container: 
■ GTIN—The container GTIN identifier as a hyperlink. Click the hyperlink to 

view GTIN details for the container. See “Filtering a GTIN List” on page 92. 
■ GTIN Type—The type of GTIN. See “GTIN Number Structures” on 

page 256. 
■ Pack—The container code indicator. See “Container and Component GTIN 

Codes” on page 258.
■ Color—The GTIN’s color information.
■ Color Description—The GTIN’s color description.
■ Size—The GTIN’s size information.
■ Size Description—The GTIN’s size description.

Finding Component GTINs for a Container GTIN
Component GTINs are contained in other GTINs called containers.
If you are on a GTIN details page, go to Step 2 of the following procedure.

To find component GTINs of a container GTIN
1 If you are on a GTIN List page, go to Step 2. Otherwise, find a GTIN by doing 

one of the following
■ See “Finding GTINs Across Selection Codes” on page 88.
■ See “Finding GTINs Under One Product” on page 90.

Note: You may find want to filter the GTIN list to display only Containers. 
See “Filtering a GTIN List” on page 92. In the Pack column, a container is 
indicated by any value except PP, which indicates component. 
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2 Click the hyperlink in the Components column. The View Components popup 
lists all of the components that are part of the selected container.

The table displays from left for each component in the container: 
■ Check box for vendor to remove the component from the container 

(disabled for retailer). 
■ GTIN—The component GTIN identifier as a hyperlink. Click the hyperlink 

to view GTIN details. See “Filtering a GTIN List” on page 92.
■ GTIN Type—The type of GTIN. See “GTIN Number Structures” on 

page 256. 
■ Quantity—The quantity of the component in the container. 
■ Pack—The component pack type (PP or blank). 
■ Unit of Measure—The unit of measure for the quantity.
■ Color—The component GTIN’s color information.
■ Color Description—The component GTIN’s color description.
■ Size—The component GTIN’s size information.
■ Size Description—The component GTIN’s size description.

Setting Internet Explorer (IE) Options for Copy Data to Table
The Copy Data to Table option enables you to download data from the following 
pages to a table that opens in a pop-up window:
■ Product List pages
■ GTIN List pages
■ Partner Access Report page
■ Error Processing (document list) page
To allow data download and pop-up functionality for this option, you need to set 
the following Internet options for Internet Explorer (IE):
■ Add the secure URL for Catalogue to your IE trusted sites.
■ Enable IE to prompt for file downloads.
■ If you are using a pop-up blocker, add the secure URL for Catalogue to your IE 

pop-up blocker settings.
The following procedure describes how to set all of these options.
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To set Internet Explorer options for Copy Data to Table 
1 Access the Internet with Internet Explorer. 
2 From the Tools menu, select Internet Options. 

The Internet Options window opens.
3 Click the Security tab. 
4 Under the Select a zone to view or change security settings section, click 

the Trusted sites icon. 
The Trusted sites zone displays.

5 Click Sites. 
The Trusted sites window opens.

6 In the Add this website to the zone box, type the secure URL for Catalogue, 
https://catalogue.gxs.com.

7 Click Add. 
The URL appears in the Websites box.

8 Click Close. 
You return to the Internet Options window, Security tab.

9 If it is enabled, click Apply on the Internet Options window. If it is not enabled, 
continue to the next step.
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10 Under the Security level for this zone section, click Custom level.

The Security Settings - Trusted Sites Zone window opens. 

11 Scroll down to the Downloads section.
12 Under Automatic prompting for file downloads, select Enable. 

13 Click OK at the bottom of the Security Settings - Trusted Sites Zone window.
A warning dialog box opens, asking you to verify that you want to change the 
settings for this zone.

14 Click Yes.
You return to the Internet Options window.

15 If it is enabled, click Apply on the Internet Options window. If it is not enabled, 
continue to the next step.

16 Do one of the following:
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■ If you are not using a pop-up blocker, you are done. Click OK. 
You are now set up to use the Copy Data to Table feature.

■ If you are using a pop-up blocker, continue to the next step to add the 
secure URL for Catalogue to your IE pop-up blocker settings.

17 Click the Privacy tab. 
18 In the Pop-up Blocker section at the bottom, click Settings.

The Pop-up Blocker Settings window opens.
19 In the Address of website to allow box, type the secure URL for Catalogue, 

https://catalogue.gxs.com, in the box.

20 Click Add. 
The URL appears in the Allowed sites box.

21 Click Close on the Pop-up Blocker Settings window. 
You return to the Internet Options window.

22 Click OK on the Internet Options window. 
You are now set up to use the Copy Data to Table feature.
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The GS1 US® Color and Size Code System (formerly the National Retail Federation 
(NRF) Color and Size Code System) provides vendors and retailers with a 
standardized method of color and size identification of general merchandise and 
apparel (GM&A). 
This system allows vendors and retailers to access, search, synchronize, request, 
and download the latest GS1 US color and size code information. This functionality 
is available to OpenText Active Catalogue vendors and retailers through 
Catalogue’s Web User interface (UI). The color and size data from GS1 US is 
updated several times a day.
Refer to the following resources for additional information:
■ For answers to frequently asked questions about color and size codes, please 

refer to the OpenText Active Catalogue Color and Size Code FAQs which can be 
found on the Product Documentation List page in Catalogue (click Product 
Documentation > All Documents). 

■ Although OpenText provides GS1 US color and size information on behalf of the 
GS1 US, you can also visit the GS1 US website to find more detailed information 
about GS1 US. The web address for GS1 US is www.gs1us.org.

This section explains how to find, view, and download the GS1 US color and size 
codes. In addition, it describes how to request a new size code via email.
This section is organized as follows: 
■ “Finding Color Codes” on page 104.
■ “Filtering the Color Code List” on page 105.
■ “Examples of Filtering Color Codes” on page 105
■ “Downloading Color Codes” on page 107.
■ “Finding Size Codes” on page 107.
■ “Filtering the Size Code List” on page 108.
■ “Examples of Filtering Size Codes” on page 109
■ “Downloading Size Codes” on page 112.
■ “Requesting a New Size Code from GS1 US” on page 113.
■ “Importing a CSV text file to Excel” on page 115.
■ “Commonly Used Color Description Abbreviations” on page 115.
■ “National Retail Federation Color Code Ranges” on page 116.

www.gs1us.org
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■ “GS1 US Product Category List” on page 117.
■ “GS1 US Product Category2 List” on page 118.
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Finding Color Codes
This section describes how to find an GS1 US color code.

To find a color code
1 Click Color/Size Codes > Color Codes. The Color Code List page opens. 

The table displays from left for each color code:
■ Color Code—The GS1 US color code
■ Color—The GS1 US color
■ Color Group—The GS1 US color group

2 To locate a color code in the list, do any of the following: 
■ Filter the color code list. See “Filtering the Color Code List” on page 105. 
■ Scroll down the list. 
■ Use the browse buttons to move between pages.
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Filtering the Color Code List
You can use a filter to display a list of color codes based on the criteria you specify.

To filter the color code list
1 On the Color Code List page, click Filter. The filter expands to display the filter 

options. 

2 You can filter the list by selecting one of the following options:
■ Color Code—To show only a specific color code, type the full color code 

(leading zeros do not need to be typed) in the Color Code field.
■ Color Group—To show only a specific color group, select the color group 

from the list of color groups.
■ Color—To show only a specific color, click the arrow to the left of the color 

group that contains the color you want to display. The color group expands 
to display all of the colors in a particular group. Select a color from the list.

3 Click Filter. The list that meets your criteria displays.
Note: To remove all filter criteria, click Clear Filter.

Examples of Filtering Color Codes
The following examples illustrate different ways to filter color codes:
■ “Example 1 - Color Codes for the Brown Group” on page 105
■ “Example 2 - Color Codes for Rust/Copper” on page 106

Example 1 - Color Codes for the Brown Group
1 On the Color Code List page, click Filter. The filter expands to display the filter 

options.
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2 Click Brown Group to highlight the group.

3 Click Filter. The list displays the colors in the Brown Group (a partial list is 
shown below).

Example 2 - Color Codes for Rust/Copper
1 On the Color Code List page, click Filter. The filter expands to display the filter 

options.
2 Click the arrow to the left of the Brown Group. The group expands to show all 

of the colors in this group which includes Rust/Copper.

3 Click Rust/Copper to highlight the group.
4 Click Filter. The list displays the colors Rust/Copper (a partial list is shown 

below).
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Downloading Color Codes
OpenText Active Catalogue allows you to download color code data directly to your 
desktop as a CSV (comma separated values) text file. See “Importing a CSV text 
file to Excel” on page 115 for information about importing your file into Microsoft 
Excel so that leading zeros are displayed.

To download color codes
1 Filter the color code list to restrict it to only the color codes you want to 

download. See “Filtering the Color Code List” on page 105.
2 Click Download to initiate the data download. The File Download dialog 

opens.
3 Do one of the following:

■ Click Open to view the file. 
■ Click Save to save the file to your computer. The Save As dialog opens. 

Type a file name in the File name text box and click Save. The file is 
saved to your computer.

■ Click Cancel to cancel the download and return to the Color Code List 
page.

Finding Size Codes
This section describes how to find an GS1 US size code.

To find a size code
1 Click Color/Size Codes > Size Codes. The Size Code List page opens. 

The table displays from left for each size code:
■ Size Code—The GS1 US size code
■ Category—The product category description (the first level of product 

category description)
■ Category2—The GS1 US table name description (the second level of 

product category description)
■ Primary Size—The primary size description
■ Secondary Size—The secondary size description
■ Heading—The GS1 US Heading description (the third level of product 

category description)
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■ Heading2—The GS1 US Heading2 description (the fourth level of product 
category description)

■ Type—The size type. If the size code is European or US, it is indicated in 
this column.

2 To locate a size code in the list, do any of the following: 
■ Filter the size code list. See “Filtering the Size Code List” on page 108. 
■ Scroll down the list. 
■ Use the browse buttons to move between pages.

Filtering the Size Code List
You can use a filter to display a list of size codes based on the criteria you specify. 
Refer to “GS1 US Product Category List” on page 117 and the “GS1 US Product 
Category2 List” on page 118 to help you search for only those product categories 
you want to display.

To filter the size code list
1 On the Size Code List page, click Filter. The filter expands to display the filter 

options.

2 Filter the list by entering and/or selecting the criteria for each of the options 
you want to filter by. You can filter on multiple options simultaneously.

■ Size Code—To show only a specific size code, type the full size code.
■ Category—Tree view of Category, Category2, Heading, and Heading2 

descriptions—To filter the list by a specific level of product category 
description, select one of the following description levels. To expand the 
tree and display subsequent levels, click the arrow to the left of each 
description.

■ Category—To filter the list by Category description, select a category 
description (first level).

■ Category2—To filter the list by Category2 description, expand a 
Category level and select a Category2 description (second level).
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■ Heading—To filter the list by Heading description, expand a Category2 
level and select a Heading description (third level).

■ Heading2—To filter the list by Heading2 description, expand a Heading 
level and select a Heading2 description (fourth level).

■ Primary Size—To filter the list by the primary size description, type a 
partial or full primary description in the text box.

Note: The largest dimension of the description must be entered first. 
For example, filter the list for a 10x8 picture frame rather than an 8x10 
inch picture frame. Sizes are in inches for US measurements and 
millimeters for metric measurements.

■ Secondary Size—To filter the list by the secondary size description, type a 
partial or full secondary description in the text box.

■ Type—To filter the list by a specific size type (European or US), type E or U 
in the text box.

■ Add Date—To filter the list by size codes that were added by GS1 US on or 
after a specific date, type a date (MM/DD/YYYY format) in the text box (or 
click Auto Calendar and select a date from the calendar).

3 Click Filter. The list that meets your criteria displays.
Note: To remove all filter criteria, click Clear Filter.

Examples of Filtering Size Codes
The following examples illustrate different ways to filter size codes:
■ “Example 1 - Size Codes for Tier Swag Set” on page 109
■ “Example 2 - Size codes for Adult Male and Unisex Clothing” on page 110
■ “Example 3 - Size Codes Using the % Wildcard Character” on page 111

Example 1 - Size Codes for Tier Swag Set
1 On the Size Code List page, click Filter. The filter expands to display the filter 

options.
2 Click the arrow to the left of Window Treatments. The tree expands to show 

all of the second level descriptions beneath Window Treatments. 
3 Click the arrow to the left of Cascades Festoons, Jabots Swags. The tree 

expands to show all of the third level descriptions beneath it.
4 Click the arrow to the left of Cascades & Swags. The tree expands to show all 

of the fourth level descriptions beneath it. 
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5 Click Tier Swag Set to highlight the category.

6 Click Filter. The list displays all size codes whose Heading2 description is Tier 
Swag Set (a partial list is shown below).

Note: The filter now reflects your search criteria in the Heading and 
Heading2 fields:

Example 2 - Size codes for Adult Male and Unisex Clothing
1 On the Size Code List page, click Filter. The filter expands to display the filter 

options.
2 In the Category field, click Adult Male & Adult Unisex Clothing & 

Furnishings to highlight the category.
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3 In the Primary Size field, type 34.

4 Click Filter. The list displays all size codes where Primary Size is 34 in the Adult 
Male and Adult Unisex category (a partial list is shown below).

Example 3 - Size Codes Using the % Wildcard Character
In this example, the wildcard character % is used in the Heading search string to 
locate size codes that contain the word bedskirts.
1 On the Size Code List page, click Filter. The filter expands to display the filter 

options. Do not highlight any name in the Category field.
2 In the Heading field, type %bedskirt.
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3 Click Filter. The list displays all size codes where Heading contains the word 
bedskirt (a partial list is shown below).

Downloading Size Codes
OpenText Active Catalogue allows you to download size code data directly to your 
desktop as a CSV (comma separated values) text file. See “Importing a CSV text 
file to Excel” on page 115 for information about importing your file into Microsoft 
Excel so that leading zeros are displayed.
Note: You should restrict the number of size codes you download by filtering the 
list before you download the codes. See Step 1 in the following procedure.

To download size codes
1 Filter the size code list to restrict it to only the size codes you want to 

download. See “Filtering the Size Code List” on page 108.
2 Click Download to initiate the data download. The File Download dialog 

opens. 
3 Do one of the following:

■ Click Open to view the file. 
■ Click Save to save the file to your computer. The Save As dialog opens. 

Type a file name in the File name text box and click Save. The file is 
saved to your computer.

■ Click Cancel to cancel the download and return to the Size Code List page.
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Requesting a New Size Code from GS1 US
If you do not find the exact size code you want in the list of size codes on the Size 
Code List page, you can submit a request to GS1 US to add a new code. 
Note: New color codes cannot be requested.
Use the procedure below to fill out the registration information and submit the 
request. The information is emailed to OpenText Cloud Support Services (CSS) for 
validation. After validation, OpenText forwards the request to GS1 US for 
consideration; you will be notified if a new code is created. 

To request a new size code
1 Click Color/Size Codes > Request New Size Code. The Size Code Request 

page opens.
2 At the top of the page, enter the following information:

■ Name—Your name. Required.
■ Title—Your title. Optional.
■ Email Address—Your email address. Required.
■ Phone—Your phone number. Required.
■ Fax—Your fax number. Optional.
■ Company Name—Your company’s name. Required.
■ Address—Your company’s address. Required.
■ City/State Zip—Your company’s city, state, and ZIP code. Required.
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3 At the bottom of the page, fill in the following information for each size code 
you are requesting. You can request up to 10 new size codes each time you 
submit a request.

■ Table #—For each size code you are requesting, determine the 
appropriate table name from the following list and type the corresponding 
table number for the new code in the Table # column. Required.

■ Product—For each size code you are requesting, type the product 
category description (the first level of product category description). 
Required.

■ First Size—For each size code you are requesting, type the first size 
description. The First Size corresponds to the Primary size that displays 
on the Size Code List page. Recommended.

■ Second Size—For each size code you are requesting, type the second size 
description. The Second Size corresponds to the Secondary size that 
displays on the Size Code List page. Recommended.

■ Explain requirements for code request—Type an explanation of why 
you need this new size code. Optional.

Note: If you need to clear the entries in the form and start over, click Clear.
4 If you are satisfied with your entries, print the form for your records before you 

submit it. From the File menu, select Print.
5 To submit your request, click Send. The information is emailed to OpenText 

Cloud Support Services (CSS) for validation. OpenText will forward it to GS1 US 
for consideration. You will be notified if a new code is created.
Note: Once you submit your request, the Size Code Request page remains 
open. The Name text box is cleared to prevent you from accidentally 



W O R K I N G  W I T H  C O L O R  A N D  S I Z E  C O D E S
Importing a CSV text file to Excel

OpenText Active Catalogue CE 21.2 Browser Interface User Guide  115

7

resubmitting the same request. You can submit other size code requests, or 
select another option from the button bar.

Importing a CSV text file to Excel
You can import your CSV text file of GS1 US color or size codes to a Microsoft Excel 
spreadsheet. Use the following procedure to format the data to display the leading 
zeros for the codes.

To import a CSV text file of GS1 US color or size codes to Excel
1 Open a new, blank Excel document (workbook).
2 From the Data menu, select Import External Data > Import Data. The 

Select Data Source dialog box opens.
3 Browse to the CSV text file you want to import, and select it. Click Open. The 

Text Import Wizard - Step 1 of 3 opens.
4 Select Delimited as the file type that describes your data. Click Next. The 

Text Import Wizard - Step 2 of 3 opens.
5 Under Delimiters, select Comma as the only delimiter. Click Next. The Text 

Import Wizard - Step 3 of 3 opens.
6 Under Column data format, select Text as the column format for the column 

that contains the GS1 US color or size codes. Click Finish. The Import Data 
dialog box opens.

7 Select New worksheet. Click OK. The data is imported into the Excel 
spreadsheet and displays the GS1 US color or size code information, including 
the leading zeros for the codes.

Commonly Used Color Description Abbreviations
The following table lists commonly used color description abbreviations.

Color Abbreviation
Black BLK, BK
Charcoal CHRCL
Dark Green DK GREEN, DARK GRN
Medium Brown MED BROWN, MEDIUM BRN
Light Blue LT BLUE, LIGHT BU
Gray/Grey GY
Silver SLVR
White WHT, WT
Natural NTURAL
Blue/Natural BLUE/NAT (using Blue color code)
Cream CRM
Heather Gray HTHR GREY, HEATHER GY
Brown BRN, BR (if tritone, for example, BK/WT/BR)
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National Retail Federation Color Code Ranges
The following table lists GS1 US color code ranges.

Beige BGE, BG
Green GRN, GR
Green Combination GRN COMBO
Blue BL, BU
Navy NVY
Bright Blue BRT BLUE
Turquoise TURQ, TRQSE
Purple PRPLE
Lavender LVNDR
Red RD
Pink PNK
Yellow YLW, YW, YL
Gold GLD
Orange ORGE
Midnight MIDNT
Assorted ASST (999)
Multicolor MULTI (960)
Printed PRNTD
Floral FLRL
Rainbow RAINBO, RNBW

No Color 000 Purple 500
Black 001 Dark Purple 501-509
Oxford 002-009 Medium Purple 510-519
Charcoal 010-019 Bright Purple 520-529
Gray 020 Lt/Pastel Purple 530-539
Dark Gray 021-029 Open Purple 540-599
Medium Gray 030-039 Red 600
Silver 040-049 Dark Red 601-609
Lt/Pastel Grey 050-059 Medium Red 610-619
Open Grey 060-099 Bright Red 620-629
White 100 Lt/Pastel Red 630-639
Natural 101-109 Open Red 640-649
Open White 110-199 Pink 650
Brown 200 Dark Pink 651-659
Dark Brown 201-209 Medium Pink 660-669
Medium Brown 210-219 Bright Pink 670-679
Rust/Copper 220-229 Lt/Pastel Pink 680-689

Color Abbreviation
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* See Table 9 in the GS1 US Color and Size Code Guidelines which can be found on 
the Product Documentation page (Product Documentation > All Documents)

GS1 US Product Category List
The following table lists all of the product categories for GS1 US size codes. You 
can use this list to set your filter criteria and narrow down the list of size codes that 
displays on the Size Code List page.

Lt/Pastel Brown 230-239 Open Pink 690-699
Open Brown 240-249 Yellow 700
Beige/Khaki 250 Dark Yellow 701-709
Dark Beige 251-259 Gold 710-719
Medium Beige 260-269 Medium Yellow 720-729
Light Beige 270-279 Bright Yellow 730-739
Open Beige 280-299 Lt/Pastel Yellow 740-749
Green 300 Open Yellow 750-799
Dark Green 301-309 Orange 800
Medium Green 310-319 Dark Orange 801-809
Bright Green 320-329 Medium Orange 810-819
Lt/Pastel Green 330-339 Bright Orange 820-829
Open Green 340-399 Lt/Pastel Orange 830-839
Blue 400 Open Orange 840-899
Dark Blue 401-409 Miscellaneous
Navy 410-419 Brown Overflow 900-919
Medium Blue 420-429 Beige Overflow 920-929
Bright Blue 430-439 Red Overflow 930-949
Turquoise/Aqua 440-449 Pink Overflow 950-959
Lt/Pastel Blue 450-459 Open 

Miscellaneous
960-998

Open Blue 460-499 Assorted Pre-
Pack* 999

Adult Male & Adult Unisex Clothing & Furnishings
All
Bath Rugs Accessories
Bed Bath Kitchen
Boys' & Unisex Students' Clothing & Furnishings
China Dinnerware Accessories
Cookware
Drinkware
Flatware

No Color 000 Purple 500
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GS1 US Product Category2 List
The following table lists all of the second level product categories for GS1 US size 
codes. You can use this list to set your filter criteria and narrow down the list of 
size codes that displays on the Size Code List page. 

Footwear Main Table
Furniture Slipcovers
Infants', Toddlers & Girl's Clothing
Jewelry
Juniors, Misses' & Women's Clothing & Furnishings
Linear Measurements
Liter Measurements
Mattresses Boxsprings Beds
Millimeter Measurements
Miscellaneous
Pre-Pack Assortment Table
Volume Measurements
Weight Measurements
Window Treatments

Bakeware Sets No Size Code
Bath Kitchen Towels Miscellaneous Open Stock Service Accessory Pieces
Bath Rug Sets Pillows Accessories
Bath Rug Sets with Lid Priscillas Ruffled Applications
Bath Rugs Protective Coverings
Bed Bath Accessories Ring Sizes
Bed Pillows Pillowcases Shams Rod Sleeves Shades Side Cascades Toppers
Bed Sheets Sheet Sets Rug Set
Bedskirts Canopies Servers
Bedspreads Duvets Service Sets
Blankets Quilts Shower Curtains Accessories
Bracelets Watches Sizes Beginning With a Letter
Brazil Footwear Sizes Sizes Beginning With a Letter or Word
Cascades Festoons Jabots Swags Sizes Beginning With a Number
Comforters Feather Beds Slipcovers
Cookware Sets Spoons
Curtain Rods Accessories Table Linens
Dinnerware Sets Tank Set
European Footwear Sizes Tiebacks
European Sizes Beginning With a Letter Toilet Lid Covers
European Sizes Beginning With a Number United Kingdom Footwear Sizes
Flatware Piece Sets United States Customary Units



W O R K I N G  W I T H  C O L O R  A N D  S I Z E  C O D E S
GS1 US Product Category2 List

OpenText Active Catalogue CE 21.2 Browser Interface User Guide  119

7

Forks United States Footwear Sizes
Knives United States Sizes Beginning With a Letter
Lined Curtains Drapes Panels Tiers United States Sizes Beginning With a Letter 

or Word
Mastectomy Pads United States Sizes Beginning With a Number
Metric System Unlined Curtains Drapes Panels Tiers
Metric Units US Customary and Metric Units

Miscellaneous Valances Window Accessories
Mondopoint
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A compliance check is a way to validate Catalogue data against a set of pre-
determined rules. Compliance checks can be used to enforce industry standards 
and may be mandated by your trading partners. 
This section describes the compliance checks that are available, explains how to 
enable the compliance checks, and discusses the options that are available if your 
data does not pass a compliance check.
For detailed information about the validation rules that apply to each compliance 
check, see the OpenText Active Catalogue Attributes Guide.
This section is organized as follows: 
■ “About Compliance Checks” on page 120.
■ “Email Notifications for Compliance Checks” on page 122.

About Compliance Checks
OpenText Active Catalogue can perform several different compliance checks. The 
compliance checks that are available to your account are determined by your 
OpenText administrator. Some options may be grayed out, indicating that the 
compliance check is mandatory for your account.
When a compliance check is enabled, Catalogue verifies that an item meets the 
data requirements for a particular set of validation rules. If the data is non-
compliant, you can decide whether Catalogue should reject the data.
The following compliance checks are available:
■ Item Maintenance Compatibility — verifies that an item is compliant with 

specific rules, as follows:
■ Item identifiers of type EO are not allowed
■ 14-digit UK item identifiers must start with 0
■ Items with the following prepack types are not allowed: CA, DS, IP, MX, PL

Note: You cannot add a mock GTIN (used for Catalogue/Intelligent Web 
Forms (IWF) integration) if the Item Maintenance Compatibility compliance 
check is turned on.

■ GMA Compliance — verifies that an item is compliant with GM&A (General 
Merchandise and Apparel) industry standards, as follows:
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■ Color code, Color Desc, Size Code and Size Desc must exist.
■ If Color Code is 000 then Color Desc must be ‘NO COLOR’ and vice-versa.
■ If Size Code is 00000 then Size Desc much be ‘NO SIZE’ and vice-versa.
■ Prepack and Size Code check: Based on the prepack code/type, size code 

must be one of the following:
■ between 10000 and 89999 (or set to 00000 'NO SIZE')
■ at least 90000 (or set to 00000 'NO SIZE')

■ Color code and Color Desc must be consistent within the Product.
■ Size code and Size Desc must be consistent within the Product.
■ Color and Size Codes can’t be modified to different values when updating 

the item.
■ Color Code, Size Code and GTIN Type must be unique.
■ Size Code must be a valid GS1 US size code. 

■ Prefix Validation — verifies that an item's GTIN begins with a GS1 (UCC/EAN) 
company prefix (also called Manufacturer Block ID) that is associated with your 
account. Not available to distributors.
Vendors must contact Support to change the settings for Prefix Validation. This 
precaution prevents a vendor from turning off prefix validation which could 
result in the vendor inadvertently using another account’s GTINs. See 
“Contacting Technical Support” on page 5.
Note: Be aware of the following:

■ If the Prefix Validation compliance check is turned on (both the “Enable 
compliance check” and “Reject non-compliant data” check boxes are 
selected”) and a GTIN uses a GS1 company prefix that is not associated 
with your account, you cannot add or modify the GTIN (the prefix is part of 
the GTIN number). 

■ If the Prefix Validation compliance check is turned off, a GTIN using a GS1 
company prefix that is not associated with your account can be added or 
modified (resulting in non-compliant data). 
Note: Check your GS1 company prefixes to be sure that they are valid. 
OpenText does not recommend using invalid GS1 company prefixes, as it 
may result in chargebacks from some of your retailers.
To view your GS1 (UCC/EAN) company prefixes, go to Account > 
Account Details and click the GS1 (UCC/EAN) Company Prefixes tab.

■ Product Description Uniqueness — verifies that an item’s Product 
Description is unique across all products within your catalogue
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Enabling Compliance Checks
Use this procedure to enable one or more compliance checks as well as choose 
whether or not to reject non-compliant data for each compliance check.
Note: Vendors must contact Support to change the settings for Prefix Validation. 
This precaution prevents a vendor from turning off prefix validation which could 
result in the vendor inadvertently using another account’s GTINs. See “Contacting 
Technical Support” on page 5.

To enable compliance checks and/or reject non-compliant data
1 Click Data Management > Compliance Checks. The Compliance Checks 

page opens.

2 Select one or more of the following check boxes under each compliance check 
that you want Catalogue to perform:

■ Enable compliance check — Enables the compliance check so that 
Catalogue performs validation of your data. If the check box is already 
checked and is grayed out, this compliance check is mandatory for your 
account. It can only be changed by your OpenText administrator.

■ Reject non-compliant data — If an item does not pass a compliance 
check, you can decide if the item should be rejected (the data will not be 
entered into the Catalogue database).
If this check box is selected, data changes received by the batch interface 
will go to error processing, and you are notified by email (see “Email 
Notifications for Compliance Checks” on page 122). Changes made through 
the user interface (UI) are reported directly through the UI.

3 Click Save. Your options are saved.

Email Notifications for Compliance Checks
For EDI documents, you are notified by email when an item fails to meet the data 
requirements of a compliance check. You must have the Reject non-compliant 
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data check box selected to receive emails. See “Enabling Compliance Checks” on 
page 122.
Catalogue sends you a summary email for each EDI document that contains errors. 
The email is sent to the primary contact email address for your account (Account 
> Account Details). Be sure that this email address is valid.
The email includes a hyperlink to the browser interface where you can 
troubleshoot the errors. 
The email can be recognized by its subject line:

"OpenText Active Catalogue error report (control number: DocumentControlNumber)" 
See the example below. The email includes the number of qXML functions 
(translated from EDI) that were rejected and a summary of the errors.
Example
Subject: OpenText Active Catalogue error report (control number: DocumentControlNumber)

One or more errors occurred while processing your input file. Please login to the OpenText Active 
Catalogue User Interface to review and manage these errors.
( https://catalogue.gxs.com)

Control number: DocumentControlNumber
Date:              May 6, 2007
Time:              5:27:38 AM
Number of errors:  360

Error    Count  Description
-20505   23     Failed to get existing item attributes; error code=-20505
-20505   15     Item Number not found
-20511   3      Duplicate item number302 
-90034   1      Item number already exists
-20510   318 Specified Selection Code or Product not found. It may have been deleted by 
another user.

You can use Error Processing in the browser interface to view and manage errors. 
For more information, see Chapter 14, "Online Correction of Errors," on page 235.

https://catalogue.gxs.com
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This section explains how to maintain your product catalogue. Topics include 
adding, updating, and deleting Selection Codes, Products, and GTINs and the 
descriptive attributes for each, as well as image attributes and physical images. 
The section includes validation requirements for GTIN attributes and GTIN 
containers and components. 
This section is organized as follows: 
■ “Special Character Encoding Guidelines” on page 125
■ “Adding Selection Codes” on page 126
■ “Editing Selection Code Descriptions” on page 127
■ “Deleting Selection Codes” on page 128.
■ “Adding Products” on page 128.
■ “Editing Product Details” on page 130
■ “Adding and Editing Custom Field Values for a Product” on page 131
■ “Moving a Product to a Different Selection Code” on page 133
■ “Deleting Products” on page 134
■ “Adding Image Attributes to a Product” on page 135
■ “Adding (Uploading) Physical Images to a Product” on page 139
■ “Updating Product Image Attributes” on page 140
■ “Updating Product Physical Images” on page 143
■ “Deleting Image Attributes from a Product” on page 143
■ “Deleting Physical Images from a Product” on page 144
■ “Adding GTINs” on page 145
■ “Adding GTINs By Copying and Modifying an Existing GTIN” on page 147
■ “Editing GTINs” on page 148
■ “Editing Multiple GTINs under a Product” on page 149
■ “Deleting GTINs” on page 150
■ “Adding Image Attributes to a GTIN” on page 151
■ “Adding (Uploading) Physical Images to a GTIN” on page 154
■ “Updating GTIN Image Attributes” on page 155
■ “Updating GTIN Physical Images” on page 158
■ “Deleting Image Attributes from a GTIN” on page 158
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■ “Deleting Physical Images from a GTIN” on page 159
■ “GTIN Validation” on page 160
■ “GTIN Validation” on page 160
■ “Maintaining Container and Component GTINs” on page 161
■ “Working with Attributes” on page 163.
Note: If you change any information at the Selection Code, Product, or GTIN 
level, and you have other information at these levels that contains an asterisk, you 
must update that information by removing the asterisk before the system will allow 
you to save your changes. The following characters should not appear in any data 
loaded to OpenText Active Catalogue > ^ ` [ ] * ~ 

Special Character Encoding Guidelines
Generally, issues with special characters stem from character encoding 
mismatches. Active Catalogue uses the Windows-1252 (Cp1252) character 
encoding. This is similar to ISO-8859-1, and the two special characters supported 
by Active Catalogue, the copyright character and the registered trademark 
character, are mapped identically between the two encodings.
Depending on the interface you use, use the one of the following methods to 
ensure that special characters are handled properly:
■ Preferred method. Use a text editor with a Character Map tool and select the 

ISO-8859-1 encoding. Most modern text editors have Character Map tools that 
allow you to change the encoding and copy the desired special character to the 
clipboard. The special character can then be pasted into a field in the UI or 
pasted into the file for subsequent loading via text file upload.

■ When generating EDI or Web Services requests for submission to Catalogue, the 
mechanism used to create the file must use ISO-8859-1 encoding.
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Adding Selection Codes
Selection Codes are the top level of your product organization system. 

To add selection codes
1 Click Catalogue > Selection Code List. The Selection Code List page opens. 

2 Click Add. The Add Selection Code(s) page opens. 

3 For each new Selection Code, enter a new, 3-digit Selection Code in the first 
column. 

4 Optional, but recommended. Enter Selection Code Description up to 25 
characters. 
Note: The following characters should not appear in any data loaded into 
OpenText Active Catalogue > ^ ` [ ] * ~

5 Do one of the following:
■ To save the Selection Codes, and return to the Selection Code List page, 

click Save. 
■ To save the Selection Codes you have entered and remain on the Add 

Selection Code(s) page with additional blank fields for adding more 
Selection Codes, click Add More and repeat the procedure from Step 3. 

6 Click Save to save the Selection Codes. 
7 Click Close to return to the Selection Code List page.
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Editing Selection Code Descriptions
A Selection Code description is recommended but not required. 

To edit a Selection Code description
1 Find the Selection Code. See “Finding Selection Codes” on page 77. The 

Selection Code List page opens.

2 Click the Selection Code’s hyperlink (the 3-digit number in the Selection Code 
column). The Selection Code Details popup opens. 

3 Type the new description in the Description field (maximum of 25 characters), 
then click Save. 
Note: The following characters should not appear in any data loaded to 
OpenText Active Catalogue > ^ ` [ ] * ~

4 To close the popup, click close at the top right corner. 
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Deleting Selection Codes
If you delete a Selection Code, the Selection Code, all Products (including all 
Product images) and all GTINs (including all GTIN images) under the Selection 
Code will also be deleted. 

To delete a Selection Code
1 Find the Selection Code. See “Finding Selection Codes” on page 77. The 

Selection Code List page opens.

2 Select the check box to the left of the Selection Code you want to delete. 
3 Click Delete. A message asks if you if you want to proceed with deletion of the 

Selection Code. 
4 Do one of the following:

■ To delete the Selection Code, click OK. A message confirms the deletion or 
reports an error. 

■ To cancel the deletion, click Cancel.

Adding Products
To add a Product, you must know the Selection Code above the Product. 

To add a Product
1 Click Catalogue > Advanced Search. The Find Catalogue Data page opens. 
2 Select Selection Code, type the full Selection Code that will contain the new 

Product(s), and select EQUAL from the drop-down list.
3 Click Search. 

One of the following occurs:
■ The Product List page opens listing current Products under the Selection 

Code. Go to the next step.
■ If no Products have ever existed for this Selection Code, the Selection Code 

List page opens. Click the Product’s hyperlink (in the Products column). In 
this case, the hyperlink will be a zero (meaning that zero Products currently 
exist under this Selection Code). The Add Product(s) page opens. Go to 
Step 5.



M A I N T A I N I N G  C A T A L O G U E  D A T A
Adding Products

OpenText Active Catalogue CE 21.2 Browser Interface User Guide  129

9

■ If a Product has been added to and deleted from this Selection Code, and 
no Products currently exist, the Add Product(s) page opens. Go to Step 5.

4 Click Add to open the Add Product(s) page. 

5 For each new Product under the Selection Code, enter:
■ Required. Product—The Product identifier (maximum of 20 characters)

Note: Do not use any of the following in a Product identifier: 
■ Leading spaces
■ Illegal characters > ^ ` [ ] * ~
■ Special characters ! @ # $ % & * ( ) _ / |

Product identifiers are stored and exported in upper case, even if you load 
the Product in lower or mixed case.

■ Required. Description—The description of the Product (maximum of 25 
characters)

■ Optional. Extended Description—The extended description of the 
Product (maximum of 40 characters)

Note: When using the UI, you can only add foreign language product 
description or product extended description by modifying an existing product. 
See “Editing Product Details” on page 130.

6 Do one of the following:
■ To save the Products, and return to the Product List page, click Save. 
■ To save the Products you have entered and remain on the Add Product(s) 

page with additional blank fields for adding more Products to the Selection 
Code, click Add More and repeat the procedure from Step 5. 

7 Click Save to save the Products.



130 OpenText Active Catalogue CE 21.2 Browser Interface User Guide

M A I N T A I N I N G  C A T A L O G U E  D A T A

Editing Product Details

8 Click Close to return to the Product List page.

Editing Product Details
You can edit the Product description and Product extended description, but not the 
Product identifier (Name). 

To edit Product details
1 Find the Product to edit:

■ See “Finding Products Across Selection Codes” on page 80.
■ See “Finding Products Under One Selection Code” on page 82.

The Product List page opens.

2 Click the Product’s hyperlink (in the Product column). The Edit Product page 
opens. 
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3 In the Standard Product Attributes section, at the top of the page, type your 
edits in the Description (maximum of 25 characters) and/or Extended 
Description (maximum of 40 characters) fields. 
Note: Do not use any of the following illegal characters > ^ ` [ ] * ~

4 Optional. In the Foreign Language Descriptions section, to add foreign 
language product descriptions, type your descriptions (maximum of 25 
characters) and/or extended descriptions (maximum of 40 characters) for the 
languages shown, in the appropriate fields. You do not need to specify an 
international description in order to specify an international extended 
description; you can provide one description without the other.
Note: Do not use any of the following illegal characters > ^ ` [ ] * ~

5 Click Save.

Adding and Editing Custom Field Values for a Product
Catalogue supports account-specific custom fields (attributes) at the Product level, 
thereby allowing Intelligent Web Forms (IWF) integration with Catalogue. 
The vendor must first add the custom fields (called custom field definitions) using 
the browser user interface (UI). Once the custom fields have been added, they can 
be populated with values by either the vendor (using the UI, an EDI 888 
document, or web services) or the retailer (using the UI or web services).
Note: Once a vendor defines a custom field, the field is available to be populated 
by all retailers who have access to a particular Product in that vendor’s catalogue.
See “Adding a Custom Field Definition” on page 60 for details on how to add a 
custom field definition.

To add or edit custom field values for a Product
1 Find the Product to edit:

■ See “Finding Products Across Selection Codes” on page 80.
■ See “Finding Products Under One Selection Code” on page 82.

The Product List page opens.
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2 Click the Product’s hyperlink (in the Product column). The Edit Product page 
opens.

Note: If custom fields have not been defined for any Products in this account, 
the Account-specific Custom Field Values section, at the bottom of the page, 
does not display.

3 In the Account-specific Custom Field Values section, in the Account Name 
text box, type the name of the account whose custom field values you want to 
edit. 
As you type the account name, a drop-down list appears and auto-fills with 
account names that match the characters you are typing. The more characters 
you type, the closer the match, and the less items that appear in the drop-
down list. 
Select an account name from this list.
Note: To further narrow the list, you can select the Fields Present check 
box; the list will display only those accounts that have at least one custom field 
value populating a custom field.

4 For each custom field for the selected account name, type a value in the 
corresponding Value field. If a custom field supports multiline values, a More 
link displays. Once you have entered a value for the first custom field value, 
click More to display the field for the next custom field value. Repeat this 
process to add additional custom field values.
Note: Do not use any of the following illegal characters > ^ ` [ ] * ~

5 Click Save to save the values. The new values are saved for the selected 
account.

6 Repeat Steps 3-5, as needed, to assign custom field values for other accounts.
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Moving a Product to a Different Selection Code
OpenText Active Catalogue can move a Product and all of its GTINs and associated 
attributes to a Selection Code that you specify. 
Note: Traditionally, vendors used the Product Move function to hide or expose a 
Product to particular retailers by placing a Product under a Selection Code with the 
appropriate access (Restricted or Unrestricted). The Catalogue now supports 
Product-level access which allows a vendor to restrict a retailer’s access to 
individual Products. See Chapter 3, "Working With Access Rights," on page 38.

To move a Product
1 Find the Product to move:

■ See “Finding Products Across Selection Codes” on page 80.
■ See “Finding Products Under One Selection Code” on page 82.

The Product List page opens.

2 Click the Product’s hyperlink (in the Product column). 
3 On a Product List page, select the check box next to the Product you want to 

move and click Move. The Move Product(s) popup opens.
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4 Type the Selection Code you want to move the Product to. As you type, 
available Selection Code matches and their corresponding descriptions display 
in the drop-down list.

5 Select a value from the drop-down list.
6 Click Move. 

OpenText Active Catalogue moves the Product and all of its GTINs and 
associated attributes to the specified Selection Code. It does not change 
attribute data other than Selection Code data. A message indicates that the 
Product was moved successfully. 
Retailers who do not have access to the Selection Code under which the 
Product moves will not be able to export the data until they are granted access.
Note: Moving a Product in this way does not impact UCCnet registration of 
the Product.

Deleting Products
If you delete a Product, the Product (including all Product images) and all GTINs 
under the Product (including all GTIN images) will be deleted. 

To delete a Product
1 Find the Product: 

■ See “Finding Products Across Selection Codes” on page 80. 
■ See “Finding Products Under One Selection Code” on page 82. 
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The Product List page opens.

2 Select the check box to the left of the Product you want to delete. 
3 Click Delete. A message asks if you want to proceed with deletion of the 

Product. 
4 Do one of the following:

■ To delete the Product, click OK. A message confirms the deletion or reports 
an error. 

■ To cancel the deletion, click Cancel.

Adding Image Attributes to a Product
A set of image attributes can be added to a Product. An attribute set represents a 
single image and must be added for every image you want to add to the Product. 
The file name must be unique for each attribute set within a Product.
Once a set of image attributes has been added, you can add (upload) a physical 
image that is associated with that set of attributes. Multiple attribute sets (and 
physical images) can be added for each Product.

Color Code - Optional
If the image has a color code associated with it, you have the option to add the 
image at the Product level or at the Product + Color Code level. There are separate 
icons on the Product Media page for adding an image at each of these levels.
After the attribute set is added, you cannot change the level at which you have 
added the image.

To add image attributes to a Product
1 Find the Product you want to add the image attributes to.

■ See “Finding Products Across Selection Codes” on page 80. 
■ See “Finding Products Under One Selection Code” on page 82.

The Product List page opens.
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2 Click the image hyperlink (in the Image column) for the Product. 

The Product Media page opens. Note that there are two add icons, one for 
adding the image at the Product level and one for adding the image at the 
Product + Color Code level.

3 Do one of the following:
To add a... Do this:
Product level image 1 From the Product Media page, click Add Product Level 

Image.

The Product Level Image Attributes popup opens.

1

2
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4 Use the attribute fields and/or drop-down lists to add the attribute values of the 
image. 
The required attributes are highlighted in red with a red asterisk.

■ Color Code—Required only for Product + Color Code Level image. Cannot 
be changed once attribute set is added.

■ File Name—Required. The file name of the attribute set. The name must 
be unique for each attribute set within a Product. Cannot be changed once 
attribute set is added.
Note: You must include the file extension; for example, sample.jpg. Do 
not use any of the following illegal characters < > ^ : & ? \ / | + %

■ File Type—Required. The type of file. Value must be JPG (JPEG).
■ Image Type—Required. The type of image. Value must be SI (Still Shot).
■ Purpose—Required. The intended use of the image. Value must be INT 

(internet).
■ Orientation—Required. The orientation of the image:

To add a... Do this:
Product + Color Code 
level image

1 From the Product Media page, click Add Product + 
Color Code Level Image.

The Product + Color Code Level Image Attributes popup 
opens.
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■ PRI - Primary
■ SDL - Side Left
■ SDR - Side Right
■ VF1 - Front
■ VIB - Bottom
■ VIK - Back
■ VIS - Side
■ VIT - Top

■ Location Type—Required. The location type for the image:
■ ACL - Application Transaction Reference Number
■ FTP - File Transfer Protocol
■ LMI - Local Media Identifier
■ URL - Uniform Resource Locator

■ External Location—Required only when value of Location Type is FTP or 
URL. The location of the image.

■ File Size—Optional. The size of the file.
■ Pixel Density (DPI)—Optional. Pixel density (DPI) for image.
■ Height—Optional. The image pixel height.
■ Width—Optional. The image pixel width.
■ Image Style—Optional. The image style:

■ CSW - Color swatch
■ PRO - Product

■ Facing (GDSN)—Optional. The direction from which the image is viewed:
■ 1 - Front
■ 2 - Left
■ 3 - Top
■ 7 - Back
■ 8 - Right
■ 9 - Bottom

■ Angle—Optional. The horizontal direction of the image: 
■ 1 - Center, No plunge angle
■ 2 - Left, No plunge angle
■ 3 - Right, No plunge angle
■ 7 - Center, Plunge angle present
■ 8 - Left, Plunge angle present
■ 9 - Right, Plunge angle present
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■ Clipping Path—Optional. The name of a path defined in the image itself 
that defines the outline of the subject of the image.

■ Image Description—Optional. The description of the image.
5 Click Save. 

The image attribute set has been added to the Product.
To add a physical image to the Product, see “Adding (Uploading) Physical 
Images to a Product” on page 139.

Adding (Uploading) Physical Images to a Product
After a set of image attributes has been added to a Product (see “Adding Image 
Attributes to a Product” on page 135), you can add (upload) a physical image that 
is associated with that set of attributes. Multiple attribute sets (and physical 
images) can be added for each Product.
Note: Image file type must be JPEG with the level of compression at 10 or above. 
Image size is limited to 500 KB per image. There is a limit of 50,000 images per 
account.
Uploading an image replaces the current image, if one already exists. You do not 
need to delete an image before uploading a new one. Therefore, you can also use 
the following procedure to update an existing image.

To add (upload) a physical image to a Product
1 Find the Product you want to add the physical image to.

■ See “Finding Products Across Selection Codes” on page 80. 
■ See “Finding Products Under One Selection Code” on page 82.

The Product List page opens.
2 Click the image hyperlink (in the Image column) for the Product you want to 

add the image to.
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The Product Media page opens. 

3 Click Upload Image for the appropriate Product image. 
The Upload Image popup opens.

4 Click Browse. The Choose File to Upload dialog box opens. 
5 Navigate to the image you want to upload, select it, and click Open. The path 

to the file displays in the Upload Image box.
6 Click Save. 

The image has been added to the Product.

Updating Product Image Attributes
You can update images attributes associated with a Product.

To update image attributes associated with a Product
1 Find the Product whose image attributes you want to update.

■ See “Finding Products Across Selection Codes” on page 80. 
■ See “Finding Products Under One Selection Code” on page 82.

The Product List page opens.
2 Click the image hyperlink (in the Image column) for the Product whose image 

attributes you want to update. 
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The Product Media page opens. 

3 Click Update Image Attributes for the appropriate Product image. 
The Product Level Image or Product + Color Code Level Image Attributes 
popup opens, depending on the image.

4 Use the attribute fields and/or drop-down lists to update the image attribute 
values of the image. 
The required attributes are highlighted in red with a red asterisk.
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■ Color Code—Displays for Product + Color Code Level images only. Cannot 
be changed once attribute set is added.

■ File Name—Cannot be changed once attribute set is added.
■ File Type—Required. The type of file. Value must be JPG (JPEG).
■ Image Type—Required. The type of image. Value must be SI (Still Shot).
■ Purpose—Required. The intended use of the image. Value must be INT 

(internet).
■ Orientation—Required. The orientation of the image:

■ PRI - Primary
■ SDL - Side Left
■ SDR - Side Right
■ VF1 - Front
■ VIB - Bottom
■ VIK - Back
■ VIS - Side
■ VIT - Top

■ Location Type—Required. The location type for the image:
■ ACL - Application Transaction Reference Number
■ FTP - File Transfer Protocol
■ LMI - Local Media Identifier
■ URL - Uniform Resource Locator

■ External Location—Required only when value of Location Type is FTP or 
URL. The location of the image.

■ File Size—Optional. The size of the file.
■ Pixel Density (DPI)—Optional. Pixel density (DPI) for image.
■ Height—Optional. The image pixel height.
■ Width—Optional. The image pixel width.
■ Image Style—Optional. The image style:

■ CSW - Color swatch
■ PRO - Product

■ Facing (GDSN)—Optional. The direction from which the image is viewed:
■ 1 - Front
■ 2 - Left
■ 3 - Top
■ 7 - Back
■ 8 - Right
■ 9 - Bottom

■ Angle—Optional. The horizontal direction of the image: 
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■ 1 - Center, No plunge angle
■ 2 - Left, No plunge angle
■ 3 - Right, No plunge angle
■ 7 - Center, Plunge angle present
■ 8 - Left, Plunge angle present
■ 9 - Right, Plunge angle present

■ Clipping Path—Optional. The name of a path defined in the image itself 
that defines the outline of the subject of the image.

■ Image Description—Optional. The description of the image.
5 Click Save. 

The Product image attribute set has been updated.

Updating Product Physical Images
Uploading a new image replaces the current image; you do not need to delete an 
image before uploading a new one. 
To upload a new Product physical image to replace a current image, see “Adding 
(Uploading) Physical Images to a Product” on page 139.

Deleting Image Attributes from a Product
Image attributes can be deleted from a Product. 
Note: Deleting the image attributes from a Product also deletes any physical 
image associated with that attribute set.

To delete image attributes from a Product
1 Find the Product from which you want to delete the image attributes.

■ See “Finding Products Across Selection Codes” on page 80. 
■ See “Finding Products Under One Selection Code” on page 82.

The Product List page opens.
2 Click the image hyperlink (in the Image column) for the Product whose image 

attributes you want to delete. 
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The Product Media page opens. 

3 Click Delete Image Attributes for the appropriate Product image. A message 
asks if you want to proceed with deletion of the image attributes. 
Note: Deleting a set of image attributes from a Product also deletes any 
physical image that is also associated with that set of image attributes.

4 Do one of the following:
■ To delete the attributes, click OK.
■ To cancel the deletion, click Cancel.

Deleting Physical Images from a Product
Physical images can be deleted from a Product. 

To delete a physical image from a Product
1 Find the Product from which you want to delete the image.

■ See “Finding Products Across Selection Codes” on page 80. 
■ See “Finding Products Under One Selection Code” on page 82.

The Product List page opens.
2 Click the image hyperlink (in the Image column) for the Product whose image 

you want to delete. 
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The Product Media page opens. 

3 Click Delete Image for the appropriate Product image. A message asks if you 
want to proceed with deletion of the image. 

4 Do one of the following:
■ To delete the physical image, click OK. 
■ To cancel the deletion, click Cancel.

Adding GTINs
To add a GTIN, you must know the Product that will contain the GTIN. Also, you 
cannot move an existing GTIN to another Product. Delete the GTIN, and then re-
add it under the other Product. 

To add a GTIN
1 Click Catalogue > Advanced Search. The Find Catalogue Data page opens.
2 Select Product.
3 Select one of the following Product search options:

■ Identifier—The Product identifier 
■ Description—The description of the Product
■ Compressed—The compressed Product identifier (leading zeros, spaces, 

and special characters are ignored)
If you perform a Compressed Product search, the system retrieves all 
Products with compressed product values that exactly match the value you 
type in the Product field. Compressed Product identifiers omit leading 
zeroes, spaces, and special characters in Product identifiers for purposes of 
the Product search. 
For example, the Compressed Product identifier for 000324 MENS SHOES is 
324MENSSHOES. Sending 324MENSSHOES in a Compressed Product 



146 OpenText Active Catalogue CE 21.2 Browser Interface User Guide

M A I N T A I N I N G  C A T A L O G U E  D A T A

Adding GTINs

search returns all Products with that sequence of characters, ignoring 
leading zeroes, spaces, and special characters in the actual Product 
identifiers.

4 Select EQUAL from the Product drop-down list (EQUAL is automatically 
selected and is the only option for Description and Compressed), and type the 
full Product identifier, description, or compressed Product identifier in the field.

5 Click Search. 
One of the following occurs:

■ If the Product already contains GTINs, the GTIN List page opens. Go to 
Step 7.

■ If the Product does not contain any GTINs, the Product List page opens. Go 
to Step 6.

6 On the Product List page, in the GTINs column, click the 0 (zero) hyperlink.

The GTIN List page opens.
7 On the GTIN List page, click Add.

The GTIN Detail (New) page opens. 

8 Optional. To change the attribute filter (the filter determines the attributes that 
display on the page), select an attribute filter from the Change Attribute 
Filter drop-down list.

9 Enter the unique GTIN and GTIN Type. To automatically calculate a check 
digit for the GTIN, go to the following URL:
http://www.gs1us.org/solutions_services/tools/check_digit_calculator

See “GTIN Number Structures” on page 256.

http://www.gs1us.org/solutions_services/tools/check_digit_calculator
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10 Populate all required attributes. Use the following tips:
■ See “Working with Attributes” on page 163.
■ To jump to a specific attribute group, select an attribute group from the 

Jump To Group drop-down list. 
■ To use the Find link for the Color Code and Size Code fields, see “Find Link” 

on page 17. 
11 Optional. To make the GTIN a container, use the Prepack/Container Code 

field. See the following: 
■ “GTIN Validation” on page 160.
■ “Container and Component GTIN Codes” on page 258. 

12 Do one of the following: 
■ To save the GTIN, click Save.
■ To save the GTIN and add more GTINs to the Product, click Add and 

repeat Steps 8 through 11. 
■ To save the GTIN and base a new GTIN on a copy of the GTIN you are 

adding, click Copy. See “Adding GTINs By Copying and Modifying an 
Existing GTIN” on page 147. 

Adding GTINs By Copying and Modifying an Existing GTIN
To save time adding the attribute data of a new GTIN, you can copy the attribute 
data of an existing GTIN and modify it.

To add a GTIN by copying and modifying an existing GTIN
1 Find the GTIN that you want to copy and modify for the new GTIN, or add a 

GTIN that will be used as the basis for the new GTIN:
■ See “Finding GTINs Across Selection Codes” on page 88. 
■ See “Finding GTINs Under One Product” on page 90. 
■ See “Adding GTINs” on page 145.

2 Open the GTIN Detail (Copy) page using one of these methods: 
■ On a GTIN List page, select the check box to the left of the GTIN you want 

to copy, then click Copy. 
■ On the GTIN Detail (New), GTIN Detail (Edit), or GTIN Detail (View) page, 

click Copy. 
The GTIN Detail (Copy) page opens with attributes populated with the same 
values as the selected GTIN. 

3 Optional. To change the attribute filter (which determines the attributes that 
display on the page), select an attribute filter from the Change Attribute 
Filter drop-down list (under the heading information)

4 Enter the new GTIN and GTIN Type (use all caps). To automatically calculate 
a check digit for the GTIN, go to the following URL: 
http://www.gs1us.org/solutions_services/tools/check_digit_calculator

http://www.gs1us.org/solutions_services/tools/check_digit_calculator


148 OpenText Active Catalogue CE 21.2 Browser Interface User Guide

M A I N T A I N I N G  C A T A L O G U E  D A T A

Editing GTINs

See “GTIN Number Structures” on page 256.
5 Populate all required attributes. Use the following tips:

■ See “Working with Attributes” on page 163.
■ To jump to a specific attribute group, select an attribute group from the 

Jump To Group drop-down list. 
■ To use the Find link for the Color Code and Size Code fields, see “Find Link” 

on page 17. 
6 Optional. To make the GTIN a container, use the Prepack/Container Code 

field. See the following: 
■ “GTIN Validation” on page 160.
■ “Container and Component GTIN Codes” on page 258. 

7 Optional for OpenText Active Catalogue vendors. Change the Product and 
Product Desc (Product description). Optionally, you can also change the 
Product Extended Desc (Product extended description) field to do either of 
the following: 

■ Create a new Product with Product Desc (Product description) to place 
the new GTIN under. 

■ Enter the Product and Product Desc (Product description) of a different, 
existing Product to place the new GTIN under. 

Note: Product Desc (Product description) must contain a value, but it will 
be ignored for Products that already exist. 

8 Use the attribute fields and/or drop-down lists to add or edit attribute values. 
See “Working with Attributes” on page 163.
Note: Use the same attribute filter as for the original GTIN. Otherwise, some 
attributes in the original may not be included in the new GTIN. 

9 Do one of the following: 
■ To save the new GTIN, click Save. 
■ To save the new GTIN and add another GTIN that is not based on an 

existing GTIN (copied), click Add. 

Editing GTINs
Use the Edit GTIN Details page to add or change GTIN attribute values. You can 
edit GTIN attributes, but not the GTIN and GTIN Type.

To edit GTIN attributes
1 Find the GTIN to edit:

■ See “Finding GTINs Across Selection Codes” on page 88. 
■ See “Finding GTINs Under One Product” on page 90.

2 Select the check box to the left of the GTIN you want to edit, then click Edit. 
(You can also click Edit on the GTIN Detail (View) page). 



M A I N T A I N I N G  C A T A L O G U E  D A T A
Editing Multiple GTINs under a Product

OpenText Active Catalogue CE 21.2 Browser Interface User Guide  149

9

The GTIN Detail (Edit) page opens. 

To view all the associated attributes, use the horizontal scroll bar at the bottom 
of the page, and/or hide the navigation panel.

3 Use the attribute fields and/or drop-down lists to add or edit attribute values. 
Use the following tips:

■ See “Working with Attributes” on page 163.
■ To jump to a specific attribute group, select an attribute group from the 

Jump To Group drop-down list. 
■ To use the Find link for the Color Code and Size Code fields, see “Find Link” 

on page 17. 
4 Do one of the following: 

■ To save your edits, click Save. 
■ To save your edits and move on to edit the next GTIN, click Save & Next.
■ To save your edits and add a new GTIN, click Add. 
■ To save your edits and add a new GTIN with attributes automatically 

populated the same as the current GTIN, click Copy. 

Editing Multiple GTINs under a Product
Use the Edit GTIN Details page to update GTIN attribute values for multiple GTINs 
under a Product. A minimum of two GTINS and a maximum of 25 GTINs can be 
modified at one time.
The following attributes cannot be updated for multiple GTINs at one time:

■ Prepack/Container Code
■ Color Code
■ Color Description
■ Size Code
■ Size Description
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To update multiple GTINs
1 Find the GTINs you want to update:

■ See “Finding GTINs Under One Product” on page 90.
2 Select the check boxes to the left of the GTINs you want to update (or select 

the check box in the header to select all GTINs and then deselect those you do 
not want to update), then click Edit.
The GTIN Detail (Edit) page opens.
Note: All attribute fields are blank. This is an update action (not replace), so 
only populated attributes will be updated for all the GTINs that are selected; 
blank attributes values will NOT overwrite or delete existing attribute values. 

To view all the associated attributes, use the horizontal scroll bar at the bottom 
of the page, and/or hide the navigation panel.

3 Use the attribute fields and/or drop-down lists to populate attribute values. Use 
the following tips:

■ See “Working with Attributes” on page 163.
■ To jump to a specific attribute group, select an attribute group from the 

Jump To Group drop-down list. 
4 Do one of the following: 

■ To clear all fields, click Reset. Return to step 3 to populate attribute 
values.

■ To save your edits, click Save. A message indicates that the attribute 
values on the page will be applied to the number of GTINs you have 
selected. Click Yes to continue or No to Cancel. Upon saving, your 
changes are applied to the selected attributes.

Deleting GTINs
If you delete a GTIN, the GTIN (including all GTIN images) will be permanently 
deleted. 

To delete a GTIN
1 Find the GTIN to delete: 
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■ See “Finding GTINs Across Selection Codes” on page 88. 
■ See “Finding GTINs Under One Product” on page 90.

2 Select the check box to the left of the GTIN you want to edit.
3 Click Delete. You can also click Delete on the GTIN Detail (View) page. A 

message asks if you want to proceed with deletion of the GTIN. 
4 Do one of the following:

■ To delete the GTIN, click OK. A message confirms the deletion or reports 
an error. 

■ To cancel the deletion, click Cancel.

Adding Image Attributes to a GTIN
A set of image attributes can be added to a GTIN. An attribute set represents a 
single image and must be added for every image you want to add to the GTIN. The 
file name must be unique for each attribute set within a GTIN.
Once a set of image attributes has been added, you can add (upload) a physical 
image that is associated with that set of attributes. Multiple attribute sets (and 
physical images) can be added for each GTIN.

To add image attributes to a GTIN
1 Find the GTIN you want to add the image attributes to.

■ See “Finding GTINs Across Selection Codes” on page 88. 
■ See “Finding GTINs Under One Product” on page 90.

The GTIN List page opens.
2 Click the image hyperlink (in the Image column) for the GTIN.

The Item Media page opens. 

3 Click Add Item Level Image. 
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The Item Level Image Attributes popup opens.

4 Use the attribute fields and/or drop-down lists to add the attribute values of the 
image. 
The required attributes are highlighted in red with a red asterisk.

■ File Name—Required.The file name of the attribute set. The name must 
be unique for each attribute set within a GTIN. Cannot be changed once 
attribute set is added.
Note: You must include the file extension; for example, sample.jpg. Do 
not use any of the following illegal characters < > ^ : & ? \ / | + %

■ File Type—Required. The type of file. Value must be JPG (JPEG).
■ Image Type—Required. The type of image. Value must be SI (Still Shot).
■ Purpose—Required. The intended use of the image. Value must be INT 

(internet).
■ Orientation—Required. The orientation of the image:

■ PRI - Primary
■ SDL - Side Left
■ SDR - Side Right
■ VF1 - Front
■ VIB - Bottom
■ VIK - Back
■ VIS - Side
■ VIT - Top
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■ Location Type—Required. The location type for the image:
■ ACL - Application Transaction Reference Number
■ FTP - File Transfer Protocol
■ LMI - Local Media Identifier
■ URL - Uniform Resource Locator

■ External Location—Required only when value of Location Type is FTP or 
URL. The location of the image.

■ File Size—Optional. The size of the file.
■ Pixel Density (DPI)—Optional. Pixel density (DPI) for image.
■ Height—Optional. The image pixel height.
■ Width—Optional. The image pixel width.
■ Image Style—Optional. The image style:

■ CSW - Color swatch
■ PRO - Product

■ Facing (GDSN)—Optional. The direction from which the image is viewed:
■ 1 - Front
■ 2 - Left
■ 3 - Top
■ 7 - Back
■ 8 - Right
■ 9 - Bottom

■ Angle—Optional. The horizontal direction of the image: 
■ 1 - Center, No plunge angle
■ 2 - Left, No plunge angle
■ 3 - Right, No plunge angle
■ 7 - Center, Plunge angle present
■ 8 - Left, Plunge angle present
■ 9 - Right, Plunge angle present

■ Clipping Path—Optional. The name of a path defined in the image itself 
that defines the outline of the subject of the image.

■ Image Description—Optional. A description of the image.
5 Click Save. 

The image attribute set has been added to the GTIN.
To add a physical image to the GTIN, see “Adding (Uploading) Physical Images to a 
GTIN” on page 154.
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Adding (Uploading) Physical Images to a GTIN
Once a set of image attributes has been added to a GTIN (see “Adding Image 
Attributes to a GTIN” on page 151), you can add (upload) a physical image that is 
associated with that set of attributes. Multiple attribute sets (and physical images) 
can be added for each GTIN.
Note: Image file type must be JPEG with the level of compression at 10 or above. 
Image size is limited to 500 KB per image. There is a limit of 50,000 images per 
account.
Uploading an image replaces the current image, if one already exists. You do not 
need to delete an image before uploading a new one. Therefore, you can also use 
the following procedure to update an existing image.

To add (upload) a physical image to a GTIN
1 Find the GTIN you want to add the physical image to.

■ See “Finding GTINs Across Selection Codes” on page 88. 
■ See “Finding GTINs Under One Product” on page 90.

The GTIN List page opens.
2 Click the image hyperlink (in the Image column) for the GTIN you want to add 

the image to. 

The Item Media page opens. 

3 Click Upload Image for the appropriate GTIN image attribute set. 
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The Upload Image popup opens.

4 Click Browse. The Choose File to Upload dialog box opens. 
5 Navigate to the image you want to upload, select it, and click Open. The path 

to the file displays in the Upload Image box.
6 Click Save. 

The image has been added to the GTIN.

Updating GTIN Image Attributes
You can update images attributes associated with a GTIN.

To update image attributes associated with a GTIN
1 Find the GTIN whose image attributes you want to update.

■ See “Finding GTINs Across Selection Codes” on page 88. 
■ See “Finding GTINs Under One Product” on page 90.

The GTIN List page opens.
2 Click the image hyperlink (in the Image column) for the GTIN whose image 

attributes you want to update.
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The Item Media page opens. 

3 Click Update Image Attributes for the appropriate GTIN image.
The Item Image Level Attribute popup opens.

4 Use the attribute fields and/or drop-down lists to add the image attribute values 
of the image. 
The required attributes are highlighted in red with a red asterisk.
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■ File Name— Cannot be changed once attribute set is added.
■ File Type—Required. The type of file. Value must be JPG (JPEG).
■ Image Type—Required. The type of image. Value must be SI (Still Shot).
■ Purpose—Required. The intended use of the image. Value must be INT 

(internet).
■ Orientation—Required. The orientation of the image:

■ PRI - Primary
■ SDL - Side Left
■ SDR - Side Right
■ VF1 - Front
■ VIB - Bottom
■ VIK - Back
■ VIS - Side
■ VIT - Top

■ Location Type—Required. The location type for the image:
■ ACL - Application Transaction Reference Number
■ FTP - File Transfer Protocol
■ LMI - Local Media Identifier
■ URL - Uniform Resource Locator

■ External Location—Required only when value of Location Type is FTP or 
URL. The location of the image.

■ File Size—Optional. The size of the file.
■ Pixel Density (DPI)—Optional. Pixel density (DPI) for image.
■ Height—Optional. The image pixel height.
■ Width—Optional. The image pixel width.
■ Image Style—Optional. The image style:

■ CSW - Color swatch
■ PRO - Product

■ Facing (GDSN)—Optional. The direction from which the image is viewed:
■ 1 - Front
■ 2 - Left
■ 3 - Top
■ 7 - Back
■ 8 - Right
■ 9 - Bottom

■ Angle—Optional. The horizontal direction of the image: 
■ 1 - Center, No plunge angle



158 OpenText Active Catalogue CE 21.2 Browser Interface User Guide

M A I N T A I N I N G  C A T A L O G U E  D A T A

Updating GTIN Physical Images

■ 2 - Left, No plunge angle
■ 3 - Right, No plunge angle
■ 7 - Center, Plunge angle present
■ 8 - Left, Plunge angle present
■ 9 - Right, Plunge angle present

■ Clipping Path—Optional. The name of a path defined in the image itself 
that defines the outline of the subject of the image.

■ Image Description—Optional. A description of the image.
5 Click Save. 

The GTIN image attribute set has been updated.

Updating GTIN Physical Images
Uploading a new image replaces the current image; you do not need to delete an 
image before uploading a new one. 
To upload a new GTIN physical image to replace a current image, see “Adding 
(Uploading) Physical Images to a GTIN” on page 154.

Deleting Image Attributes from a GTIN
Image attributes can be deleted from a GTIN. 
Note: Deleting the image attributes from a GTIN also deletes any physical image 
associated with that attribute set.

To delete image attributes from a GTIN
1 Find the GTIN from which you want to delete the image attributes.

■ See “Finding GTINs Across Selection Codes” on page 88. 
■ See “Finding GTINs Under One Product” on page 90.

The GTIN List page opens.
2 Click the image hyperlink (in the Image column) for the GTIN whose image 

attributes you want to delete.
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The Item Media page opens. 

3 Click Delete Image Attributes for the appropriate GTIN image. A message 
asks if you want to proceed with deletion of the image attributes. 
Note: Deleting a set of image attributes from a GTIN also deletes any 
physical image that is also associated with that set of image attributes.

4 Do one of the following:
■ To delete the image attributes, click OK. 
■ To cancel the deletion, click Cancel.

Deleting Physical Images from a GTIN
Physical images can be deleted from a GTIN. 

To delete a physical image from a GTIN
1 Find the GTIN from which you want to delete the image.

■ See “Finding GTINs Across Selection Codes” on page 88. 
■ See “Finding GTINs Under One Product” on page 90.

The GTIN List page opens.
2 Click the image hyperlink (in the Image column) for the GTIN whose image you 

want to delete. 



160 OpenText Active Catalogue CE 21.2 Browser Interface User Guide

M A I N T A I N I N G  C A T A L O G U E  D A T A

GTIN Validation

The Item Media page opens. 

3 Click Delete Image for the appropriate GTIN image. A message asks if you 
want to proceed with deletion of the image. 

4 Do one of the following:
■ To delete the physical image, click OK. 
■ To cancel the deletion, click Cancel.

GTIN Validation
Data is validated when it is saved to OpenText Active Catalogue. 
When adding or updating GTINs, OpenText Active Catalogue checks to make sure 
that:
■ The following characters do not appear in any data > ^ ` [ ] * ~
■ If the Prefix Validation compliance check is turned on, the GTIN begins with a 

GS1 (UCC/EAN) Company Prefix (formerly UCC Manufacturer Block ID) that is 
associated with your account. The compliance check can be applied to all GTIN 
types except EO and UA. For more information about compliance checks, see 
Chapter 8, "Working with Compliance Checks," on page 120.

■ Each GTIN identifier is unique in the vendor catalogue.
Note: A GTIN can exist in catalogues of a manufacturer (account type V) and 
one or more distributors (account type D). 

■ Correct check digit appears.
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■ GTIN numbers meet the requirements of the associated GTIN type. See“GTIN 
Number Structures” on page 256.

Note: Catalogue does not perform GTIN validation of mock GTINs for Intelligent 
Web Forms (IWF) customers whose accounts are set up to allow mock GTINs.

Maintaining Container and Component GTINs
Containers (also called prepacks or parent items) are GTINs that contain other 
GTINs called components (also called child items). 
Container and component rules are as follows: 
■ Specify the GTIN as a container when you add the GTIN to the catalogue. 
■ Create and save the container GTIN before assigning components to it. 
■ You can change a container designation only to a different container designation, 

not to a no designation or component designation.
■ A component designation is not required for a GTIN to be a component, but if 

the GTIN is to be sold only as part of a container it should be designated a 
component.

■ A GTIN can be designated a component at the time it is added to the catalogue 
or later (that is, assign it to a container later).

■ To change a component's quantity or unit of measure (UOM), you must remove 
the component from the container, then add it to the container again with the 
corrected information.

■ A component does not require the same Selection Code and/or Product as its 
container.

■ Deleting a container does not delete its components. It deletes only the 
container and severs the container-component relationships.

■ A component GTIN can be deleted without first removing the component from 
the container.

■ A Selection Code or Product above containers can be deleted without first 
deleting the containers. 

■ A container can have from 0 to 100 GTIN components.
■ A container can contain containers, but the second level of containers cannot 

contain a third level of containers (that is, you can have 
container/containers/components).

Assigning Components to a Container
To assign a GTIN as a component, the GTIN must already exist in OpenText Active 
Catalogue. You can also assign a container as a component to another container. 

To assign a component to a container
1 Find the GTIN container: 

■ See “Finding GTINs Across Selection Codes” on page 88. 
■ See “Finding GTINs Under One Product” on page 90. 
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2 On the GTIN List page, in the Components column, click the Component 
hyperlink of the GTIN container that you want to assign components to. 
Note: You can also click the Component hyperlink on the GTIN Detail 
screens.
Tip: Filter the GTIN list by Pack type. In the Pack column, a container is 
indicated by any value except PP, which indicates the GTIN is a component.
The View Components pop-up opens listing all components (and containers, if 
any) that are part of the selected container. 

3 Click Add. The fields for assigning a component display at the top of the pop-
up. 

4 Enter the component’s information: 
■ Component GTIN—The GTIN identifier
■ GTIN Type—The type of GTIN
■ Quantity— The quantity of the component in the container
■ Unit of Measure—The unit of measure for the quantity. See “Container 

and Component GTIN Codes” on page 258. 
Note: To change a component's quantity or unit of measure (UOM), you must 
remove the component from the container, then add it again with the corrected 
information. See “Removing Components From a Container” on page 162. 

5 Do one of the following; 
■ To add the component, click Save. 
■ To return to the previous page without saving your changes, click Cancel.

Removing Components From a Container
Removing a component from a container does not remove it from your catalogue. 
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To remove a component from a container
1 Find the container GTIN.

■ See “Finding GTINs Across Selection Codes” on page 88. 
■ See “Finding GTINs Under One Product” on page 90. 

2 On the GTIN List page, in the Components column, click the Component 
hyperlink of the GTIN container from which you want to remove components. 
The View Components pop-up opens.
Note: You can also click the Component hyperlink on the GTIN Detail 
screens.
Tip: Filter the GTIN list by Pack type. In the Pack column, a container is 
indicated by any value except PP, which indicates component. 
The View Components pop-up opens listing all components (and containers, if 
any) that are part of the selected container. 

3 In the column to the left of the component GTIN, select the check box for each 
component GTIN to delete from the container. 
Note: To view details of the component, click the GTIN’s hyperlink in the 
GTIN column. 

4 Click Delete. The components are removed from the container.

Working with Attributes
This section explains how to work with data attributes when maintaining your 
catalogue. 
Attributes are details (for example, Color, Unit Cost) of the associated record (for 
example, GTIN). The hundreds of GTIN attributes supported by OpenText Active 
Catalogue are organized in Attribute Groups. See “GTIN Attribute Groups” on 
page 69. 
Item attributes may fall under an industry standard. See “GTIN Attribute Rules” on 
page 164.
The only data attributes in OpenText Active Catalogue not used exclusively with 
GTINs are:
■ Account attributes 
■ Selection Code Description 
■ Product Description 
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■ Product Extended Description 
Note: To confirm that the attribute value you just added or updated actually 
loaded to your catalogue, click the browser Refresh on the open Add or Edit page. 
If the data loaded, it will appear on the page. If it did not load, try to load it again 
using an Edit page, not an Add page. 

GTIN Attribute Conventions
OpenText Active Catalogue employs the following conventions in its handling of 
GTIN attributes:
■ To restrict the display and export of GTIN attributes, apply an attribute filter. See 

“Working with Attribute Filters” on page 68. 
■ Press Tab to jump to the next attribute in a list.
■ The required number structures for GTIN types supported by OpenText Active 

Catalogue are described in “GTIN Number Structures” on page 256.
■ If a GTIN Description does not exist, the Color Code, Color Description, Size 

Code, and Size Description are combined to serve as a GTIN description and 
appear in brackets ([ ]).

■ When saving a GTIN, if an attribute error exists, a message describing the error 
displays. Fix the error and save again. 

■ To view the format requirements and definition of the attribute, move your 
cursor over the attribute name. 

GTIN Attribute Rules
To ensure validation of your attributes during processing, follow these rules: 
■ Follow the attribute’s format requirements. The format requirements and 

definition display as you move your cursor over the attribute name on the GTIN 
Detail (New), GTIN Detail (Edit), and GTIN Detail (Copy) pages.
The possible data types are:

■ CHAR indicates alphanumeric

■ NUMBER indicates numeric

■ DATE indicates the date format

■ The following characters should not appear in any data loaded into OpenText 
Active Catalogue > ^ ` [ ] * ~

■ Select Unit of Measure (UOM), where applicable, from the drop-down list next to 
the attribute value field.

Data Type Description
CHAR The maximum number of alphanumeric characters allowed.
NUMBER The maximum number of numeric characters allowed (first digit). A second 

digit, if any, indicates the number of digits allowed to the right of the 
decimal. 

DATE Use the DATE format you selected as your account preference. See 
“Maintaining Your Account” on page 49. 
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■ Booking Date must precede Availability Date, which must precede Discontinue 
Date.

■ Use a Cancel Date only if the GTIN was never produced or shipped. (The GTIN is 
automatically deleted 12 months after the Cancel Date.) If the GTIN was 
produced or shipped, use a Discontinue Date.

■ Additional industry standard compliance checks may be configured for your 
account. For more information about compliance checks, see the OpenText 
Active Catalogue Attributes Guide.

GDS Network Attributes
Accounts interfacing with the GDS network generally use the GDSN filter as the 
default attribute filter when creating and viewing the GTIN information.

On the GTIN Detail page, the Classification attributes must be populated as 
described below. 

The OpenText Active Catalogue attribute Classification Level 1 Value must be 
populated with both of the following values for data that will be sent into the GDS 
network.
■ A UDEX classification value in XX.XXXX.XXXX format. The value must exist in the 

UDEX list of allowable values.
■ A Global Product Classification (GPC) code in an 8-digit numeric format 

(XXXXXXXX). The value must be an acceptable GPC code.
For those vendors that utilized legacy UCCnet services in the past and previously 
assigned UDEX classification values to their items, the 1SYNC website contains a 
suggested mapping from UDEX to GPC. This is not a comprehensive list, but may 
be useful to some vendors who need assistance with the process. You must have a 
logon to the 1SYNC (UCCnet) Subscriber web site to access this page. The user ID 
and password information is provided by 1SYNC once you sign a subscription 
agreement with 1SYNC.

Multiline Attribute Tips
A multiline attribute can contain more than one value (for example, Country of 
Origin can contain up to three countries).
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If an attribute can contain more than three values, it is identified by the presence 
of More next to the attribute name with the maximum number of possible values.

To open more lines in a multiline attribute 
1 Click the More hyperlink to display additional fields for entering values. Click 

the hyperlink again to continue adding three additional fields until the 
maximum number of possible fields is reached.

2 Enter data by typing and/or selecting values from the drop-down lists. 
Note: When updating a multiline attribute, the entire list is replaced, so be 
sure to send all of the values that are to appear in the updated list, not only 
new values. 

Associated Multiline Attributes
Some multiline attributes are associated, which means one attribute is logically 
connected to another (for example, Ship From City and Ship From State or 
Province). 

Use the following guidelines to work with these attributes:
■ To view all the associated attributes, use the horizontal scroll bar at the bottom 

of the page, and/or hide the navigation panel.
Note: The associated multiline values must occupy the same row (for 
example, Topeka and Kansas in the same row of Ship From City and Ship From 
State or Province). If a value is not possible in a row of an associated multiline 
attribute (for example, a state or province in China), leave it blank.

■ Move your cursor over the attribute name to view the format requirements and 
definition of the attribute. 

■ For information about cost and price attributes, see “Working With Costs and 
Prices” on page 166. 

■ Do not send duplicate values for Ship From Code.
■ If an error occurs in an associated multiline attribute, an error message displays 

at the top of the page. 

Working With Costs and Prices
Each row of Unit Cost and/or MSRP attributes includes: 
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■ Unit Cost or MSRP numeric value
■ Currency (required for Unit Cost and MSRP)
■ Effective Date (optional unless otherwise noted)
■ Expiration Date (optional) 
■ Trading Partner (to assign a private Unit Cost to a specific retailer)

Note: The Trading Partner drop-down list includes only retailers with access 
to your catalogue.

Notes for working with costs and prices include the following:
■ For Unit Cost and MSRP, use only a numeric value, not a currency symbol (for 

example, $). 
■ Multiple public Unit Cost value/currency pairs are allowed per GTIN only if their 

active dates (determined by Unit Cost Effective Date and Unit Cost Expiration 
Date) do not overlap. 

■ Multiple private Unit Cost value/currency pairs for the same retailer are allowed 
per GTIN only if their active dates (determined by Unit Cost Effective Date and 
Unit Cost Expiration Date) do not overlap.

■ If provided, an Expiration Date must follow the Effective Date in the same row.
■ Private costs are visible only to the vendor and the specified retailer. 
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Analytics and Reports 10
There are several reports you can run that provide information about how you and 
your trading partners use or access Catalogue data. The following reports are 
available:
■ “Analytics Report” on page 169
■ “Compliance Report” on page 175
■ “Item Search Ratio Report” on page 182
■ “Load Status Report” on page 184
■ “Trading Partner Access Report” on page 186

Analytics Report
The Attributes Analytics Report was designed primarily for retailers to view their 
trading partners’ accounts to see which attributes the vendors are populating for 
their items (GTINs). At the beginning of each month, the system takes a snapshot 
of all active vendors in Catalogue. The snapshot captures data for 203 attributes. 
After the snapshot is taken, retailers can generate a report. The report is created 
as a CSV file and uses the retailer’s access to a vendor’s account to determine 
which vendors to include in the report. 
This is the criteria for including a vendor’s data in the report:
■ If a vendor has granted any level of access to the retailer, the vendor’s data is 

included in the file. 
■ If a vendor has totally restricted the retailer’s access, the vendor’s data is not 

included in the report. 
■ If a vendor grants any level of access to a retailer after the report has been run, 

the retailer can re-run the report and the vendor’s data is added to the report.
The Attributes Analytics Report can also be run by a vendor. It includes only the 
vendor’s own data and enables the vendor to see the attribute data that a retailer 
sees. 
Topics are organized as follows:
■ “Requesting and Running an Attributes Analytics Report” on page 170
■ “Downloading an Attributes Analytics Report” on page 171
■ “Understanding Attributes Analytics Reports” on page 172
■ “Deleting an Attributes Analytics Report” on page 175



170 OpenText Active Catalogue CE 21.2 Browser Interface User Guide

A N A L Y T I C S  A N D  R E P O R T S

Analytics Report

■ “Setting Internet Explorer (IE) Options for Attributes Analytics and Compliance 
Reports” on page 187

Requesting and Running an Attributes Analytics Report
At the beginning of each month, the system takes a snapshot of all active vendors 
in Catalogue. The snapshot captures data for 202 attributes. 
Important: Each multiline attribute is counted once per GTIN, regardless of how 
many multiline occurrences (values) there are for each multiline attribute. Only 
attribute counts for items that were added or updated after a specified date are 
included in the Attributes Analytics Report. The default date is 2016-01-01.
After a snapshot of vendor data is taken, you can request an Attributes Analytics 
Report based on a given snapshot date. Catalogue saves up to 12 monthly 
snapshots of data, allowing you to create reports that show attribute population 
rates over the course of a year. 
When you request a report, it is created as a CSV file and uses the retailer’s current 
access to a vendor’s account to determine which vendors to include in the report. 
You can save the data as a CSV text file that can be displayed in another 
application such as MS Excel.
Note: If a retailer has been granted access to any vendors’ accounts since the last 
time the report was run, those vendors are included in the report the next time the 
report is run.
1 To access the Attributes Analytics Report
2 Click Administration > Attributes Analytics.

The Attributes Analytics Reports - Results page opens.

3 Click Add.
The Add Request for Attributes Analytics Reports opens.

4 From the Snapshot Date drop-down list, select the date for which you want to 
request attribute data. 

5 Click Save.
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You return to the Attributes Analytics Reports - Results page, and a message 
indicates that the report request was added successfully. The Status is New 
while the report is processing.

6 Refresh the page to see if your report is complete (press F5).
7 Once the report is complete, you can download it. See “Downloading an 

Attributes Analytics Report” on page 171.

Downloading an Attributes Analytics Report
After an Attributes Analytics Report has run and processing is complete, it is 
available from the Attributes Analytics Reports - Results page.
You can save the report data to a CSV text file on your computer which can then be 
displayed in another application such as MS Excel.
Note: Be sure to set the required Internet Explorer options so you can 
successfully use this feature. See “Setting Internet Explorer (IE) Options for 
Attributes Analytics and Compliance Reports” on page 187. 
If you do not set the IE options, you may experience inconsistent behavior when 
you use this feature. Sometimes the data will appear and sometimes the page may 
flash momentarily, but there is no indication that your setting is not correct except 
that the data will not display.

To download an Attributes Analytics Report
1 Click Administration > Attributes Analytics. 

The Attributes Analytics Reports - Results page opens.
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The list displays the results of all Attributes Analytics Reports that you have run. 
The most recent result is listed at the top of the list. 
Note: When an administrator runs a report acting as a retailer or vendor, 
those reports also display on the page in that vendor’s or retailer’s account 
when they login. 
The table displays from left for each Attributes Analytics Report: 

■ A check box to select a report for deletion from the list. 
■ Status—Status of the report.

■ New—Data was requested but is not yet in the process of being 
retrieved.

■ In Progress—Data is in the process of being retrieved.
■ Complete—Data has been completely retrieved.
■ In Error—Data the system was not able to retrieve.

■ Snapshot Date—The date that the system takes a monthly snapshot of 
all active vendors in Catalogue. The snapshot captures data for 202 
attributes. 

■ Report Run Date—The date that the report was requested and 
processed.

■ Download—Download icon (click to download the report).
2 To find a result in the list: 

■ Scroll through the list. 
■ Use the browse bar to move between pages.

3 To download the report, in the Download column, click the icon next to the 
report you want to download. 
A dialog box opens asking if you want to open the file or save it to your 
computer.

4 Do one of the following:
■ Click Open to display the report data as a CSV text file. The text file can be 

saved as a CSV file and opened later with an application such as MS Excel. 
If the .csv extension is already associated with MS Excel, the data displays 
in Excel. 

■ Click Save to save the file as a CSV text file that you can open later in an 
application such as MS Excel. Depending on your browser, the file may be 
saved to your Download folder. If the .csv extension is already associated 
with Excel, the file may be automatically saved as an MS Excel file.

Understanding Attributes Analytics Reports
The Attributes Analytics Report provides attribute data for 226 attributes for each 
item (GTIN) of a retailer’s active trading partners (as long as they have some level 
of access to the vendor’s account).
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The following attributes are included in the report:
■ Vendor Account Id ■ Vendor Account Short Name ■ Snapshot Year Month
■ Total GTINS ■ Product Images ■ Product Color Code Images
■ GTIN Images ■ Advertised Origin ■ Available Date
■ Booking Date (Item Effective Date) ■ Color Description ■ Consumer Package Height
■ Consumer Package Length ■ Size of Units in Consumer Package 

(Net Content)
■ Consumer Package Volume 

(Cube)
■ Consumer Package Gross Weight ■ Consumer Package Width ■ CPSIA Certified Y/N
■ GTIN Description ■ Discontinue Date ■ Fabric Description
■ Hazardous Material Class Code ■ Hazardous Material Description ■ Lead Time
■ Material Country Of Origin ■ Manufacturer's Suggested Retail Price ■ NRF Color Code
■ NRF Size Code ■ Minimum Order Quantity ■ Country of Origin
■ Refillable ■ Seasonal Availability ■ Size Description
■ Special Item Code ■ Trade Name ■ Unit Cost
■ Unit Cost Effective Date ■ Unit Cost Expiration Date ■ Warranty Description
■ Aerosol Y/N ■ Consumer Item Height ■ Consumer Item Length
■ Consumer Item Width ■ Adhesive ■ Adjustable
■ Adjustable Strap ■ Bag Type ■ Band Type
■ Beauty Area Of Use ■ Beauty Treatment Spec ■ Bedding Size
■ Bedding Type ■ Benzoyl Peroxide Rest ■ Bill Logo Application
■ Boot Leg Circumference ■ Boot Shaft Type ■ Bra Band Type
■ Bra Bust Type ■ Bra Cup Coverage ■ Bra Cup Type
■ Bra Impact Level ■ Bra Padding ■ Bra Specialty Type
■ Bra Type ■ Bra Underwire ■ Bracelet Type
■ Brand Name ■ Closure ■ Coat/Jacket Type
■ Collar Type ■ Conference ■ Consumer Lifestage
■ Control Level ■ Convertible ■ Cookware Type
■ Covered ■ Cuff Type ■ Detachable Strap
■ Dinnerware Category ■ Dishwasher Safe ■ Dress Type
■ Earring Type ■ Eyewear Type ■ Fabric Or Material Code
■ Faux Fur Y/N ■ Feature / Benefit ■ Fiber
■ Fill Material ■ Finish ■ Flatware Type
■ Formulation ■ FPLA Compliance Flag ■ Fur - Animal Name
■ Fur - Country of Origination ■ Fur - Treatment ■ Gauge
■ Gender By Age ■ Gender ■ Gold Karat
■ Hand Painted ■ Handbag Shoulder Drop ■ Handle Strap
■ Handmade ■ Hat Type ■ Headwear Bill Type
■ Headwear Crown ■ Headwear Fit ■ Heel Height
■ Heel Height Range ■ Heel Material ■ Heel Type
■ Holiday/Event ■ Hooded ■ Hosiery/Sock Type
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■ Hypoallergenic ■ Insulated ■ Jewelry Sets
■ Jewelry Type ■ Knit Type ■ Laser Cut
■ League ■ Leg Type ■ Length Description
■ Lined ■ Lined Code ■ Lining Material
■ Material Group ■ Maternity ■ Metal
■ Metal Composition ■ Metal Feet ■ Microwave Safe
■ Short Product Marketing Message ■ Necklace Type ■ Neckwear Type
■ Number Of Settings ■ Occasion List ■ Officially Licensed
■ Oil Free ■ Open Closed Toe ■ Order Quantity Multiple
■ Outsole Type ■ Padded ■ Pant/Inseam Length
■ Pants/Shorts Type ■ Panty Back Coverage ■ Panty Type
■ Platform Height ■ Player Name ■ Pocket Details
■ Product Style ■ Primary Detail Application ■ Primary Detail Logo
■ Primary Detail Placement ■ Primary Detail Size ■ Primary Detail Type
■ Primary Motif Theme ■ Prop 65 Warning ■ Proposition 65 Warning 

Description
■ Reversible ■ Ring Type ■ Rug Type
■ Scent Type ■ Seams ■ Secondary Detail Application
■ Secondary Detail Logo ■ Secondary Detail Placement ■ Secondary Detail Size
■ Secondary Detail Type ■ Secondary Motif Theme ■ Selling Channel
■ Shaft Height ■ Shape ■ Shapewear Type
■ Shoe Style ■ Shoe Type ■ Skin Type
■ Skirt Type ■ Sleepwear Type ■ Sleeve Length
■ Sleeve Measurement ■ Slip Split ■ Slip Type
■ Sole Type ■ Special Embellishment ■ Sport
■ Stay Cool Handle ■ Steamable Y/N ■ Stone
■ Stone Details ■ Strap Placement ■ Stretch
■ Support Level ■ Sweater Pullover Type ■ Tableware Type
■ Tag ■ Team ■ Third Detail Application
■ Third Detail Logo ■ Third Detail Placement ■ Third Detail Size
■ Third Detail Type ■ Third Motif Theme ■ Toe Shape
■ Towel Type ■ Marked Retail Price ■ Waist Rise
■ Waistband Type ■ Watch Case Shape ■ Water Repellent
■ Wrinkle Resistant ■ Brand Owner's Name ■ Classification Level 1 Value
■ GTIN Extended Description ■ Boxed For Gift Giving ■ Item Care Instructions Code
■ Item Care Instructions ■ Harmonized Tariff Schedule ■ Does Not Contain
■ Key Active Ingredient ■ List of Ingredients ■ Active Ingredient
■ SPF Rating ■ Special Handling Code ■ Vendor Collection Name
■ Asthma/Allergy Certified ■ ■
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Each row in the report represents a retailer’s trading partner (vendor). Only active 
trading partners are included in the report. The report displays the number of total 
GTINs in the vendor’s catalogue as well as the number of instances where a 
particular attribute is populated in that catalogue. Retailers can analyze data from 
a given report and they can also compare changes in data from month to month. 
For example, in the report below, the catalogue of the vendor represented by the 
first row has a total of 660 GTINs and there are 660 instances where the color 
description attribute is populated.
Note: Vendors see only one row of their own data.

Deleting an Attributes Analytics Report
To delete an attributes analytic report
1 Click Administration > Attributes Analytics. 

The Attributes Analytics Reports - Results page opens.

2 Select the check boxes to the left of the reports you want to delete (click again 
to deselect).

3 Click Delete to remove the reports from the list.

Compliance Report
A Compliance Report is a one-time report run against the current state of data that 
exists within a catalogue. You can compare your catalogue to an attribute filter 
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that contains the specific attributes you require and obtain a report on the 
attributes that are not populated. 
A compliance report allows you to test your own compliance as different retailers 
define it.
You can choose any of the following attribute filters when setting up a report to 
scan your catalogue for missing attribute values:
■ Your own vendor account attribute filter
■ Any retailer account attribute filter
■ A system attribute filter
Note: You have the option to run the report for a specified Selection Code or 
Product.
Topics are organized as follows:
■ “Requesting and Running an Attribute Filter Compliance Report” on page 176
■ “Downloading an Attribute Filter Compliance Report” on page 178
■ “Understanding Attribute Filter Compliance Report” on page 179
■ “Filtering the Attribute Filter Compliance Reports List” on page 181
■ “Deleting an Attribute Filter Compliance Report” on page 181
■ “Setting Internet Explorer (IE) Options for Attributes Analytics and Compliance 

Reports” on page 187

Requesting and Running an Attribute Filter Compliance 
Report

You can request and run a compliance report that indicates whether there are 
missing (not populated) attribute values in your catalogue when it is compared to 
an attribute filter that contains the specific attributes you require.

To request and run a compliance report
1 Click Data Management > Compliance Reports. 

The Compliance Reports page opens.

2 Click Add.
The Attribute Filter Compliance Report Request page opens.
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3 The report will be run against your account. If needed, enter additional criteria 
to constrain the compliance report to a particular Selection Code or Product:

■ Optional. Selection Code—To run the report against a specific Selection 
Code, type a partial Selection Code (auto-fill field). Select a Selection Code 
from the drop-down list. If you enter a Selection Code that doesn’t exist in 
the account, an error message displays.

■ Optional. Product—To run the report against a specific Product, type a 
partial Product (auto-fill field). Select a Product from the drop-down list. If 
you enter a Product that doesn’t exist in the account, an error message 
displays.

Note: If you enter a Product, but leave the Selection Code field blank, 
Catalogue searches across all Selection Codes.

4 Select the type of attribute filter you want to run the report against:
■ System Filter—Maintained by OpenText Administrators
■ Account Filter—Created, maintained, and applied by users in the account

Once you select the type of filter, the drop-down list populates with all filters of 
that type. 
For information about attribute filters and how to create account filters, see 
Chapter 5, "Working with Attribute Filters," on page 68.

5 From the drop-down list, select an attribute filter to run the report against.
6 If needed, specify one or more of the following options:

■ Maximum Attributes to Report—Limits the number of attributes that 
are displayed in the report. To display all attributes, type 999.

■ Exclude items updated before—Excludes from the report all items that 
were updated before the date you enter. Enter a date or click the Auto 
Calendar icon to select a date.

■ Ignore discontinued items—Select this check box if you do not want 
the report to display discontinued items.

7 Click Save.
You return to the Compliance Reports page, and a message indicates that the 
report request was added successfully. The Status is New while the report is 
processing. 
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8 Refresh the page to see if your report is complete (press F5).
Note: Compliance report processing times are limited to 20 minutes. If the 
report is not complete in 20 minutes, Catalogue stops processing the report, 
and an error message displays. 
You can re-run the report and try one of the following:

■ Limit the number the number of items in the report by specifying a 
particular Selection Code or Product when you request the report (Step 3). 

■ Specify an attribute filter that contains fewer attributes. Every attribute 
within the designated filter must be scanned, and this can significantly 
affect the performance of when running the compliance report.

9 Once the report is complete, you can download it. See “Downloading an 
Attribute Filter Compliance Report” on page 178.

Downloading an Attribute Filter Compliance Report
Once a compliance report has been run and processing is complete, it is available 
from the Compliance Reports page.
You can view the report data or save it to a CSV text file on your computer. 
Note: Be sure to set the required Internet Explorer options so you can 
successfully use this feature. See “Setting Internet Explorer (IE) Options for 
Attributes Analytics and Compliance Reports” on page 187. 
If you do not set the IE options, you may experience inconsistent behavior when 
you use this feature. Sometimes the data will appear and sometimes the page may 
flash momentarily, but there is no indication that your setting is not correct except 
that the data will not display.

To download a compliance report
1 Click Data Management > Compliance Reports. 

The Compliance Reports page opens.

Note: The list displays the results of all compliance reports that you have run. 
The most recent result is listed at the top of the list. Reports are available for 14 
days. After that, the report remains on the list, but you are not able to view it.
The table displays from left for each compliance report: 

■ Check box to select a report for deletion from the list. 
■ Status—Status of the report.
■ User ID—The user identifier.
■ Account Number—The account identifier.
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■ Start Date—Date and time the report started.
■ End Date—Date and time the report completed. 
■ Duration—Time it took to run the report.
■ Download—Download icon (click to download the report).

2 To find a result in the list: 
■ Filter the list. See “Filtering the Attribute Filter Compliance Reports List” on 

page 181. 
■ Scroll through the list. 
■ Use the browse bar to move between pages.

3 To download the report, in the Download column, click the icon next to the 
report you want to download. 
A dialog box opens asking if you want to open the file or save it to your 
computer.

4 Do one of the following:
■ Click Open to display the report data as a CSV text file. The text file can be 

saved as a CSV file and opened later with an application such as MS Excel. 
If the .csv extension is already associated with MS Excel, the data displays 
in Excel. 

■ Click Save to save the file as a CSV text file that you can open later in an 
application such as MS Excel. Depending on your browser, the file may be 
saved to your Download folder. If the .csv extension is already associated 
with Excel, the file may be automatically saved as an MS Excel file.

Understanding Attribute Filter Compliance Report
The Compliance Report is comprised of 3 parts:
■ Header—Information about the accounts and attribute filter
■ Body—Compliance information
■ Footer—Attribute filter details at the time the report is run

Header
The report header lists information such as the requesting and target accounts and 
the attribute filter used. The header information follows the tag #ReportOptions.
For example: 

Header details include the following information:
■ requesting user
■ requesting account
■ target account



180 OpenText Active Catalogue CE 21.2 Browser Interface User Guide

A N A L Y T I C S  A N D  R E P O R T S

Compliance Report

■ selection code filter
■ product name filter
■ item update date filter
■ exclude discontinued items
■ date format
■ maximum attributes to report
■ account attribute filter name 
■ attribute filter account nbr 
■ attribute filter account name

Body
The body of the report lists the compliance information.
For example:

Body details include the following information:
■ Hierarchy information identifies the attribute that is unpopulated and has 

therefore, failed the compliance check (Selection Code, Product, GTIN, GTIN 
type, last update date)

■ Unpopulated attributes lists the specific attributes that are missing for the GTIN 
based on the selected attribute filter.

Note: If the number of attributes was limited in the report options, and there 
were more unpopulated attributes compared to that limit, the message ‘Additional 
attributes are non-compliant’ appears. Limiting the number of attributes reported 
allows you to focus on small sets of attributes at a time. Another approach is to 
create a smaller attribute filter.

Footer
Footer details include the attribute filter details at the time the is report run. This 
information is included to eliminate confusion if the filter definition changes and 
the report is run again.
For example:

The footer is grouped into two sections:
■ #Attribute filter details—Shows the selected attribute filter name
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■ #Attribute Group—Shows each attribute group within the selected filter, 
followed by the attributes within that group at the time the report is run. This 
section repeats for each attribute group in the filter.

Filtering the Attribute Filter Compliance Reports List
You can use the filter to display a list of compliance reports based on the criteria 
you specify. 

To filter the compliance reports list
1 On the Compliance Reports page (Data Management > Compliance 

Reports), enter the criteria for each of the options you want to filter by. You 
can filter on multiple options simultaneously.

■ Status—Select a status from the drop-down list to display only results with 
the specified status:

■ New—Show only those results for data that was requested but is not 
yet in the process of being retrieved.

■ In Progress—Show only results for data that is in the process of being 
retrieved.

■ Complete—Show only results for data that has been completely 
retrieved.

■ In Error—Show only results for data that the system was not able to 
retrieve.

■ Account Number—To show only results for a specified account identifier, 
type a partial or full account identifier in the text box. 

■ Account Name—To show only results for a specified account name, type 
a partial or full account name in the text box.

2 Click Filter. The list that meets your criteria displays.
Note: To remove all filter criteria, click Clear Filter.

Deleting an Attribute Filter Compliance Report
To delete an attribute filter compliance report
1 Click Data Management > Compliance Reports. 

The Compliance Reports page opens.

2 Select the check boxes to the left of the reports you want to delete (click again 
to deselect).
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3 Click Delete to remove the reports from the list.
Note: Reports are available for 14 days. After that, the report is still listed, 
but you are not able to view it.

Item Search Ratio Report
The Item Search Ratio Report was designed primarily for retailers who want to 
know the number of times they are not able to find items (GTINs) in their vendors’ 
catalogues. Since vendors may need to verify this information, you also have the 
ability to access this data.
Topics are organized as follows:
■ “Viewing the Item Search Ratio Report” on page 182
■ “Filtering an Item Search Ratio Report List” on page 184

Viewing the Item Search Ratio Report
Tracking and reporting for Item Search Ratio Report the begins at the time the 
report option is enabled. It must be enabled by OpenText Cloud Support Services 
(CSS). 
Note: Tracking missed GTINs occurs only when the option is turned on. If the 
option is turned off, tracking stops. No history of tracking is available before the 
option is turned on or after the option is turned off.
This section is organized as follows:
■ “Overview for Retailers” on page 182
■ “Overview for Vendors” on page 183
■ “Accessing the Item Search Ratio Report” on page 183
You can filter the data and also save the data as a CSV text file that can be copied 
to another application such as MS Excel.
To filter or copy the data from the report, see:
■ “Filtering an Item Search Ratio Report List” on page 184
■ “Copying Report Data to a Table” on page 191

Overview for Retailers
Each time you search a specific vendor’s or distributor’s catalogue (not a cross-
catalogue search), Catalogue keeps track of the number of times you find and do 
not find the GTINs you are looking for. 
The Item Search Ratio Report displays the actual number of hits (GTINs found) 
and misses (GTINs not found) for each vendor/distributor whose catalogue you 
have searched, as well as the hit and miss percentages.

E n a b l i n g  t h e  R e p o r t  O p t i o n
The Item Search Ratio Report option must be enabled before data displays on the 
page. To enable the option, contact OpenText Cloud Support Services (CSS) at 
1-800-334-2255.
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After the report option is enabled for your account, data displays in the report, 
provided you have performed searches for GTINs from a specific vendor. Data does 
not display for a vendor if you have not searched their catalogue for GTINs.

Overview for Vendors
Each time your trading partners (retailers) search your specific catalogue (not a 
cross-catalogue search), Catalogue keeps track of the number of times they find 
and do not find the GTINs they are looking for. 
The Item Search Ratio Report displays the actual number of hits (GTINs found) 
and misses (GTINs not found) for each trading partner that searched your 
catalogue, as well as the hit and miss percentages.

E n a b l i n g  t h e  R e p o r t  O p t i o n
The Item Search Ratio Report option must be enabled before data displays on the 
page. To enable the option, contact OpenText Cloud Support Services (CSS) at 
1-800-334-2255.
After the report option is enabled for your account, data displays in the report only 
if the trading partner also has the report option enabled and has performed 
searches for specific GTINs in your catalogue. Data does not display if a trading 
partner has not searched your catalogue for GTINs.

Accessing the Item Search Ratio Report

To access the Item Search Ratio Report
1 Click Administration > Item Search Ratio Report.

The Item Search Ratio Report page opens.
The report page may take several minutes to load; it is dependent on the 
number of trading partner accounts that were accessed.

In this example:
■ The trading partner GROCERY RETAILER accessed your catalogue and 

searched for GTIN data 11 times (3 hits, (GTINs found) + 8 misses (GTINs 
not found)). 

■ The percentage of times the searches were successful is the hit percentage 
(Hit %) which is 27 (3/11). 
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■ The percentage of times the searches were unsuccessful is the miss 
percentage (Miss %) which is 73 (8/11).

The results of this report only apply to GTIN searches for a specific vendor (the 
vendor must be specified at the time of the GTIN search). The results do not 
include cross-catalogue searches.

2 You can use the “Copy Data to Table” feature to view this data in a table or 
save the data as a CSV text file on your computer. With either method, you can 
copy the data from the table and paste it into another application, such as an 
Excel spreadsheet. See “Copying Report Data to a Table” on page 191.

Filtering an Item Search Ratio Report List
You can filter the Item Search Ratio Report list based on the criteria you specify. 

To filter an Item Search Ratio Report list
1 To view a list of the number of hits (GTINs found) and misses (GTINs not 

found) for each trading partner that searched your catalogue, click 
Administration > Item Search Ratio Report. 
The Item Search Ratio Report page opens. 

2 Locate the Filter bar.

3 Enter the criteria for each of the options you want to filter. You can filter on 
multiple options simultaneously.

■ Trading Partner Name—Enter a full or partial Trading Partner name.
■ Trading Partner Id—Enter a full Trading Partner ID.

4 Click Filter. The list that meets your criteria displays.
Note: To remove all filter criteria, click Clear Filter.

Load Status Report
The Load Status Report (LSR) is a report for vendors that is generated for each 
inbound EDI file sent to Catalogue:
■ 832 - DLSR, data load status report

This report lists how many items in each EDI file were rejected, added, 
replaced, duplicated, moved, modified, and deleted.

■ 888b - PLSR, profile load status report
This report lists how many total profile (access) changes were made for 
granting or revoking trading partnership access. The report also show what 
custom fields were populated, and with what values.

Each LSR is associated with the control number of the EDI document.
A vendor can request that an OpenText administrator enable LSRs for their account 
See “Contacting Technical Support” on page 5. 
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After the LSR option has been enabled, the document number on the EDI 
Management Console List page is a hyperlink to the Load Status Report for that file 
(which can then be downloaded). See “Using the EDI Management Console” on 
page 229.
Additionally, the OpenText administrator can enable an email option for your 
account so that the same LSR report is emailed to the primary contact listed on the 
Account Detail page. See “Maintaining Your Account” on page 49.
Note: If you send in 50 EDI files, for example, you will receive 50 LSR emails.

Sample Catalogue Data Load Status Report for 832
This sample report shows the results data load status report for an 832.
ecCatalogue Update beginning for: KIBBLES on 2020-01-16 at 01:59:08
    1       GTIN RECORDS REJECTED (NOT PROCESSED)
    0       NEW GTIN RECORDS ADDED
    0       EXISTING GTIN RECORDS REPLACED
    0       EXISTING GTIN RECORDS DUPLICATED
    0       EXISTING GTIN RECORDS MOVED
    0       EXISTING GTIN RECORDS MODIFIED
    0       EXISTING GTIN RECORDS DELETED
    0       EXISTING GTIN RECORDS CANCELLED
==>Processing interchange : Control No. : 577163234
          -->Processing envelope    : Control No. : 13
          -->Version                : 004030
          -->Processing Document    : Control No. : 130001 of type : 832
               ---> GTIN REJECTED : 520245101027 UA -- ERROR: A GTIN with passed Discontinue 
Date cannot be maintained
ecCatalogue Update completed for : KIBBLES on 2020-01-16 at 01:59:08

Sample Catalogue Profile Load Status Report for 888b
This sample report shows the results of profile load status report for an 888b.
ecCatalogue Update beginning for : DPKEYSTO on 2020-01-28 at 06:28:44
39018   TOTAL PROFILE UPDATES PROCESSED
24311   PROFILE UPDATES ACCESS GRANTED
0       PROFILE UPDATES ACCESS REVOKED
149     PROFILE UPDATES REJECTED DUE TO ERROR
14558   PROFILE UPDATES DUPLICATE
75322   RETAILER CROSS REFERENCE ADDED
0       RETAILER CROSS REFERENCE DELETED
0       RETAILER CROSS REFERENCE REJECTED DUE TO ERROR
2416    RETAILER CROSS REFERENCE DUPLICATE
          ==>Processing interchange : Control No. : 000003785
          -->Processing envelope    : Control No. : 3785
          -->Version                : 004030
          -->Processing Document    : Control No. : 37850001 of type : 888
                --->Granting Catalogue Access for retailer: GPC10157 Level:  Product ID                
Selection Code: 001 Product Id: 10107477
                     Establishing Trading Partnership
                     <Add successful>
          --->Processing Retailer Cross Reference Record Type:P03  Attribute Type : ShipToName  
Attribute Value : PAW PAW WINE DISTR KALAMAZOO
                --->Adding retailer cross reference: 10107477 Level:
                     <Add successful>
          --->Processing Retailer Cross Reference Record Type:P03  Attribute Type : ShipToNumber  
Attribute Value : 0021910541
                --->Adding retailer cross reference: 10107477 Level:
                     <Add successful>
                --->Granting Catalogue Access for retailer: GPC10157 Level:  Product ID                
Selection Code: 001 Product Id: 10112573
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                     Establishing Trading Partnership
                     <Add successful>
          --->Processing Retailer Cross Reference Record Type:P03  Attribute Type : ShipToName  
Attribute Value : PAW PAW WINE DISTR KALAMAZOO
                --->Adding retailer cross reference: 10112573 Level:
                     <Add successful>

Trading Partner Access Report
The Trading Partner (TP) Access Report lists the trading partners who have 
accessed your catalogue in the last 3 months.
Topics are organized as follows:
■ “Viewing the Trading Partner (TP) Access Report” on page 186
■ “Filtering a Trading Partner (TP) Access Report List” on page 187

Viewing the Trading Partner (TP) Access Report
You can view a list of all trading partners who have accessed your catalogue in the 
last 3 months. For every trading partner who has accessed your catalogue in a 
particular month, you can see the last date that each of those trading partners 
accessed your catalogue in that month. You can filter the data and also save the 
data as a CSV text file that can be copied to another application such as MS Excel.
Note: You cannot view the TP Access Report unless you have been granted 
permission through your user role. Contact your system administrator to obtain 
permission.
To filter or copy the data from the report, see these sections:
■ “Filtering a Trading Partner (TP) Access Report List” on page 187
■ “Copying Report Data to a Table” on page 191

To access the Trading Partner Report
1 Click Administration > TP Access Report.

The Partner Access Report page opens.
Note: The report page may take several minutes to load; it is dependent on 
the number of trading partner accounts that were accessed.
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In this example, the list has been filtered by the trading partner, GROCERY 
RETAILER. The last date that GROCERY RETAILER accessed your catalogue in 
the months of May, March, and January is displayed. The fact that no entries 
exist for April and February means that this retailer did not access your 
catalogue in those months.
You can use the “Copy Data to Table” feature to view this data in a table or 
save the data as a CSV text file on your computer. With either method, you can 
copy the data from the table and paste it into another application, such as an 
Excel spreadsheet. See the section, “Copying Report Data to a Table” on 
page 191.

Filtering a Trading Partner (TP) Access Report List
You can filter the Trading Partner (TP) Access Report list based on the criteria you 
specify. 

To filter a Trading Partner Access Report list
1 To view a list of all trading partners who have accessed your catalogue, click 

Administration > TP Access Report. 
The Partner Access Report page opens. 

2 Locate the Filter bar.

3 Enter the criteria for each of the options you want to filter. You can filter on 
multiple options simultaneously.

■ Trading Partner Name—Enter a full or partial Trading Partner name.
■ Trading Partner Id—Enter a full Trading Partner ID.

4 Click Filter. The list that meets your criteria displays.
Note: To remove all filter criteria, click Clear Filter.

Setting Internet Explorer (IE) Options for Attributes 
Analytics and Compliance Reports

When analytics and compliance reports are downloaded, they open in a pop-up 
window:
To allow data download and pop-up functionality for this option, you need to set 
the following Internet options for Internet Explorer (IE):
■ Add the secure URL for Catalogue to your IE trusted sites.
■ Enable IE to prompt for file downloads.
■ If you are using a pop-up blocker, add the secure URL for Catalogue to your IE 

pop-up blocker settings.
The following procedure describes how to set all of these options.

To set Internet Explorer options for downloading report data
1 Access the Internet with Internet Explorer. 
2 From the Tools menu, select Internet Options. 
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The Internet Options window opens.
3 Click the Security tab. 
4 Under the Select a zone to view or change security settings section, click 

the Trusted sites icon. 
The Trusted sites zone displays.

5 Click Sites. 
The Trusted sites window opens.

6 In the Add this website to the zone box, type the secure URL for Catalogue, 
https://catalogue.gxs.com.

7 Click Add. 
The URL appears in the Websites box.

8 Click Close. 
You return to the Internet Options window, Security tab.

9 If it is enabled, click Apply on the Internet Options window. If it is not enabled, 
continue to the next step.
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10 Under the Security level for this zone section, click Custom level.

The Security Settings - Trusted Sites Zone window opens. 

11 Scroll down to the Downloads section.
12 Under Automatic prompting for file downloads, select Enable. 

13 Click OK at the bottom of the Security Settings - Trusted Sites Zone window.
A warning dialog box opens, asking you to verify that you want to change the 
settings for this zone.

14 Click Yes.
You return to the Internet Options window.

15 If it is enabled, click Apply on the Internet Options window. If it is not enabled, 
continue to the next step.

16 Do one of the following:
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■ If you are not using a pop-up blocker, you are done. Click OK. 
You are now set up to download analytic and compliance reports.

■ If you are using a pop-up blocker, continue to the next step to add the 
secure URL for Catalogue to your IE pop-up blocker settings.

17 Click the Privacy tab. 
18 In the Pop-up Blocker section at the bottom, click Settings.

The Pop-up Blocker Settings window opens.
19 In the Address of website to allow box, type the secure URL for Catalogue, 

https://catalogue.gxs.com, in the box.

20 Click Add. 
The URL appears in the Allowed sites box.

21 Click Close on the Pop-up Blocker Settings window. 
You return to the Internet Options window.

22 Click OK on the Internet Options window. 
You are now set up to download analytic and compliance reports.
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Copying Report Data to a Table
You can use the “Copy Data to Table” feature to copy data from the following 
reports to a table:
■ Trading Partner (TP) Access Report (see “Viewing the Trading Partner (TP) 

Access Report” on page 186)
■ Item Search Ratio Report (see “Viewing the Item Search Ratio Report” on 

page 182)
You can view the data in the table or save the data to a CSV text file on your 
computer. With either method, you can copy the data from the table and paste it 
into another application.
Note: Be sure to set the required Internet Explorer options so you can 
successfully use this feature. See “Setting Internet Explorer (IE) Options for Copy 
Data to Table” on page 98. 
If you do not set the IE options, you may experience inconsistent behavior when 
you use this feature. Sometimes the data table will appear and sometimes the 
page may flash momentarily, but there is no indication that your setting is not 
correct except that the table will not display.
The Copy Data to Table icon appears on the button bar on the Partner Access 
Report and the Item Search Ratio Report pages.

To copy the report data
1 Click Copy Data to Table on one of the following pages:

■ Trading Partner Access Report page (Administration > TP Access 
Report)

■ Item Search Ratio Report page (Administration > Item Search Ratio 
Report)

A dialog box opens asking if you want to open the file or save it to your 
computer.

2 Do one of the following:
■ Click Open to display the data in a table format such as MS Excel. After the 

table is open, you can select rows and columns of data to copy. 
When you want to close the table, click the X in the upper right corner of 
the window. If you modified the table, you can choose to save your 
changes to your computer.

■ Click Save to save the file to an application such as an MS Excel file. 
Depending on your browser, the file may be saved to your Download folder. 

Opening a Downloaded CSV Text File in MS Excel
This topic describes how to work with a downloaded OpenText Active Catalogue 
text file within Microsoft Excel (MS Excel). The procedures step you through the 
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process of opening the text file in MS Excel so that the format of the GTINs, 
Selection codes, and Products is preserved. 
Note: Catalogue creates a comma separated values (CSV) text file that has a .txt 
extension rather than a .csv extension. This allows you to open the text file in MS 
Excel and then set specific options so that the format of your data is preserved.
There are two methods for opening a text file in MS Excel:
■ Using the MS Excel Text Import Wizard—see “Using the MS Excel Text Import 

Wizard” on page 192
■ Using the Open With option from Windows Explorer—see “Using the Open With 

Option from Windows Explorer” on page 195

Using the MS Excel Text Import Wizard
1 Open MS Excel.
2 From the File menu, select Open. 

The Open window opens.
3 Navigate to the location of the text file (.txt extension).

Note: Next to the File name text box, be sure to select Text Files from the 
drop-down list so that all text files display. 

4 Select the file, and click Open or Open Other Workbooks. 
MS Excel’s Text Import Wizard - Step 1 of 3 window opens.

5 Select Delimited as the file type that best describes your data (how your data 
will be read).

6 Click Next. 
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The Text Import Wizard - Step 2 of 3 window opens.

7 Be sure that the following options are set:
a Under Delimiters, select the Tab check box and the Comma check box. 

Make sure that all other check boxes are cleared.
b Clear the Treat consecutive delimiters as one check box.
c From the Text qualifier drop-down list, select the double quotes (").

8 Click Next. 
The Text Import Wizard - Step 3 of 3 window opens

9 Select the first column (which contains the ITEM_NUMBER) by clicking the 
General column heading. 
The column highlights.

10 Under Column data format, select Text. 
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The column heading now reads Text.

11 Repeat Steps 9 and 10 for the third and fourth General columns (which contain 
the Selection Code and Product data) to set them to a Text data format.

Note: Depending on the filter you selected, Private Account IDs associated 
with Unit Cost and MSRP also need to be set to a Text data format.

12 Click Finish. 
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The downloaded data displays in Excel, and the format of the GTINs, Selection 
codes, and Products is preserved. 

Note: To expand all columns to the width of the data within each column, 
highlight the entire spreadsheet by clicking on the upper left-hand corner of the 
spreadsheet, and then double-click on the line between any of the column 
headings.

Using the Open With Option from Windows Explorer
1 In Windows Explorer, navigate to the location of the text file.
2 Right-click on the file and select Open With > Microsoft Office Excel.

Note: Double-clicking on the file will open it in Notepad.

The downloaded data displays in Excel, but each line of data is stored in the 
first column.

3 Select the first column (A) by clicking on the A column heading.
4 From the Data menu, select Text to Columns. MS Excel’s Text Import Wizard 

- Step 1 of 3 window opens. 
Continue with Step 5 in the section, “Using the MS Excel Text Import Wizard” 
on page 192, and complete the remaining steps in that section. They will guide 
you through Excel’s Text Import Wizard until the downloaded data displays in 
Excel.
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Working with CSV Text Files 
to Upload Data 11

This section explains how to create a comma separated values (CSV) text file to 
upload small volumes of catalogue item or image data. Text file upload is useful for 
vendors with smaller catalogues who may have too many items to enter using the 
browser user interface (UI), but too few items to need the scalability of EDI or Web 
Services.
Note: Uploading physical images is discussed in Chapter 9, “Maintaining 
Catalogue Data” in these topics:
■ “Adding (Uploading) Physical Images to a Product” on page 139
■ “Adding (Uploading) Physical Images to a GTIN” on page 154
Topics include:
■ “Using Text File Upload” on page 196
■ “Using a Downloaded Text File for a Text File Upload” on page 197
■ “CSV Text File Format Rules for Catalogue” on page 197
■ “Creating a CSV Text File from an MS Excel Spreadsheet” on page 201
■ “Using a CSV Text File to Upload Data” on page 204
■ “Correcting Errors in the CSV File” on page 206

Using Text File Upload
Text file upload is a way to upload small amounts of Catalogue data using a CSV 
text file. For CSV text file upload, the following topics are relevant.

If you want to... Use the following option: See this topic:
Use a text file download file as a text 
file upload file

Not applicable “Using a Downloaded Text File for 
a Text File Upload” on page 197

Review the guidelines for formatting a 
CSV text file.

Not applicable “CSV Text File Format Rules for 
Catalogue” on page 197.

Create a CSV text file for the products 
or items you want to upload.

MS Excel or similar application “Creating a CSV Text File from an 
MS Excel Spreadsheet” on 
page 201

Upload small volumes of catalogue 
item or image data using a CSV text 
file

Data Management > Text File Upload “Using a CSV Text File to Upload 
Data” on page 204
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Using a Downloaded Text File for a Text File Upload
You can use a text file previously downloaded from Catalogue (TFD file) as the 
basis for a text file upload (TFU). 
There are two things to keep in mind:
■ The TFD file does not include an action column. 

To use the TFD file as a TFU file, you need to add a column to the CSV text file 
that specifies the action you want to perform on each GTIN in the file (insert, 
update, replace, or delete).

■ In the header row of the CSV text file, as the first entry, add the word 
action. 

■ In every subsequent row of data, specify the action you want to perform 
on that row’s GTIN data (insert, update, replace, or delete)

You can add the column and corresponding information in the CSV text file or in 
the Excel file (before you save it as a CSV text file). Then upload the CSV text 
file using the UI.
For more information about creating a properly formatted CSV text file, see:

■ “CSV Text File Format Rules for Catalogue” on page 197.
■ “Creating a CSV Text File from an MS Excel Spreadsheet” on page 201.

■ The TFD file includes three columns that will not be used when the file is used as 
a TFU file. The following three columns are ignored:

■ VENDORACCOUNT
■ CREATE_DATE
■ UPDATE_DATE

CSV Text File Format Rules for Catalogue
Understanding the format rules described below will enable you to produce an 
acceptable file you can upload to  Catalogue using the browser interface. 
Once you understand the rules, you can use one of many applications including MS 
Excel and MS Access to create an acceptable CSV text file. 

View a CSV text file using Notepad Not applicable “Viewing the CSV Text File in 
Notepad” on page 204

Correct Errors in a CSV text file Data Management > Text File Upload “Correcting Errors in the CSV File” 
on page 206

Open a Downloaded CSV text file in 
MS Excel

Not applicable Chapter 12, “Working with 
Downloads.”

“Opening a Downloaded CSV Text 
File in MS Excel” on page 221

If you want to... Use the following option: See this topic:
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Basics
The OpenText Active Catalogue CSV text file is self-describing data file. The first 
non-blank row is the header row and defines the attribute names and the order 
that they will appear throughout the rest of the file. The remaining non-blank rows 
contain the item data with one item per line, with attribute values appearing in the 
order defined in the header row.

Structure
The following sections describe the structure of the CSV text file.

Character Conventions
The CSV text file uses one line for each item of data. The lines can be separated by 
either line feed (ASCII 10) characters or a pair of carriage return (ASCII 13) and 
line feed characters. 
The CSV text file separates fields on a line with a comma character. If a field value 
needs to contain a comma character, the whole field must be surrounded by 
double quotes (ASCII 34). 
If a field needs to contain a quote character, it must be proceeded by an additional 
quote character.

Required Attributes
Every CSV text file must include (at the minimum) the following fields:
■ SELCODE
■ PRODUCT
■ ITEM_NUMBER
■ ITEM_NUMBER_TYPE
These attributes identify the Catalogue item that will be changed. The following 
example is a simple file that inserts this item into the Catalogue:
ACTION,SELCODE,PRODUCT,ITEM_NUMBER,ITEM_NUMBER_TYPE,ITEM.DESCRIPTION
Insert,001,PID001,123412341551,UP,Item Description

Blank Rows
Catalogue ignores blank rows (all white space and no delimiters) in the CSV text 
file; however, blank rows are reflected in the line numbers used to report errors 
(they are counted as a row). In the example below, rows 1, 3, and 5 are blank 
rows. Rows 2, 4, and 6 are data rows. Row 2 is shown wrapping.

row 1
row 2 ITEM.IDENTIFIER,ITEM.IDENTIFIER_TYPE,ITEM.PRODUCT,

ITEM.DESCRIPTION,ITEM.ORIGIN_COUNTRY,ITEM.ORIGIN_COUNTRY
row 3
row 4 123456789012,UP,JEANS,DESIGNER BLUE,USA,MEX
row 5
row 6 123456789012,UP,JEANS,DESIGNER BLUE,USA,CAN

File Size
The CSV file can have a maximum number of 1000 data rows (blank rows are not 
counted).
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Header Row

Header Fields
The first non-blank row is the header row. The fields in the header row are Active 
Catalogue attribute names. These names are case-insensitive and are in one of the 
following formats:
■ The attribute name listed in the OpenText Active Catalogue Attributes Guide (for 

example, ITEM.COLOR_DESCRIPTION or ITEM.NRF_SIZE_CODE). 
■ The attribute name displayed on the Edit GTIN Details screen in the OpenText 

Active Catalogue application (for example, Color Description or Size Description)
Use the attribute name up to, but not including, the first comma that is displayed. 
Include parentheses when it is part of the name. See the examples in the following 
table.

Attribute Name Displayed on 
Edit GTIN Details Screen

Attribute Name Used in 
CSV Text File

Booking Date (Item Effective Date) Booking Date (Item Effective Date) 
Dangerous Goods Item, Y/N: Dangerous Goods Item

 

Qualifying an Attribute Value
When an attribute requires a qualifier (either a UOM or Private Account ID), the 
field immediately following the attribute must contain the qualifier. The qualifier is 
identified as a colon followed by the qualifier (UOM or Private_Account_id). 

U O M  E x a m p l e
In the CSV fragment below (the ellipses indicate that only part of the CSV text file 
is shown), Consumer Package Length has a UOM of inches (IN) and Consumer 
Package Gross Weight has a UOM of ounces (OZ).
...Consumer Package Length,:uom,Consumer Package Width,:uom,Consumer Package 
Height,:uom,Consumer Package Gross Weight,:uom,Consumer Package Volume (Cube),:uom
...10,IN,5,IN,2,IN,16,OZ,1.3,CF

P r i v a t e  A c c o u n t  I D  E x a m p l e
In the CSV fragment below, Unit Cost is an attribute that has a UOM qualifier of 
U.S. dollars (USD) as well as a Private Account ID qualifier of 123456789012. 
These qualifiers are followed by fields for the Unit Cost Effective Date and Unit Cost 
Expiration Date which are associated with the private cost values. 
...Unit Cost,:uom,:Private_Account_id,Unit Cost Effective Date,Unit Cost Expiration Date
...80,USD,1234567890,1/1/2005,1/1/2006

Optionally, to clearly identify the attribute that is being qualified, you can repeat 
the name of the attribute before the colon of the qualifier, as shown in the CSV 
fragment below:
...Unit Cost,Unit Cost:uom,Unit Cost:Private_Account_id,Unit Cost Effective Date,Unit Cost Expiration 
Date
...80,USD,1234567890,1/1/2005,1/1/2006
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Multiline Attributes
For each row in the CSV text file, multi-line attributes must appear as consecutive 
fields. In the following example, ITEM.ORIGIN_COUNTRY is the multi-line attribute 
and appears twice, one field next to the other.
ITEM.IDENTIFIER,ITEM.IDENTIFIER_TYPE,ITEM.PRODUCT,ITEM.DESCRIPTION,ITEM.ORIGIN_COUN
TRY,ITEM.ORIGIN_COUNTRY
123456789012,UP,JEANS,DESIGNER BLUE,USA,MEX
123456789012,UP,JEANS,DESIGNER BLUE,USA,CAN

Data Rows

Missing Values
A data row contains values for the fields defined in the header row. If an item does 
not have a value for the corresponding field, it can be left blank. This should 
appear in the CSV text file as a repeated delimiter. Trailing commas are needed for 
missing values at the end of a row.
Note: Since empty fields are allowed, it is not possible to remove a specific 
attribute value from an item using the update action. Use the replace action to 
remove attributes values.
For example, the following CSV text file does not have a value for the first 
ITEM.ORIGIN_COUNTRY field. The missing value is accounted for by the repeating 
commas.
ITEM.IDENTIFIER,ITEM.IDENTIFIER_TYPE,ITEM.PRODUCT,ITEM.DESCRIPTION,
ITEM.ORIGIN_COUNTRY,ITEM.ORIGIN_COUNTRY
123456789012,UP,JEANS,DESIGNER BLUE,,MEX

Quoted Values
If a value needs to contain the delimiter character (for example: DESIGNER, 
BLUE), the corresponding field in the CSV text file needs to be surrounded by 
double quotes ("DESIGNER, BLUE"). If the value contains a quote character, the 
quote character must be proceeded by another quote character. 
For example, DESIGNER, "BLUE" needs to appear in the CSV text file as 
"DESIGNER, ""BLUE""".
ITEM.IDENTIFIER,ITEM.IDENTIFIER_TYPE,ITEM.PRODUCT,ITEM.DESCRIPTION,ITEM.ORIGIN_COUN
TRY,ITEM.ORIGIN_COUNTRY
123456789012,UP,JEANS,"DESIGNER, ""BLUE""",,MEX

Excess Data Values
A data row cannot contain more data values than you have defined in the header 
row. If it does, the line will generate an error and be ignored.

Action Field
You can use a field to specify the action of a row (insert, update, replace, or 
delete). The following rules apply:
■ If you use a field to specify an action, and you specify insert for an existing item, 

the system will generate an error. 
■ If you use a field to specify an action, and you specify update or replace for an 

non-existent item, the system will generate an error. 
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■ If you do not use a field to specify an action, the system uses the appropriate 
action to load the data into Catalogue (it inserts an item if there is no existing 
item and updates an item if it already exists).

■ If you specify replace for an existing item, the item is updated only with the 
attributes specified in that data row. Attributes for the item that are omitted from 
the data row are removed from the existing item. The item has a new delta time 
stamp but its create time stamp is preserved. All of the item attributes have a 
new delta time stamp. 

■ Selection Code, Selection Code description, Product, and Product description can 
only be created using text file upload; you cannot update these fields using text 
file upload.

■ Text file upload supports implied Product delete; that is, if you use a CSV text file 
to delete the last item in a Product, the Product will be deleted.

Hierarchy Creation
Catalogue will automatically create a Selection Code/Product hierarchy from the 
values provided in the CSV text file as long as all the necessary values are present. 
For Catalogue to create the hierarchy, the CSV text file must contain values for the 
Selection Code (selcode), Selection Code description (hierarchy.node_description), 
Product (product), and Product description (hierarchy.product_description). 
If the hierarchy does not yet exist, Catalogue will create the hierarchy.
Note: If the hierarchy already exists, Catalogue will not update the existing values 
with the values in the CSV text file.

Creating a CSV Text File from an MS Excel Spreadsheet
The steps in the following table describe how to create a CSV text file from an MS 
Excel spreadsheet.
Your CSV text file must conform to the CSV format specifications described in “CSV 
Text File Format Rules for Catalogue” on page 197. Data loaded using a CSV text 
file must conform to your configured compliance checks and basic GTIN attribute 
validations and rules.

Step See this section
1. Create a basic MS Excel spreadsheet structure. “Create a Basic MS Excel Spreadsheet Structure” on page 202.
2. Apply a text format to attributes values that appear 
numeric, but must be shown as text.

“Apply MS Excel Formats to Attribute Values” on page 202.

3. Enter your data in the spreadsheet, one item per row. “Enter Data into the Spreadsheet” on page 203.
4. Save the spreadsheet as an MS Excel (.xlsx) file (to 
retain full data information).

“Save Your Spreadsheet as an MS Excel File” on page 203.

5. Save the spreadsheet as a CSV text file. “Save Your Spreadsheet as a CSV Text File” on page 203.
6. View the CSV text file in Notepad or a similar text 
editor.

“Viewing the CSV Text File in Notepad” on page 204.
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Create a Basic MS Excel Spreadsheet Structure
1 Open MS Excel. 
2 From the File menu, select New.
3 Select Blank workbook. A blank worksheet displays.

4 Create a header row by typing attribute names into row 1 of the spreadsheet. 
The header row must contain the mandatory fields SELCODE, PRODUCT, 
ITEM_NUMBER, and ITEM_NUMBER_TYPE. 
For a complete list of attribute names, please refer to the OpenText Active 
Catalogue Attributes Guide.

Apply MS Excel Formats to Attribute Values 
Apply a text format to the columns of attributes that appear numeric but must be 
shown as text. 
MS Excel interprets the values in the columns; if they appear to be numeric, it 
removes leading zeros and may display the value in exponential format. This will 
cause problems in the CSV text file because all of the characters are important in 
attributes such as Selection Codes, Products, and GTINs. To prevent numbers from 
being truncated, these cells must be formatted as text.
1 On the spreadsheet you created above, select the following columns: 

SELCODE, PRODUCT, and ITEM_NUMBER (use Ctrl-click to select multiple 
columns).

2 Right-click on a cell and select Format Cells.
3 Click the Number tab and select Text from the Category list.
4 Click OK. 

The text format is applied to the selected columns.
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Enter Data into the Spreadsheet
Enter your data into the spreadsheet using one row for each item. Enter the value 
for each attribute below the corresponding attribute name in the header row.

Save Your Spreadsheet as an MS Excel File
Save the spreadsheet as an MS Excel (.xlsx extension) file. 
1 From the File menu, select Save As. 

The Save As window opens.
2 Navigate to the location where you want to save the file. 
3 In the File name box, type the name of your file using a .xlsx extension. 
4 In the Save as type box, select the file type Microsoft Office Excel 

Workbook (*.xlsx) from the drop-down list. 
Note: It is critical to save the data using a .xlsx spreadsheet format before 
you save the file as a CSV text file (.csv extension). If you do not do this, the 
CSV text file may lose critical information.

5 Click Save. 
The MS Excel file is saved.

Save Your Spreadsheet as a CSV Text File
Save the spreadsheet as a CSV text file. This is the file that will be uploaded to 
OpenText Active Catalogue.
1 From the File menu, select Save As. 

The Save As window opens.
2 In the File name box, type the name of your file using a .csv extension. 
3 In the Save as type box, select the file type CSV (Comma 

delimited)(*.csv) from the drop-down list.
4 Click Save. 

MS Excel displays a warning dialog box as it saves the spreadsheet data into 
the more restrictive comma separated format:
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5 Click OK. 
Another warning dialog box displays:

6 Click Yes. 
The CSV text file is saved.

Viewing the CSV Text File in Notepad
You can view the CSV text file in Notepad or a similar application.
1 To open the CSV text file in Notepad, right-click on the file and select Open 

With Notepad.

This file can be uploaded into OpenText Active Catalogue by selecting 
Data Management > Text File Upload. See “Using a CSV Text File to Upload 
Data” on page 204.

Using a CSV Text File to Upload Data
To use a CSV text file to upload data
1 Click Data Management > Text File Upload. 

The Text File Upload page opens.

2 Select one of the following types for the data you want to upload:
■ Item—select to upload item attributes
■ Image—select to upload product or item image attributes
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3 Click Browse. 
The Choose file dialog box opens. 

4 Navigate to the CSV text file you want to upload, select it, and click Open. 
The path to the file displays in the Upload File box.

5 From the Date Format drop-down list, select the date format used in the text 
file you are uploading. 

6 Click Process to upload the file. 
A message indicates that the file is processing. When the upload is complete, 
the Text File Upload—Results page displays the results of the upload. 
Every record is treated individually. If a file has 100 records, and there are 5 
errors, then 95 records were successfully processed.
For records that were not uploaded successfully, the errors in the text file are 
displayed. See the section, “Correcting Errors in the CSV File” on page 206 for 
details about how to correct the errors and resubmit the file. 

The header displays:
■ File Name—the name of the file 
■ File Size—the size of the file
■ Date Format—the date format used in the file:

■ 1=MM/DD/YYYY
■ 2=DD/MM/YYYY
■ 3=YYYY-MM-DD

■ Total Lines—the total number of lines in the file that can potentially be 
processed (does not include the header or any commented lines).

■ Lines Processed—the total number of lines that were actually processed. 
A subset of Total Lines since some lines may not have met validation 
requirements (for example, mandatory elements are missing). These errors 
are considered validation errors, and the lines are not processed. Each line 
is validated prior to processing it. 

■ Error Lines—the number of lines that generated an error during 
processing. Validation errors are not included.

■ Success Lines—the number of lines that were successfully processed.
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7 To upload another file, click Data Management > Text File Upload to return 
to the Text File Upload page where you can browse for and upload additional 
files.

Correcting Errors in the CSV File
If the text file you uploaded contained errors, they display on the Text File 
Upload—Results page as soon as processing is complete. If you navigate away 
from this page, you will no longer be able to see the errors.
Note: Items that upload successfully can be downloaded using the Download 
process. See “Downloading Data” on page 208.

The table displays the line number of the error in your text file, the item number, 
the item type, the error code, and an error message. Correct the errors in your text 
file before uploading the file again.

To correct an error
1 In your CSV text file, locate the line number that corresponds to the line 

number of the error displayed on the Text File Upload—Results page.
2 Use the error message to determine what the error is.
3 Correct the error. For information about preparing and formatting a CSV text file 

for upload, see “CSV Text File Format Rules for Catalogue” on page 197.
4 Save the CSV text file and upload it again using the procedure, “Using a CSV 

Text File to Upload Data” on page 204.
Note: If the text file was partially loaded, you should create a new file 
containing only the lines in error. This prevents Catalogue from generating 
additional errors and updating (and therefore, charging for) items that have 
already been successfully changed.
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Working with Downloads 12
This section describes how to download catalogue data and images:
■ Downloading Data—Topics describe how to select and download catalogue 

data (including image attributes) on a one-time (ad hoc) basis using the 
following methods:

■ Batch file download
■ Text file download (including opening a downloaded CSV text file in Excel).

■ Downloading Images—Topics describe how to select and download physical 
images.

This section is organized as follows: 
■ “Downloading Data” on page 208

■ “Overview” on page 208
■ “Batch Download Process” on page 208
■ “Text File Download Process” on page 209

■ “Downloading Selection Codes” on page 210
■ “Downloading Products” on page 210
■ “Downloading GTINs” on page 210
■ “Viewing the Download Basket” on page 211
■ “Deleting Records from the Download Basket” on page 212
■ “Completing a One-Time Batch File Download” on page 212
■ “Completing a One-Time Text File Download” on page 214
■ “Deleting Text File Download Results” on page 219
■ “Finding a Text File Download Result” on page 220

■ “Filtering the Text File Download Results List” on page 220
■ “Opening a Downloaded CSV Text File in MS Excel” on page 221
■ “Downloading Images” on page 225

■ “Downloading Product Images” on page 225
■ “Downloading GTIN Images” on page 226
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Downloading Data
This section explains how to select and download catalogue data on a one-time 
(also called ad hoc) basis using one of the following download processes:
■ “Batch Download Process” on page 208.
■ “Text File Download Process” on page 209.
To request a full catalogue download, contact OpenText Cloud Support Services 
(CSS). See “Contacting Technical Support” on page 5. 
Note: Multiple Users—It is possible for multiple users to log in to Catalogue 
using the same user ID; however, if you intend to use the download feature, we 
recommend that each user have their own personal user ID. When a download is 
actually created, Catalogue views multiple sessions as one user, potentially causing 
confusion for the users about the data that is or isn’t received in their download. 
Additional user IDs can be obtained by contacting OpenText Cloud Support 
Services (CSS). See “Contacting Technical Support” on page 5.

Overview
There are two download methods for obtaining data on a one-time basis:
■ Batch file download—Catalogue allows you to download data to your 

electronic mailbox. The data can be exported in the following ways:
■ EDI format to your electronic mailbox—This is the default method. 

Catalogue sends the data to your electronic mailbox in EDI format. 
■ qXML format to your electronic mailbox on Inovisworks—This 

method requires some set up to be performed by OpenText Cloud Support 
Services (CSS), and is only available to customers who use Inovisworks as 
their VAN. See “Contacting Technical Support” on page 5.

Note: These methods are not limited to one-time downloads. Once they are 
set up, they apply to all exported data.

■ Text file download—Catalogue allows you to download data directly to your 
desktop as a text file. This is a two-stage process that allows you to access the 
retrieved data multiple times.
In the first stage, you select items using the download basket, and Catalogue 
retrieves your data and stores it. 
In the second stage, you download the data using different options to create a 
text file that you can save to your computer. Text files can be opened in an 
application such as MS Excel which allows you to view and manipulate the data. 
See “Opening a Downloaded CSV Text File in MS Excel” on page 221.

Batch Download Process
The batch download process consists of these steps: 
1 Find Selection Codes, Products, GTINs, or image attributes to download, and 

place them in the download “basket.”
2 View the download “basket” to verify your selections.
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3 Select the attribute filter, download method (Batch File), information type 
(Product, GTIN, or Media) and type of schedule (Immediate or Overnight). 
Note: The system limits Immediate downloads to one million items or less. If 
downloads are greater than one million, the system forces the Overnight option 
to go into effect. Overnight downloads of more than 5 million items must be 
broken into multiple downloads.

4 Complete the download by clicking Finish.
Note: The download basket is emptied when you exit the application, so 
complete all steps before logging out. 

Text File Download Process
The text file download process consists of these steps: 
1 Find Selection Codes, Products, GTINs or image attributes to download, and 

place them in the download “basket.” 
2 View the download “basket” to verify your selections.
3 Select the attribute filter and download method (Text File). 
4 Initiate the retrieval of data from Catalogue. At this point, Catalogue retrieves 

your data and stores it. 
■ The text file format will be item-oriented and include the Selection Code 

and Product for each item.
■ GTIN components will be in a separate file from the GTIN export file (in the 

same zip folder)
■ Image attributes will be in a separate file from the GTIN export file (in the 

same zip folder).
■ The system limits a single text file download to 250,000 items; an error 

message displays if you exceed the limit. You cannot complete the 
download until the number of items is below 250,000.

Note: Text File Downloads usually begin within 1 minute. However, at peak 
times, it may take up to 1 hour for your Text File Download to begin.

5 View the text file download results. Select the results from which to create the 
text file. 

6 (Optional) Select options that determine how the data is generated in the text 
file.

7 Download the data to create a text file.
The download basket is emptied when you exit the application, however, 
Catalogue stores the retrieved data so that you can select different options to 
create numerous text files to suit your purpose. Each time you log in, you can 
return to the text file download results, select a download result, select options 
that determine how the data is generated in the text file, and create a new text 
file that can be saved to your computer.
Note: You are billed only when the download basket is processed (the data is 
retrieved from Catalogue, Step 4), not when the data is downloaded to create a 
text file (Step 7).
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Downloading Selection Codes
To download Selection Codes
1 Find the Selection Code to download. See “Finding Selection Codes” on 

page 77.
2 In the column to the left of the Selection Codes, click one or more check boxes 

to choose Selection Codes to download. (Click a box again to deselect.) 
3 After choosing Selection Codes, click Download to add them to the download 

basket. 
4 Do one of the following:

■ To download more Selection Codes, go to Step 1.
■ To download Products, see “Downloading Products” on page 210.
■ To download GTINS, see “Downloading GTINs” on page 210.
■ To continue with the next step in the download process, go to “Viewing the 

Download Basket” on page 211.

Downloading Products
To download Products
1 Find the Product to download:

■ See “Finding Products Across Selection Codes” on page 80.
■ See “Finding Products Under One Selection Code” on page 82.

2 On a Product list page, in the column to the left of the Product, click one or 
more check boxes to select Products to download. (Click a box again to 
deselect.)

3 After choosing Products, click Download to add them to the download basket. 
4 Do one of the following:

■ To download more Products, go to Step 1.
■ To download Selection Codes, see “Downloading Selection Codes” on 

page 210.
■ To download GTINS, see “Downloading GTINs” on page 210.
■ To continue with the next step in the download process, go to “Viewing the 

Download Basket” on page 211.

Downloading GTINs 
To download GTINs
1 Find the GTIN to download: 

■ See “Finding GTINs Across Selection Codes” on page 88.
■ See “Finding GTINs Under One Product” on page 90.
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2 On a GTIN list page, in the column to the left of the GTIN, click one or more 
check boxes to select GTINs to download. (Click a box again to deselect.) 

3 After choosing GTINs, click Download to add them to the download basket
Note: On the GTIN Details page, click Download to add the GTIN to the 
download basket.

4 Do one of the following:
■ To download more GTINs, go to Step 1.
■ To download Selection Codes, see “Downloading Selection Codes” on 

page 210.
■ To download Products, see “Downloading Products” on page 210.
■ To continue with the next step in the download process, go to “Viewing the 

Download Basket” on page 211.

Viewing the Download Basket
You can view the contents of the download basket before completing the 
download. 

To view the contents of the download basket
1 Click Catalogue > Download Basket. The Download Basket page opens. 

2 The table displays from left for each record in the download basket: 
■ Check box to select a record for deletion from the basket. 
■ Trading Partner—The vendor’s name
■ Selection Code—The Selection Code identifier
■ Selection Code Description—The description of the Selection Code
■ Product—The Product identifier if the record is a Product or GTIN (blank 

for Selection Code)
■ GTIN—The GTIN identifier
■ GTIN Type—The GTIN type. See “GTIN Number Structures” on page 256.
■ Pack—The container type or component designation. See 

“Container/Component Designation Codes” on page 258. 
■ Color—The GS1 US color code
■ Color Description—The color description
■ Size—The GS1 US size code
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■ Size Description—The size description
■ Products—The number of Products under the Selection Code if the record 

is a Selection Code (blank for Products and GTINs). 
■ GTINs—The number of GTINs under the Selection Code or Product if the 

record is a Selection Code or Product (blank for GTINs). 
■ Image—The number of images associated with the Product (if the record 

is a Product) or GTIN (if the record is a GTIN). Regardless of whether a 
retailer has access to the Selection Code or Product, all images are counted 
at the Product and GTIN level. Images under Selection Codes or Products 
that the retailer does not have access to will not be downloaded or billed.

3 Do one of the following:
■ If you want to delete a record from the download basket, see “Deleting 

Records from the Download Basket” on page 212.
■ If you have verified your selection and are ready to continue with a batch 

file download, go to “Completing a One-Time Batch File Download” on 
page 212.

■ If you have verified your selection and are ready to continue with a text file 
download, go to “Completing a One-Time Text File Download” on 
page 214.

Deleting Records from the Download Basket
You can delete records from the download basket. This may be necessary because 
a record contains too many items, contains incorrect items, or contains items that 
are not text file download compatible.

To delete records from the download basket
1 Click Catalogue > Download Basket. The Download Basket page opens. 

See “Viewing the Download Basket” on page 211. 
2 In the column to the left of the Trading Partner, select the check boxes of the 

records you want to remove from the Download Basket (click again to 
deselect).

3 Click Delete to remove the records from the basket. 

Completing a One-Time Batch File Download
To complete a one-time batch file download
1 From the Download Basket page, (see “Viewing the Download Basket” on 

page 211), in the column to the left of the Trading Partner, select the check 
boxes of the records you want to download (click again to deselect).

2 Click Download. 
Note: All of the selected records in the download basket will be downloaded. 
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The Complete Data Download page opens. 

3 From the Attribute Filter drop-down list, select a filter to restrict the export of 
GTIN attributes

4 Select Batch File as your download method. Catalogue will send data to your 
electronic mailbox. The data is exported in EDI format.
Note: This option is only available if “EDI Support: Outbound from 
Catalogue” is enabled for your account. To contact technical support for 
assistance, see “Contacting Technical Support” on page 4.

5 Select one or more Information Types to indicate the type of data to download 
for the selected records. For records at the Selection Code or Product level, you 
can specify Product and/or GTIN Information Types. For records at the GTIN 
level, you can specify GTIN Information Types.

■ Products—Product attributes (and Selection Code Description above each 
Product).

■ Product Media—Product image attributes including:
■ Product image attributes for any “generic” Product image (that is, the 

Product image has no color code associated with it)
■ Product image attributes plus the color code associated with that 

Product image
Note: Only Product image attributes are downloaded using the 
Download Basket. To download Product physical images, see 
“Downloading Product Images” on page 225.

■ GTINs—GTIN attributes (and the Product and Selection Code Descriptions 
above each GTIN). 

■ GTIN Media—GTIN image attributes (and the Product image attributes 
for the Product images that are above each GTIN and meet the following 
criteria):
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■ Product image attributes for any “generic” Product image (that is, the 
Product image has no color code associated with it)

■ Product image attributes plus the color code associated with that 
Product image, for those Product images whose color code is the same 
as the color code of the GTIN.

■ GTIN image attributes for any GTIN image 
Note: Only GTIN image attributes are downloaded using the 
Download Basket. To download GTIN physical images, see 
“Downloading GTIN Images” on page 226.

6 Select when to download from Catalogue: 
■ Immediate
■ Overnight

Note: The system limits Immediate downloads to one million items or less. If 
downloads are greater than one million, the system forces the Overnight option 
to go into effect. Overnight downloads of more than 5 million items must be 
broken into multiple downloads.

7 The total number of Products and GTINs (items) that you have requested for 
download is displayed. This number may be greater than the actual number of 
Products and GTINs that are downloaded since only those Products and GTINs 
that you have access to are downloaded.

8 To confirm that you understand that you will be billed for downloading this 
data, select the check box, “I understand that Data Download is a billable 
action.”

9 Click Finish to complete the download. 

Completing a One-Time Text File Download
To complete a one-time text file download
1 From the Download Basket page, (see “Viewing the Download Basket” on 

page 211), in the column to the left of the Trading Partner, select the check 
boxes of the records you want to download (click again to deselect).

2 Click Download. 
Note: All of the selected records in the download basket will be downloaded. 
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The Complete Data Download page opens. 

3 From the Attribute Filter drop-down list, select a filter to restrict the export of 
GTIN attributes. The attributes that are exported become the column headers 
when you open the resulting text file as a CSV file (using an application such as 
Excel).

4 Select Text File as your download method. You are limited to 250,000 GTINs 
in one text file.

5 (Optional) To include component attributes in the download file, select Include 
Components. Component attributes for the exported GTINS will be included 
for all records that were in the download basket.
Note: A GTIN can have two levels of components; a GTIN can have 
components (first level of components), and the components can have 
components (second level of components). 
Currently, it is not possible to add a GTIN to the download basket and 
download two levels of components for that GTIN. To achieve this scenario, you 
must add the GTIN to the download basket and then add the first level 
component GTINs to the download basket. Since Catalogue downloads 
components for all GTINs in the download basket, both levels of components 
are downloaded.

6 (Optional) To include image attributes in the download file, select Include 
Image Attributes. Image attributes for the exported GTINS will be included 
for all records that were in the download basket.

7 The total number of Products and GTINs (items) that you have requested for 
download is displayed. This number may be greater than the actual number of 
Products and GTINs that are downloaded since only those Products and GTINs 
that you have access to are downloaded.

8 To confirm that you understand that you will be billed for downloading this 
data, select the check box, “I understand that Data Download is a billable 
action.”
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9 Click Finish. Catalogue retrieves the selected data and stores it. Once 
Catalogue begins the process of retrieving the data, the download basket is 
empty.
Note: The system limits a single text file download to 250,000 items; an error 
message displays if you exceed the limit. You cannot complete the download 
until the number of items is below 250,000.

10 To check the status of the data retrieval, click Data Management > Text File 
Download. The Text File Download—Results page opens.
Once the data retrieval is complete, it is available from this page (even after 
you log out and log back in) and can be downloaded multiple times to create 
text files without incurring additional charges.

The list displays the results of all text file downloads that you have initiated in 
the last 15 days. The most recent result is listed at the top of the list. After 15 
days, a text file download result is automatically deleted from this list. 
The table displays from left for each result in the list: 

■ Check box to select a result for deletion from list. 
■ Status—Status of the data retrieval from Catalogue.
■ User Id—The user identifier.
■ Account Id—The account identifier.
■ Start Date—Date and time that data retrieval started.
■ End Date—Date and time that data retrieval completed. 
■ Duration—Time it took to retrieve the data.
■ Download—Download icon (click to download the data to create a text 

file).
11 To find a result in the list: 

■ Filter the list. See “Filtering the Text File Download Results List” on 
page 220. 

■ Scroll through the list. 
■ Use the browse bar to move between pages.

12 To create the text file, in the Download column, click the icon next to the 
results from which you want to create the text file. The Text File Download—
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Options page opens. On this page, you can set options that determine how the 
data is generated in the text file.

13 Select one of the following options:
■ All Attributes—The text file will generate all attributes (including blank 

columns, for example, from multiline attributes that contain no data). Go to 
Step 16.

■ Limit Multiline occurrences—The text file will generate a specified 
number of multiline attributes. Go to Step 14.

14 To limit the number of multiline occurrences you want generated in the text file, 
type a number for each multiline attribute to indicate the number of 
occurrences you want to see. 
Note: The multiline attributes displayed on this page are determined by the 
attribute filter you selected for this request on the Complete Data Download 
page.
The numbers displayed to the right of each multiline attribute (for example, 2 
of 3) are represented as follows:

■ The first number indicates that at least one item in the file has the 
indicated number of multiline occurrences (for example, 2) for that 
attribute.

■ The second number indicates the maximum number of occurrences that 
are allowed for that attribute (for example, 3).

For example, Country of Origin (2 of 3) indicates that at least one item in the 
file has two Country of Origin occurrences out of a possible three Country of 
Origin occurrences allowed for that attribute. 
The ability to display a limited number of multiline occurrences in a text file is 
designed to support applications that can handle a limited number of items (for 
example, MS Excel does not support more than 256 columns of data). 

15 Click Save. 
The Download button displays in the upper-right corner of the page. 
Note: Even if you do not make any changes to the default limits that are 
shown, you must click Save; this action causes the Download button to display.
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16 Click Download to initiate the file download. The File Download dialog opens. 
17 Do one of the following:

■ Click Open to view the files. The file is downloaded as a zip file. You must 
unzip the file to view it. 
The file opens as a text file. See “Opening a Downloaded CSV Text File in 
MS Excel” on page 221 for information about working with the OpenText 
CSV format within MS Excel.

■ Click Save to save the file to your computer. The Save As dialog opens. 
Type a file name in the File name text box and click Save. The file is saved 
to your computer as a zip file. You must unzip the file to view it. 
The file opens as a text file. See “Opening a Downloaded CSV Text File in 
MS Excel” on page 221 for information about working with the OpenText 
CSV format within MS Excel.

■ Click Cancel to cancel the download and return to the Text File 
Download—Options page.

If you selected Include Components, the zip file contains a file for the GTINs 
you selected and a separate file for the GTIN’s components. The component’s 
file can be identified by “comp” in the filename. 
If you selected Include Image Attributes, the zip file also contains a separate 
file for the image attributes. The image file can be identified by “img” in the 
filename.
The corresponding file names are correlated by the user ID, account ID, and 
date and time of data retrieval.

When you open the text file as a CSV file (using an application such as Excel), 
the column headers are displayed as follows:

■ In the main file, the column headers are the attributes determined by the 
Attribute Filter and multiline options you selected for the download.

■ In the component file, the column headers are the following attributes:
■ VENDORACCOUNT
■ SELCODE
■ PRODUCT
■ COMPONENT_ITEM
■ CONTAINER_ITEM
■ QTY
■ UOM
■ PREPACK_FLAG

■ In the image file, the following attributes are included in the export:
■ Image Level
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■ Vendor Account ID
■ Selcode
■ Product
■ Item Number
■ Color Code
■ File Name
■ File Type
■ Image Type
■ Purpose
■ Orientation
■ Location Type
■ External Location
■ File Size
■ Pixel Density (DPI)
■ Height
■ Width
■ Image Style
■ Facing (GDSN)
■ Angle
■ Clipping Path
■ Image Description
■ Physical Image (Y/N)

Note: The download basket is emptied when you exit the application; 
however, Catalogue stores the data in a temporary location. This data is 
available so that you can apply different options to create numerous text files to 
suit your purpose. Each time you log in, you can return to the Text File 
Download—Results page, select a previous data result, apply options to the 
data, and create a new text file that can be saved to your computer.

Deleting Text File Download Results
To delete text file download results
1 Click Data Management > Text File Download. The Text File Download—

Results page opens. 
2 Select the check boxes to the left of the results you want to remove (click again 

to deselect).
3 Click Delete to remove the results from the list.

Note: After 15 days, a text file download result is automatically deleted from 
this list.
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Finding a Text File Download Result
To find a text file download result
1 Click Data Management > Text File Download. The Text File Download—

Results page opens. 

2 (Optional) To filter the list, see “Filtering the Text File Download Results List” on 
page 220. 

3 Do one of the following:
■ To create the text file, in the Download column, click the icon next to the 

results from which you want to create the text file. The Text File 
Download—Options page opens. Continue with Step 13 in the section, 
“Completing a One-Time Text File Download” on page 214.

■ To delete a download result, in the column to the left of the Status column, 
select the check boxes of the results you want to remove (click again to 
deselect). Click Delete to remove the results from the list. 

Filtering the Text File Download Results List
You can use the filter to display a list of download results based on the criteria you 
specify. 

To filter the text file download results list
1 On the Text File Download—Results page (Data Management > Text File 

Download), enter the criteria for each of the options you want to filter by. You 
can filter on multiple options simultaneously.

■ Status—Select a status from the drop-down list to display only results with 
the specified status:

■ New—Show only those results for data that was requested but is not 
yet in the process of being retrieved.

■ In Progress—Show only results for data that is in the process of being 
retrieved.

■ Complete—Show only results for data that has been completely 
retrieved.

■ In Error—Show only results for data that the system was not able to 
retrieve.

■ User Id—To show only results for a specified user Id, type a partial or full 
user Id in the text box. 
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■ Start Date—Show only results for data that was retrieved with on or after 
a specified start date. Type a date using the format set for your account 
(for example, MM/DD/YYYY), or click Auto Calendar and select a date.

■ End Date—Show only results for data that was retrieved on or after a 
specified end date. Type a date using the format set for your account (for 
example, MM/DD/YYYY), or click Auto Calendar and select a date.

2 Click Filter. The list that meets your criteria displays.
Note: To remove all filter criteria, click Clear Filter.

Opening a Downloaded CSV Text File in MS Excel
This topic describes how to work with a downloaded OpenText Active Catalogue 
text file within Microsoft Excel (MS Excel). The procedures step you through the 
process of opening the text file in MS Excel so that the format of the GTINs, 
Selection codes, and Products is preserved. 
Note: Catalogue creates a comma separated values (CSV) text file that has a .txt 
extension rather than a .csv extension. This allows you to open the text file in MS 
Excel and then set specific options so that the format of your data is preserved.
There are two methods for opening a text file in MS Excel:
■ Using the MS Excel Text Import Wizard—see “Using the MS Excel Text Import 

Wizard” on page 221
■ Using the Open With option from Windows Explorer—see “Using the Open With 

Option from Windows Explorer” on page 224

Using the MS Excel Text Import Wizard
1 Open MS Excel.
2 From the File menu, select Open. 

The Open window opens.
3 Navigate to the location of the text file (.txt extension).

Note: Next to the File name text box, be sure to select Text Files from the 
drop-down list so that all text files display. 

4 Select the file, and click Open or Open Other Workbooks. 
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MS Excel’s Text Import Wizard - Step 1 of 3 window opens.

5 Select Delimited as the file type that best describes your data (how your data 
will be read).

6 Click Next. 
The Text Import Wizard - Step 2 of 3 window opens.

7 Be sure that the following options are set:
a Under Delimiters, select the Tab check box and the Comma check box. 

Make sure that all other check boxes are cleared.
b Clear the Treat consecutive delimiters as one check box.
c From the Text qualifier drop-down list, select the double quotes (").

8 Click Next. 
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The Text Import Wizard - Step 3 of 3 window opens

9 Select the first column (which contains the ITEM_NUMBER) by clicking the 
General column heading. 
The column highlights.

10 Under Column data format, select Text. 
The column heading now reads Text.
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11 Repeat Steps 9 and 10 for the third and fourth General columns (which contain 
the Selection Code and Product data) to set them to a Text data format.

Note: Depending on the filter you selected, Private Account IDs associated 
with Unit Cost and MSRP also need to be set to a Text data format.

12 Click Finish. 
The downloaded data displays in Excel, and the format of the GTINs, Selection 
codes, and Products is preserved. 

Note: To expand all columns to the width of the data within each column, 
highlight the entire spreadsheet by clicking on the upper left-hand corner of the 
spreadsheet, and then double-click on the line between any of the column 
headings.

Using the Open With Option from Windows Explorer
1 In Windows Explorer, navigate to the location of the text file.
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2 Right-click on the file and select Open With > Microsoft Office Excel.
Note: Double-clicking on the file will open it in Notepad.

The downloaded data displays in Excel, but each line of data is stored in the 
first column.

3 Select the first column (A) by clicking on the A column heading.
4 From the Data menu, select Text to Columns. MS Excel’s Text Import Wizard 

- Step 1 of 3 window opens. 
Continue with Step 5 in the section, “Using the MS Excel Text Import Wizard” 
on page 221, and complete the remaining steps in that section. They will guide 
you through Excel’s Text Import Wizard until the downloaded data displays in 
Excel.

Downloading Images
This section describes how to download the physical images associated with 
Products and GTINs:
■ “Downloading Product Images” on page 225
■ “Downloading GTIN Images” on page 226

Downloading Product Images
You can download a physical image that is associated with a Product. This is a 
billable action.

To download a Product image
1 Find the Product image you want to download.

■ See “Finding Products Across Selection Codes” on page 80. 
■ See “Finding Products Under One Selection Code” on page 82.

The Product List page opens.
2 Click the image hyperlink (in the Image column) for the Product whose image 

you want to download. 
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The Product Media page opens. 

3 Click Download Image (a billable action).
The File Download dialog box opens.

4 Click Save.
The Save As dialog box opens. 

5 Navigate to the location where you want to save the image, and click Save.
The image is saved to your computer. 
Note: The image is not watermarked and has a higher resolution than the 
watermarked image that displays in Catalogue.

Downloading GTIN Images
You can download a physical image that is associated with a GTIN. This is a billable 
action.

To download a GTIN image
1 Find the GTIN image you want to download.

■ See “Finding GTINs Across Selection Codes” on page 88. 
■ See “Finding GTINs Under One Product” on page 90.

The GTIN List page opens.
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2 Click the image hyperlink (in the Image column) for the GTIN whose image you 
want to download. 

The Item Media page opens. 

3 Click Download Image (a billable action).
The File Download dialog box opens.

4 Click Save.
The Save As dialog box opens. 

5 Navigate to the location where you want to save the image, and click Save.
The image is saved to your computer. 
Note: The image is not watermarked and has a higher resolution than the 
watermarked image that displays in Catalogue.
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You can use the user interface (UI) to monitor EDI files that you send to OpenText 
Active Catalogue. The following pages will help you identify your errors. In some 
cases, you can correct your errors online.
■ The EDI Management Console (EMC) List—This page displays EDI 

validation and EDI standards validation errors which are described in the 
section,“EDI Validation Workflow” on page 228. The section, “Using the EDI 
Management Console” on page 229, describes how to use the EMC page to 
monitor the EDI files that you send. 

■ Error Processing (EP)—This module consists of a series of pages that allows 
you to drill down to see translation and data validation errors which are 
described in the section, “EDI Validation Workflow” on page 228. Chapter 14, 
"Online Correction of Errors," on page 235, describes how to use the EP pages to 
manage and correct EDI errors.

Before submitting EDI data to your production environment, you can validate your 
data by submitting sample EDI text or an EDI test file to Catalogue. The section, 
“Submitting EDI Sample Data” on page 233, describes how to submit EDI data.
This section is organized as follows: 
■ “EDI Validation Workflow” on page 228.
■ “Using the EDI Management Console” on page 229.
■ “Filtering the EDI File List on the EMC” on page 232.
■ “Submitting EDI Sample Data” on page 233.

EDI Validation Workflow
OpenText Active Catalogue performs the following validations of your EDI data:
1 EDI validation - Catalogue first checks your data to ensure that it is EDI data. 

Typical errors at this stage are unknown Catalogue account number, unknown 
batch password and unknown proxy account. These types of errors appear on 
the EMC page. See “Using the EDI Management Console” on page 229 to 
identify these types of errors.

2 EDI standards validation - Catalogue validates the EDI data to ensure that 
the EDI conforms to published EDI standards. The EDI data is validated for EDI 
qualifiers, mandatory segments and elements, field lengths, and so on. These 
types of errors appear on the EMC page. See “Using the EDI Management 
Console” on page 229 to identify these types of errors.
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You must fix all EDI standards validation errors and resend the EDI document 
before Catalogue can process the file.

3 Translation validation - If an ST group in your EDI data contains a 
translation error, the entire group is sent to Error Processing (EP). Subsequent 
ST groups will continue to be processed. You can use EP to locate the error in 
the EDI data. See “Viewing Translation Errors in an EDI Document” on 
page 245 to identify these types of errors.
You must fix all translation errors and resend the EDI data before Catalogue 
can process the file.

4 Data validation - Catalogue validates the EDI data to ensure that it conforms 
to Catalogue specifications such as business rules, data validations, and 
compliance checks. These rules are documented in the following guides, 
depending on the type of EDI document you are submitting:

■ OpenText Active Catalogue 832 (v4010) Batch Guide for Vendors 
■ OpenText Active Catalogue 832 (v4030) Batch Guide for Vendors 
■ OpenText Active Catalogue 888 Batch Guide for Vendors

Examples of errors at this stage include invalid batch password and error for 
action “00” when the G53 segment is not correct. These types of errors appear 
in Error Processing (EP). See Chapter 14, "Online Correction of Errors," on page 
235 to identify these types of errors.

Using the EDI Management Console
You can use the EDI Management Console (EMC) to monitor the EDI files that you 
send to Catalogue (EDI documents sent to your production environment or EDI 
sample data sent to the demo environment). The EMC displays EDI validation (for 
example, unknown Catalogue account number, unknown batch password or 
unknown proxy account) and EDI standards validation errors (for example, non-
compliant EDI qualifiers, mandatory segments and elements, field lengths and so 
on). 
Note: EDI files and records on the EDI Management Console are retained for 180 
days.

To view EDI errors on the EDI Management Console
1 Log in to the environment where you submitted the EDI files:

■ Your production environment—The URL for the production 
environment is https://catalogue.gxs.com

■ The demo environment—The demo environment is used to submit 
sample EDI text or test EDI files to validate data before it is submitted to 
your production environment. The URL for the demo environment is 
https://cataloguedemo.gxs.com

Note: Before you can submit EDI sample data, you must have a 
Catalogue Demo Account set up in the demo environment. Call 
OpenText Cloud Support Services (CSS) at 1-800-334-2255 for 
information on setting up this account.

https://cataloguedemo.gxs.com
http://catalogue.gxs.com
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2 Click Data Management > EDI Management Console. The EDI 
Management Console List page opens.
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The table displays from left for each EDI file: 
Check boxes to the left 
of files

Check boxes for selecting EDI files to cancel processing. 
Note: Click the top check box to the left of the Status 
heading to select all documents on a page. Once this check 
box is selected, deselecting a check box for any file deselects 
the top check box.

Status File’s current status:
■ New—The file has not been processed by the system and 

is eligible for processing.
■ Completed—The file has been processed by the system 

and there are no errors.
■ Completed With Errors—The file has been processed by 

the system, but it contains business errors (for example, 
an incorrect color code) which will appear in Error 
Processing (EP).

■ In Progress—The file is being processed.
■ In Error—The file failed EDI validation. Typical errors 

include unknown Catalogue account number, unknown 
batch password, and unknown proxy account. An email of 
this error is sent to cataloguesupport@opentext.com.

■ Cancelled—The file is not eligible for processing by the 
system; someone took the action to cancel the file from 
being processed.

■ Partially Processed—The file’s processing was 
suspended because the queue processor shut down. 
When the queue processor restarts, the file resumes 
processing and its status is changed to In Progress.

■ Failed Validation—The file failed EDI standards 
validation; EDI data does not conform to published EDI 
standards. Typical errors include EDI qualifiers, mandatory 
segments and elements, field lengths, and so on.

■ Unsupported Document Type—The file is not an EDI 
file.

■ Duplicate CtlNum—The file failed because another file 
with the same control number was already submitted for 
processing. This status is not applicable if the option 
“Allow duplicate ISA/IEA control numbers” has been set 
for your account by an administrator.

Document Control 
Number

The control number of the original EDI file.
If your account is set up to allow duplicate control numbers, a 
sequence number is generated up to 99,999. The number is 
displayed as DocumentControlNumber:SequenceNumber
If the Load Status Report option has been turned on at the 
account level (by the OpenText administrator), you can click on 
the document control number to display the Load Status 
Report (LSR) for the file (which can then be downloaded). 
To turn on the LSR option, see “Contacting Technical Support” 
on page 5.
For more information on the LSR, see “Load Status Report” on 
page 184.

Account Number The identification number of the account to which the file was 
submitted.

mailto:cataloguesupport@opentext.com
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3 To locate a file in the list, do any of the following: 
■ Filter the EDI file list. See “Filtering the EDI File List on the EMC” on 

page 232. 
■ Scroll down the list. 
■ Use the browse bar to move between pages.

Filtering the EDI File List on the EMC
You can use the filter to display the EDI file list based on the criteria you specify.

To filter the EDI file list
1 On the EDI Management Console (EMC) List page, enter the criteria for each of 

the options you want to filter by. You can filter on multiple options 
simultaneously.

■ Status—Select a status from the drop-down list to display only results with 
the specified status:

■ New—The file has not been processed by the system and is eligible for 
processing.

■ Completed—The file has been processed by the system and there are 
no errors.

■ Completed with Errors—The file has been processed by the system, 
but it contains business errors (for example, an incorrect color code) 
which will appear in Error Processing (EP).

■ In Progress—The file is being processed.
■ In Error—The file failed EDI validation. Typical errors include unknown 

Catalogue account number, unknown batch password, and unknown 
proxy account. An email of this error is sent to 
cataloguesupport@opentext.com.

■ Cancelled—The file is not eligible for processing by the system; 
someone took the action to cancel the file from being processed.

Account Name The name of the account to which the file was submitted.
File Name The name of the file.
File Size (bytes) The size of the file you submitted. Move your cursor over the 

file size to see the name of the file. This file name is the 
OpenText Doc ID.

Queued The date and time the file was retrieved from Inovisworks via 
FTP. 

Started The date and time Catalogue started processing the file.
Finished The date and time Catalogue finished processing the file.
Duration The amount of time it took Catalogue to process the file.
Notes Detailed information about the error.
Download Click the Download icon associated with a file to open or save 

the EDI file in standard size (not zip file). EDI files are available 
regardless of their status.

mailto:cataloguesupport@opentext.com
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■ Partially Processed—The file’s processing was suspended because 
the queue processor shut down. When the queue processor restarts, 
the file resumes processing and its status is changed to In Progress.

■ Failed Validation—The file failed EDI standards validation; EDI data 
does not conform to published EDI standards. Typical errors include EDI 
qualifiers, mandatory segments and elements, field lengths, and so on.

■ Unsupported Document Type—The file is not an EDI file.
■ Duplicate CtlNum—The file failed because another file with the same 

control number was already submitted for processing. 
■ Document Control Number—Enter the full or partial document control 

number (ST control number) of the file.
2 Click Filter. The list that meets your criteria displays.

Note: To remove all filter criteria, click Clear Filter.

Submitting EDI Sample Data
You can submit sample EDI text or an EDI test file to Catalogue’s demo 
environment. This feature is not available in the production environment. 
Catalogue will validate the EDI data, and any resulting errors will appear on the 
EDI Management Console List page or in Error Processing. 
Note: Before you can submit EDI sample data, you must contact OpenText Cloud 
Support Services (CSS) at 1-800-334-2255 to initiate the process of setting up a 
Catalogue Demo Account for you in the demo environment.

To submit EDI data
1 Log in to the demo environment at the following URL:

https://cataloguedemo.gxs.com

2 Click Data Management > EDI Management Console. The EDI 
Management Console List page opens.

https://cataloguedemo.gxs.com
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3 Click Add EDI. The Submit EDI page opens.

4 Select the option for submitting your EDI data:
■ Submit EDI Text—Select this option if you want to enter EDI text. Enter 

your EDI test data in the box on the page. To clear the text and start over, 
click Clear.

■ Submit EDI File—Select this option to re-display the page with an option 
to browse for your file, as shown below. Click Browse, navigate to your 
file, select it, and click Open. The path to the file appears in the File Name 
text box.

5 Click Submit to submit your file to Catalogue. The page displays a message 
indicating whether your file was submitted successfully.
EDI validation and EDI standards validation errors appear on the EDI 
Management Console (EMC) List page. See “Using the EDI Management 
Console” on page 229 to identify these types of errors.
Translation and data validation errors appear in Error Processing (EP). See 
Chapter 14, "Online Correction of Errors," on page 235 to identify these types 
of errors.
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Online Correction of Errors 14
This section explains how to use the Error Processing (EP) module in the browser 
interface. The Error Processing module is used to manage any errors encountered 
by Catalogue while processing a batch EDI document or EDI sample data 
(see“Submitting EDI Sample Data” on page 233). These errors prevent Catalogue 
from processing the complete document and must be corrected before the 
remaining actions in the document can be completed.
Note: Error Processing is only used to manage errors generated by batch 
documents or errors generated by submitting EDI sample data. Errors encountered 
in the browser are displayed on the page.
This section is organized as follows: 
■ “How Catalogue Processes Batch Files” on page 235.
■ “Strategies for Correcting Errors” on page 237.
■ “Rejectable qXML Functions” on page 239.
■ “Levels of Error Processing” on page 239.
■ “Navigating Error Processing” on page 240.
■ “Viewing Translation Errors in an EDI Document” on page 245.
■ “Copying Error Processing Data to a Table” on page 246
■ “Selecting Errors for Delete, Revert, or Edit” on page 248.
■ “Deleting Errors” on page 250.
■ “Correcting Errors” on page 250.
■ “Reverting Errors” on page 253.
■ “Resubmitting Error Documents” on page 254.
■ “Marking Error Documents as Read or Unread” on page 254.

How Catalogue Processes Batch Files
Documents sent by batch interface to Catalogue go through the following process: 
1 OpenText picks up the inbound EDI document from the OpenText electronic 

mailbox. 
2 OpenText checks file integrity against the EDI standards. 
3 The EDI document is validated for EDI qualifiers, mandatory segments and 

elements, field lengths, and so on. 
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If your administrator has not selected the option (during the account set-up 
process) that prevents functional acknowledgements (FAs) from being 
generated, one of the following occurs:

■ If the document passes EDI validation, you will receive a positive FA (997 
or CNTRL) message to acknowledge receipt of the document. The process 
continues with Step 4.

■ If the document fails EDI validation, you will receive a negative FA 
message. The errors will not appear in Error Processing (EP). You must 
resend a corrected standards-compliant EDI document that Catalogue will 
be able to process.

Note: Control numbers must be unique. If a duplicate control number is 
found, the entire EDI document will be ignored. The corrected document must 
be sent with a new control number.

4 The files are queued and processed in FIFO order (first files in are the first files 
out).

5 Within the EDI document, Catalogue processes each valid ST group as a 
separate transaction. OpenText translates each transaction into a series of 
qXML functions. 
qXML is the OpenText-designed implementation of XML, a document format 
created to load data into Catalogue. Within qXML, the original EDI is structured 
as "functions" (actions, records, or business tasks). Successful translation 
depends on the correct use of EDI mapping as detailed in the OpenText Active 
Catalogue 832 Batch Guide for Vendors and the OpenText Active Catalogue 888 
Batch Guide for Vendors.
Note: EDI documents containing errors that prevent translation into qXML 
appear in EP. You can use EP to locate the error in the EDI document. You must 
then fix the errors and resend the EDI document.

6 Catalogue attempts to validate the functions. This includes running business 
rule validations, data validations, and compliance checks for each item. The 
system stops processing a specific function when it encounters the first error in 
that function. Catalogue continues processing subsequent functions.
This process results in one of the following:

■ No errors—Successful data maintenance for that item.
■ Errors—The errors are sent to Error Processing (EP). No data 

maintenance takes place for that item. You can correct the errors online 
through EP and resubmit the error document.

7 Catalogue sends you a separate email for each EDI document that contains 
errors. It includes a hyperlink to the browser interface where you can 
troubleshoot the errors. 
The email can be recognized by its subject line:
"OpenText Active Catalogue error report (control number: DocumentControlNumber)." 
See the example below. The email includes the number of qXML functions 
(translated from EDI) that were rejected and a summary of the errors.
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The email is sent to the primary contact email address for your account 
(Account > Account Details on the Account Details tab in the Contact 
panel). Be sure that this email address is valid.

Example

Subject: OpenText Active Catalogue error report (control number: DocumentControlNumber)

One or more errors occurred while processing your input file. Please login to the OpenText Active Catalogue User Interface to review 
and manage these errors.
(https://catalogue.gxs.com)

Control number: DocumentControlNumber
Date:              May 6, 2007
Time:              5:27:38 AM
Number of errors:  360

Error    Count  Description
-20505   23     Failed to get existing item attributes; error code=-20505
-20505   15     Item Number not found
-20511   3      Duplicate item number302 
-90034   1      Item number already exists
-20510   318 Specified Selection Code or Product not found.  It may have been deleted by 
another user.

8 You can use Error Processing in the browser interface to view and manage 
errors. See the next section, “Strategies for Correcting Errors.”
Note: Any errors displayed in Error Processing are automatically purged from 
Catalogue after 60 days.

Strategies for Correcting Errors
Depending on the type of errors in your document, use the appropriate strategies 
described in the sections below to correct them.
■ “EDI Validation Errors”
■ “Translation Errors”
■ “Data Validation Errors”

EDI Validation Errors
If you sent an EDI document and received a negative FA message, your document 
was not compliant with EDI standards. You must fix all EDI standards validation 
errors before Catalogue can process the file. This type of error does not appear in 
EP. It appears on the EDI Management Console (EMC) List page. See Chapter 13, 
"Working with EDI Data," on page 228 for information on using this page to 
identify errors.
Note: Control numbers must be unique. If a duplicate control number is found, 
the entire EDI document will be ignored. The corrected document must be sent 
with a new control number.

https://catalogue.gxs.com


238 OpenText Active Catalogue CE 21.2 Browser Interface User Guide

O N L I N E  C O R R E C T I O N  O F  E R R O R S

Strategies for Correcting Errors

Translation Errors
If an ST group in your EDI document contains a translation error, the entire group 
is sent to EP. Subsequent ST groups will continue to be processed. You can use EP 
to locate the error in the EDI document. See “Viewing Translation Errors in an EDI 
Document” on page 245.
You must fix all translation errors and resend the EDI document before Catalogue 
can process the file. 

Data Validation Errors
If an EDI document is standards-compliant and has not triggered a translation 
error, the functions it contains will be processed by Catalogue. This includes 
running business rule validations, data validations, and compliance checks for each 
item. If an error occurs during one of these checks, the error appears in EP, and no 
data maintenance takes place for that item.
There are several ways to approach correcting data validation errors (online and 
offline)

Online Error Corrections
Online error corrections are corrections you make using EP. Two possible strategies 
are listed below:
■ Examine the types of errors and the details of an error. Drill down to the Error 

Processing (error detail) page, edit the values, and resubmit the error document 
that contains that error.

■ Examine the types of errors in one or more functions. Some errors may be 
compounded; that is, an error in one function causes errors in other functions. 
Fixing an error in one function will allow all the error documents to be 
resubmitted.
Example: One qXML function may create a Selection Code; however, the 
Selection Code description is invalid. Another qXML function attempts to add 
items under the same Selection Code which does not yet exist. Therefore, both 
functions contain errors. You can fix one error (the Selection Code) and 
resubmit all the error documents; all functions will succeed.

Offline Error Corrections
Offline error corrections are corrections you make using an interface other than the 
browser interface. 
You can examine the types of errors in one or more error documents. You may 
decide that it is easier to change the data in the system that generated the 
document and resend the EDI document to OpenText. Therefore, you would want 
to delete the error document in Error Processing because it will be superseded by a 
document with new data.
Note: Control numbers must be unique. If a duplicate control number is found, 
the entire EDI document will be ignored. The corrected document must be sent 
with a new control number.
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Using Group Edit to Correct Errors
If you review the cause of an error and realize that the same error exists across all 
data you have sent, you can use group edit to apply the same change to a selected 
group of errors. Group edit is a powerful feature that allows you to:
■ set all actions to a specific action (add, replace, update, delete)
■ replace an action with a different action (replace “update” with “replace”, replace 

“delete” with “add”, etc.)
■ search for a combination of a value, a UOM, and/or an account number for a 

selected attribute and replace one or more of them with a new combination of a 
value, a UOM, and/or an account number

Note: In most cases, it is preferable to edit the source data (for example, the item 
master) used to generate the batch file that you load into Catalogue. However, 
there may be instances where you need to temporarily fix data already pending at 
OpenText so that the data being sent to your trading partner is not delayed.

Rejectable qXML Functions
In general, a rejectable qXML function is a qXML function that can change data in 
the database. If a rejectable qXML function contains an error, it is sent to Error 
Processing. The following qXML functions are rejectable: 
■ bulkLoadAccountAttributes—Maintaining your account attributes
■ bulkLoadHierarchyAttributes—Adding and updating Selection Codes and 

Products
■ deleteHierarchyNode—Deleting Selection Codes and Products
■ bulkLoadItemAttributes—Adding and updating GTINs
■ deleteItemNumber—Deleting GTINs

Levels of Error Processing
You can analyze and fix errors by using Error Processing to drill down into 
subsequent levels of detail.
■ Error Processing (document list) page—Displays error documents. Each 

error document contains the errors generated by a single input document. You 
can click on a document to open subsequent pages and with more detail about 
the error:

■ Error Processing (error type list) page—If the error is not an EDI 
Error, this page opens to displays all errors for the selected error 
document. All errors are grouped by error type. A description identifies the 
type of error. Each group of error types can be expanded to display a list of 
all errors for that error type. You can click on an error to open the Error 
Processing (error detail) page; this is the next level of detail. 

■ Error Processing (error detail) page—This is the lowest level for an 
error that is not an EDI Error. This page displays details about the 
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selected error, indicates the attribute values that are invalid, and allows 
you to correct the values.

■ Error Processing (document translation error) page—If the error is 
an EDI Error, this page opens to display a fragment of the EDI document 
that highlights the error. You can also go to the EDI Management Console 
(EMC) page to see further details about the document. See Chapter 13, 
"Working with EDI Data," on page 228 for information on using this page 
to identify errors.

Note: Any errors displayed in Error Processing are automatically purged from 
Catalogue after 60 days.

Navigating Error Processing
To navigate through the levels of Error Processing
1 Click Data Management > Error Processing. The Error Processing 

(document list) page opens. 

The table displays from left for each error document: 
Check boxes to the left 
of error documents

Check boxes for selecting error documents to delete, resubmit, 
or revert. 
Note: Select the top check box to the left of the Date/Time 
heading to select all documents on a page. Once this check 
box is selected, deselecting a check box for any document 
deselects the top check box.

Date/Time Date and time the document containing errors was retrieved 
and processed by Catalogue (list begins with most recent 
documents). Click the hyperlink to open the Error Processing 
(error type list) page for the error document. 
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Documents whose dates and times are in plain typeface have been read or 
marked “Read.” Those in bold typeface have not been read or have been 
marked “Unread.” For more information, see “Marking Error Documents as 
Read or Unread” on page 254.

2 To find an error document in the list: 
■ Filter the list to find specific types of error documents. See “Filtering the 

Error Documents List” on page 244. 
■ Scroll through the list. 
■ Use the browse bar to move between pages.

For each document, you can look at the number of errors and the number of 
error types to get an idea of the scope of errors in a document. 

3 Do one of the following: 
■ To view a fragment of the EDI document that contains a translation error 

(identified by the status EDI Error), click the error document’s hyperlink in 
the Date/Time column. See “Viewing Translation Errors in an EDI 
Document” on page 245.

Document Control 
Number

A separate record is displayed for each ST segment that 
contains a translation error; the ST number is appended to the 
control number of the original EDI document. 
Note: One email notification is sent for each EDI document 
that was sent, even though several segments may be in error.
If your account is set up to allow duplicate control numbers, 
the record is displayed as 
DocumentControlNumber:TransactionNumber:SequenceNumb
er

Errors Number of errors in the error document. 
Error Types Number of error types in the error document. 
Status Error document's current status:

Error—No errors in the error document have been edited.
EDI Error—Translation errors have occurred in an ST segment 
of a sent EDI document. EDI errors cannot be fixed and 
resubmitted using Error Processing; however, you can view a 
fragment of the EDI document that contains the error to help 
you identify the problem.
Maintained—One or more errors in the error document have 
been edited, but the error document has not been 
resubmitted.
Pending Resubmit—Error document resubmission is 
pending.
Error Resubmit—Error document was resubmitted and still 
contains an error.
Synchronous Resubmit—Error document has been 
resubmitted and is in progress.

Last Update Date/Time Date and time the error document was last updated or 
resubmitted to Catalogue. 

Last Update User ID User who last updated the error document.
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■ To view more details about the EDI data request that contains an error 
(identified by the status Uncorrectable Error), click the error document’s 
hyperlink in the Date/Time column. See 

■ To view a list of error types in an error document, click the error 
document's hyperlink in the Date/Time column. The Error Processing (error 
type list) page opens. Go to Step 4.

■ To resubmit errors by error document, see “Resubmitting Error Documents” 
on page 254.

■ To delete errors by error document, see “Deleting Errors” on page 250.
■ To revert errors by error document, see “Reverting Errors” on page 253.

4 On the Error Processing (error type list) page, errors are listed by error types.

The table displays from left for each error type:
Check boxes to the left of 
the Error Type column

Check boxes for selecting error types to delete, revert, or 
edit.
Note: Select the top check box to the left of the Error 
Type heading to select all error types on a page. Once this 
check box is selected, deselecting a check box for any error 
type deselects the top check box.

Error Type Code indicating error type. Click the Error Type hyperlink to 
expand (or collapse) a list of all errors for that error type.

Count Number of errors for that error type.
Description Description of the error type.
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To expand a list of all errors for a specific error type, click the Error Type 
hyperlink. The expanded view is shown below. 

Errors are listed by error types. The table displays from left for each error type: 

5 Do one of the following:
■ To view the details of an error, click its hyperlink in the Action column. The 

Error Processing (error detail) page opens. Go to Step 6.
■ To delete errors individually or by error type, see “Deleting Errors” on 

page 250.
■ To revert errors individually or by error type, see “Reverting Errors” on 

page 253.

Check boxes to the left of 
the errors (in the Action 
column)

Check boxes for selecting errors to delete, revert, or edit. 

Action Specifies the action the function was attempting to 
perform. Click the hyperlink to open the Error Processing 
(error detail) page to view detailed information about the 
error and to edit attribute values to correct the error.

Selection Code When applicable, specifies the Selection Code in the error.
Product When applicable, specifies the Product in the error.
GTIN When applicable, specifies the GTIN in the error.
Details Text description of the error.
Status Error’s current status:

■ Error—Error has not been edited. 
■ Maintained—Error has been edited. 
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6 View the Error Processing (error detail) page. 

The table displays from left for each attribute in the function:

Error locations are indicated in red. Details about the error are displayed. See 
“Correcting Errors” on page 250 for information about correcting errors.

Filtering the Error Documents List
You can use a filter to display a list of error documents based on the criteria you 
specify.

To filter the error documents list
1 On the Error Processing (document list) page, enter the criteria for each of the 

options you want to filter by. You can filter on multiple options simultaneously.
■ Status - Select a status from the drop-down list to display only results with 

the specified status:
■ Error—Show only error documents where no errors in an error 

document have been edited.
■ EDI Error—Show only error documents where an error was caused by 

a translation error.
■ Maintained—Show only error documents where one or more errors in 

an error document have been edited, but the error document has not 
been resubmitted.

■ Pending Resubmit—Show only error documents where an error 
document is pending resubmission.

■ Error - Resubmit—Show only error documents where an error 
document was resubmitted and still contained an error.

Delete Check box to select the attribute for deletion from the function. 
Attribute Name The attribute name.
Value Value of the attribute.
UOM Unit of measure for the attribute (if applicable).
Private Account ID Field for retailer number (if applicable) when attribute is 

private (for example, Unit Cost).
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■ Synchronous Resubmit—Show only error documents where an error 
document has been resubmitted and is in progress.

■ Read Status - Select a status from the drop-down list to display only error 
documents with the specified Read/Unread status:

■ Read—Show only error documents that are displayed in plain typeface 
(they have been marked Read). 

■ Unread—Show only error documents that are displayed in bold 
typeface (they have been marked Unread).

■ Document Control Number - Enter a partial or complete document 
control number to display only error documents that begin with those 
numbers.

2 Click Filter. The list that meets your criteria displays.
Note: To remove all filter criteria, click Clear Filter.

Viewing Translation Errors in an EDI Document
Translation errors can occur in the ST segment of an EDI document. Even though 
translation errors cannot be fixed and resubmitted using Error Processing (EP), EP 
can help you locate the problem by displaying a fragment of the EDI document 
that contains the error. You must fix all translation errors and resend the EDI 
document before Catalogue can fully process the file.

To view a translation error
1 Navigate to the Error Processing (document list) page to find the error 

document whose translation error you want to view. See “Navigating Error 
Processing” on page 240. 
Tip: EDI documents containing translation errors are identified by a status of 
EDI Error. Filter the list to display only those error documents with EDI errors; 
from the Status drop-down list, select EDI Error. Click Filter.

2 Click the error document’s hyperlink in the Date/Time column. The Error 
Processing (document translation error) page opens.

3 Use the information on this page to locate and correct the error in your EDI 
document. 
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4 Once you have corrected the error in your EDI document, delete this error 
document from EP. See “Deleting Errors” on page 250.

5 Resend your corrected EDI document.

Copying Error Processing Data to a Table
You can use the “Copy Data to Table” feature to copy to a table the details of errors 
that display on the Error Processing (document list) page. You can view the error 
processing data in the table or save the data to a CSV text file on your computer. 
With either method, you can copy the data from the table and paste it into another 
application.
Note: Be sure to set the required Internet Explorer options so you can 
successfully use this feature. See “Setting Internet Explorer (IE) Options for Copy 
Data to Table” on page 98. 
If you do not set the IE options, you may experience inconsistent behavior when 
you use this feature. Sometimes the data table will appear and sometimes the 
page may flash momentarily, but there is no indication that your setting is not 
correct except that the table will not display.
The Copy Data to Table icon appears on the button bar on the Error Processing 
(document list) page.

To copy the error processing data
1 Click Data Management > Error Processing. The Error Processing 

(document list) page opens. 

2 Select the check boxes of the error documents whose data you want to copy 
(click again to deselect). To select all documents on a page, click the top check 
box to the left of the Date/Time column heading. Deselecting a specific error 
document deselects the top check box.
Note: You can copy one or more rows of data, up to a single page of errors 
at a time, with a limit of 20,000 total errors.

3 Click Copy Data to Table. 
One of the following occurs:

■ A table opens displaying the error processing data. Go to Step 5 (you can 
skip Step 4 unless the File Download dialog box opens).
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■ The File Download dialog box opens asking if you want to open the file or 
save it to your computer.

Note: The File Download dialog box will always open unless you deselect the 
Always ask before opening this type of file check box. This prevents the 
“Do you want to open or save this file” question from being asked every time 
you want to copy data to a table. Continue with Step 4.

4 Do one of the following:
■ Open - To display the error processing data in a table format, click Open.

The table data displays.

Go to Step 5.
■ Save - To save the file as a CSV text file that you can open later in 

Microsoft Excel, click Save. The Save As dialog box opens.

Do all of the following:
■ Navigate to the location where you want to save the file.
■ In the File name box, enter a name for the file. The file name should 

have a .csv extension. For example, ERRORS.csv

■ Click Save. The file is saved to the location you selected. 
■ Cancel - To cancel your action, click Cancel.
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5 Once the table is open, you can select rows and columns of error processing 
data to copy. When you want to close the table, click the X in the upper right 
corner of the window. 
If you modified the table, a dialog box appears when you close the window and 
asks if you want to save your changes. 

To save your changes, click Yes. The Save As dialog box opens. 

Do all of the following:
■ Navigate to the location where you want to save the file.
■ In the File name box, enter a name for the file. The file name should have 

a .csv extension. For example, ERRORS.csv 
Click Save. The file is saved to the location you selected.

Selecting Errors for Delete, Revert, or Edit
You can select an error document, an error type, or multiple errors to revert (to 
their previously submitted values) or delete. In addition, within an error document, 
you can select an error type or multiple errors to edit. The following sections 
describe how to select the errors before performing the appropriate action.

Selecting an Error Document
You can select an error document to delete or revert.

To select an error document
1 Navigate to the Error Processing (document list) page to find the error 

documents you want to delete or revert. See “Navigating Error Processing” on 
page 240. 
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2 Select the check boxes of the error documents you want to delete or revert 
(click again to deselect). To select all documents on a page, click the top check 
box to the left of the Date/Time column heading. 
Note: Deselecting a specific error document deselects the top check box.

3 Once you have selected the error document, do one of the following:
■ Click Delete. See “Deleting Errors” on page 250.
■ Click Revert. See “Reverting Errors” on page 253.

Selecting Specific Errors or Error Types
You can select an error type or specific errors to delete, edit, or revert.

To select an error or error type
1 Navigate to the Error Processing (error type list) page to find the error or error 

types you want to delete, edit, or revert. See “Navigating Error Processing” on 
page 240. 

2 Select the check boxes of the errors or error types that you want to delete, 
revert, or edit (click again to deselect).

■ To select a specific error (listed in the Action column), select the check box 
in the Item column (to the left of the error).

■ To select all errors of a specific type (listed in the Error Type column), 
select the check box to the left of a specific error type. 

■ To select all error types on a page, click the top check box to the left of the 
Error Type heading. 

Note: Deselecting a specific error type or error deselects the top check box.

3 Once you have selected the errors, do one of the following:
■ Click Delete. See “Deleting Errors” on page 250.
■ Click Revert. See “Reverting Errors” on page 253.
■ Click Edit. Do one of the following:

■ If you are correcting a single error, the Error Processing (error detail) 
page opens, See “Correcting Errors” on page 250.
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■ If you are editing more than one error, the Error Processing Group Edit 
page opens. See “Using Group Edit to Correct Multiple Errors” on 
page 251.

Deleting Errors
You can delete an error document, groups of errors (by error type), or specific 
errors. You can also delete a specific attribute from a function.

Note: Any errors displayed in Error Processing are automatically purged from 
Catalogue after 60 days.

To delete an error document or errors
1 Select the error document or errors you want to delete. See “Selecting Errors 

for Delete, Revert, or Edit” on page 248.
Note: You can not revert (recover) an error document that has been deleted.

2 Click Delete. A message asks you to confirm the deletion.
3 Click OK. The error document or errors are deleted.

To delete a specific attribute from a function
1 Find the function from which you want to delete an attribute by navigating to 

the Error Processing (error detail) page for that function. See “Navigating Error 
Processing” on page 240. 
Note: You can not revert (recover) an attribute that has been deleted.

2 In the Delete column, select the attribute you want to delete from the function.
3 Click Delete. A message asks you to confirm the deletion.
4 Click OK. The attribute is deleted.

Correcting Errors
The OpenText Active Catalogue qXML Reference Guide, which presents information 
about the document structures of qXML request and response documents, and the 
OpenText Active Catalogue Attributes Guide which presents information necessary 
for working with data attributes in qXML documents, may be helpful in correcting 
errors. Download these guides for assistance with rules, acceptable values, UOM 
lists, and so on.

Correcting a single error
To correct a single error
1 Find the error to correct by navigating to the Error Processing (error detail) 

page. See “Navigating Error Processing” on page 240. Error locations are 
indicated in red. Details about the error are displayed.
Note: Although the function fails for the first error that the system 
encounters, additional fields may be highlighted indicating they are also in 
error. Fix all errors before resubmitting the error document. To apply the same 
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change to a selected group of errors, see “Using Group Edit to Correct Multiple 
Errors” on page 251.

2 Enter a corrected value in the attribute containing the error or delete that 
attribute (see Step 3). 

3 (Optional) To delete attributes from the function, click their check boxes in the 
Delete column (click again to deselect), then click Save.

4 After correcting the error, click Save. The error’s status will change to 
Maintained. To resubmit the corrected error, you must resubmit the error 
document that contained the error. See “Resubmitting Error Documents” on 
page 254.
Note: If the resubmitted error document contains another error, the error 
document reappears in Error Processing as an unread document.
As you go through and change values, the information text changes from red to 
gray. For Private Accounts and unit of measure (UOM), if you provide a value 
which is not allowed, a warning message appears with a link. Click the link to 
delete the Private Account or UOM value.

Using Group Edit to Correct Multiple Errors
You can use group edit to apply the same change to a selected group of errors.
In most cases, it is preferable to edit the source data (for example, the item 
master) used to generate the batch file that you loaded into Catalogue. However, 
there may be instances where you need to temporarily fix data already pending at 
OpenText so that the data being sent to your trading partner is not delayed.
Group edit is not intended to be a full-featured edit facility. The full set of edits 
should be done in your item master. There are several actions that you cannot 
perform with group edit:

■ You cannot add an attribute.
■ You cannot delete an attribute.

The group edit feature has a revert capability that allows you to return an error 
document, groups of errors (by error type), or specific errors to the values they 
had when they were previously submitted (you cannot revert a deleted attribute). 
This capability is useful if you apply changes to a group of errors and do not see 
the results you expected. See “Reverting Errors” on page 253. 

To use group edit
1 Find the errors to correct by navigating to the Error Processing (error type list) 

page. See “Navigating Error Processing” on page 240.
2 Select the errors. See “Selecting Specific Errors or Error Types” on page 249. 
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3 Click Edit. The Error Processing Group Edit page opens.

4 Select one of the following edit options to apply to all of the errors you 
selected:

■ Set all Actions to — changes all of the actions of the selected errors to 
the action you select from the drop-down list.

■ Replace action — replaces the action you select from the first drop-down 
list with the action you select from the second drop-down list.

■ Search and replace — searches for a combination of a value, a UOM, 
and/or an account number for the attribute you select from the drop-down 
list and replaces every occurrence with a new combination of a value, a 
UOM, and/or an account number.

5 Select the appropriate actions from the drop-down lists and/or type in the 
values you want to search for and replace. For examples, see “Group Edit 
Examples” on page 252.

6 To apply these edits, click Save. A success message displays the number of 
rows that were changed.

7 Do one of the following:
■ If you want to continue with additional edits for the selected group of 

errors, repeat Step 4. 
■ If you want to return to the list of errors to correct a new set of errors, click 

the Back to error types link under the success message.

Group Edit Examples
The following scenarios are examples of when you might use each of the group 
edit options.

Set all actions to
After reviewing a sample of the specific errors, you realize that your EDI map has 
generated a series of update actions for items that do not currently exist in 
Catalogue. You decide to set all actions (regardless of their current action) to add.
1 Select Set all Actions to.
2 From the drop-down list, select Add.
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3 Click Save. A success message displays the number of rows that were 
changed.

Replace action
After reviewing a sample of the specific errors, you realize that all instances of 
particular action code need to be set to a different action code. You decide that all 
of the updates need to be adds while the deletes need to remain unchanged.
1 Select Replace action.
2 From the Replace action drop-down list, select Update.
3 From the with action drop-down list, select Add.
4 Click Save. A success message displays the number of rows that were 

changed.

Search and replace
After reviewing a sample of the specific errors, you realize that the same attribute 
value is in error across all functions within the error document. 
In most cases, it is preferable to edit the source data (for example, the item 
master) used to generate the batch file that you load into Catalogue. However, 
there may be instances where you need to temporarily fix data already pending at 
OpenText so that the data being sent to your trading partner is not delayed.
For example, if the country code for the Country of Origin attribute is incorrect in 
your EDI map, you can change the current value within Error Processing.
1 Select Search and replace.
2 From the Attribute drop-down list, select Country of Origin.
3 Under Search for, select the Value check box and type the current incorrect 

value for the country code.
Note: Catalogue searches for the values shown in the check boxes that are 
selected (Value, UOM and Account).

4 Under Replace with, select the Value check box, and type the correct value for 
the country code.
Note: Catalogue values are replaced with the values shown for the check 
boxes that are selected (Value, UOM and Account).

5 Review the changes you are about to make.
6 Click Save. A success message displays the number of rows that were 

changed.

Reverting Errors
You can revert an entire error document, groups of errors (by error type), or 
specific errors to the values that were present when the error document was 
previously submitted. This capability is useful if you apply changes to a group of 
errors and do not see the results you expected (for example, you do a search and 
replace on an attribute’s value and realize that you cannot proceed with the second 
phase of your edits).
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Resubmitting Error Documents

To revert an error document or errors
1 Select the error document or errors you want to revert. See “Selecting Errors 

for Delete, Revert, or Edit” on page 248.
Note: Revert will not recover attributes that have been deleted.

2 Click Revert. A message asks you to confirm your action. 
3 Click OK. The values of the errors return to the values that were present when 

the document was previously submitted.
Note: Revert has no effect on EDI errors since they cannot be edited using 
EP.

Resubmitting Error Documents
You can resubmit a corrected error only by resubmitting the error document that 
contains the error; therefore, be sure that all errors in an error document are 
corrected before resubmitting the document. A “Maintained” status means that one 
or more errors in the error document has been edited and saved. 
Note: You cannot resubmit error documents that contain translation errors.

To resubmit error documents
1 Find the error documents to resubmit. See “Navigating Error Processing” on 

page 240. 
2 Select the check boxes of the error documents you want to resubmit (click 

again to deselect). To select all error documents on a page, click the top check 
box to the left of the Date/Time heading. 
Note: Deselecting a specific document deselects the top check box.

3 Click Resubmit. A message asks you to confirm your action.
4 Click OK. A message confirms the success or failure of the resubmission. 

Note: An error document that contains other errors can be resubmitted 
successfully; however, if the resubmitted document contains another error, the 
error document reappears in Error Processing as an unread document.

Marking Error Documents as Read or Unread 
The total number of unread errors is displayed in brackets on the navigation panel 
(Data Management > Error Processing). 

On the Error Processing (document list) page, you can manage the list of 
documents by marking error documents as Read or Unread. The number of errors 
displayed in the brackets on the navigation panel updates dynamically as you read 
errors or mark errors as Read or Unread.
You can:
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■ Mark an error document Read to make its associated date and time plain 
typeface (that is, not bold). Bold typeface occurs automatically to error 
documents that are routed to Error Processing. 

■ Mark an error document Unread to make its associated date and time bold, as it 
appears before being read. 

For example, one morning you may look at 50 error documents and make 
corrections for 48 of them. When you go to lunch, you can mark the two 
uncorrected error documents as Unread so they display in bold typeface, indicating 
that they have not been corrected. 
Another example: Hundreds of error documents arrive displaying the same error 
description. You realize an attribute is unmapped in your system. You do not need 
to investigate the error for each item, so you can mark all of the error documents 
Read (that is, plain typeface) to indicate they do not need attention. 

To mark an error document as Read or Unread 
1 Click Data Management > Error Processing. The Error Processing 

(document list) page opens.
2 Select the check boxes of the error documents you want to mark as Read or 

Unread (click again to deselect). To select all documents on a page, click the 
top check box to the left of the Date/Time heading. 
Note: Deselecting a specific error document deselects the top check box.

3 Click Read to display all selected documents in plain typeface, or Unread to 
display all selected documents in bold typeface.
Note: The total number of unread errors is displayed in brackets on the 
navigation panel (Data Management > Error Processing). The number 
updates dynamically as you read errors or mark errors as Read or Unread.
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GTIN Number Structures A
The following are the required number structures for GTIN types supported by 
OpenText Active Catalogue. GS1 (EAN/UCC) Company Prefix and Item or Case 
Reference identifiers can be of varying length, which is indicated in the diagrams 
below by arrows. 
Note: GTIN Type must be upper case. 
The following are the number structures for GTIN types supported by Catalogue. 

Code Description
EN EAN/UCC-13 (13-digit European Article Number)
EO EAN/UCC-8 (8-digit European Article Number)
UA UPC/EAN Case Code
UK EAN/UCC-14 (14-digit Shipping Container Code)
UP UCC-12 (12-digit UPC Consumer Package Code) 

EN: EAN/UCC-13 (European Article Number) 
Primary GTIN type used outside of North America. Typically used for a consumer 
unit. This EAN is a 13-digit code that uniquely identifies a consumer unit. It uses 
Modulo-10 calculation. 

Country Code 
Prefix

EAN.UCC Prefix Item Reference
Check Digit

N1 N2 N3 N4 N5 N6 N7 N8 N9N10 N11 N12 N13

EO: EAN/UCC-8 (European Article Number) 
Used outside of North America. Can be either a vendor- or consumer-sellable unit. 
This EAN is an 8-digit code used to identify a consumer unit. Assigned directly by 
the EAN Member Organization of that country for products that have limited 
barcode space. It uses Modulo-10 calculation. 

Country Code 
Prefix EAN.UCC-8 Prefix and Item Reference Check Digit
N1 N2 N3 N4 N5 N6 N7 N8
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UA: UPC/EAN Case Code
A UPC/EAN Case Code is a12-digit code that identifies the manufacturer’s shipping 
unit. It has no check-digit. 
Note: Catalogue does not validate the 2-digit industry code and the 5-digit UCC 
Company Prefix code.

UK: EAN/UCC-14 (Shipping Container Code) 
Vendor sellable only. A EAN/UCC Shipping Container Code is a 14-digit code that 
uniquely identifies the manufacturer’s shipping unit (case, module, or pallet), that 
is, the product and package quantity. Previously also known as SCC-14. It uses 
Modulo-10 calculation. 

Packaging 
Indicator

Number 
System 
Character

EAN.UCC Prefix 
 Case 
Reference Check 

Digit
N1 N2 N3 N4 N5 N6 N7 N8 N9 N10 N11N12 N13 N14

UP: UCC-12 (UPC Consumer Package Code) 
Primary GTIN type used in North America. Typically used for a consumer unit. A 
UPC is a 12-digit Universal Product Code that uniquely identifies a consumer unit. 
It uses Modulo-10 calculation. 

Number 
System 
Character

UCC Company Prefix Item Reference Check 
Digit

N1 N2 N3 N4 N5 N6 N7 N8 N9 N10 N11 N12

For more information, visit the GS1 US website at: 
http://www.gs1us.org/solutions_services/tools/check_digit_calculator

Number System Character UCC Company Prefix Case Code
N1N2 N3 N4 N5 N6 N7 N8 N9 N10 N11N12

http://www.gs1us.org/solutions_services/tools/check_digit_calculator
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Container and Component 
GTIN Codes B

This section defines the codes used with container and component GTINs in 
OpenText Active Catalogue. A GTIN’s Prepack/Container Code indicates what type 
of container the GTIN is, or if the GTIN is a component. If the GTIN is a 
component, another code indicates the unit of measure of the quantity of the 
component in the container. 
This section is organized as follows:
■ “Container/Component Designation Codes” on page 258.
■ “Component Unit of Measure Codes” on page 259.

Container/Component Designation Codes
Containers (for example, prepacks) and components are indicated by the following 
codes or descriptions in the Prepack/Container Code field and Pack column: 
■ PP (prepack component)—GTIN is a component of a container and sold only 

as part of a container. 
Note: A GTIN can be a component and not have PP designation if the GTIN 
can also be sold individually. 

■ PU (prepack container)—Assortment of GTINs; the components, but not the 
container, are consumer sellable.

■ PC (prepack container)—Component quantities are subject to change. 
■ SP (setpack container)—GTINs are ordered as a group and sold to consumers 

either as a group or separately.
■ MP (multipack container)—Consumer-sellable group of GTINs, usually the 

same GTIN. 
■ IP (inner pack or pack)—a logistical unit between case and each
■ CA (case or masterpack)—may be contained in one or more DS, PL, or MX
■ DS (display shipper)—may be contained in PL or MX
■ PL (pallet)
■ MX (mixed module)
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Component Unit of Measure Codes 
The following codes indicate the unit of measure (UOM) of the quantity of a 
component in a container. For example, a quantity of 1 and a UOM of GS indicates 
the container contains one gross of the component. 

Code Description
CA Case
DZ Dozen
EA Each
GS Gross
HC Hundred Count
KT Kit
PC Piece
PR Pair
ST Set
TH Thousand
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Index 
Symbols
.csv, save file as, 203
.xls, save file as, 203

Numerics
1SYNC, 165

A
abbreviations, GS1 US color code descriptions, 115
access

assigning by mass update, 45
filtering Product list, 42
filtering Selection Code list, 42
filtering trading partner list, 41
filtering trading partners, 53
finding trading partner, 39
setting and maintaining trading partner, 43

access rights
attribute filters, 68
overview, 38
setting up, 38
user, 39

accessing documentation, 4
accounts, maintaining, 49
action field, 200
adding

custom field definitions, 60
custom field values, 131
GTIN image attributes, 151
GTIN images, 154
GTINs, 145
GTINs by copying, 147
Product image attributes, 135
Product images, 139
Products, 128
Selection Codes, 126

attribute filters
access rights, 68
adding, 73
adding by copying, 74
applying, 72
assigning user default, 72
changing default, 69
default, 69
deleting, 75
editing, 74
filtering list, 71
finding, 70
viewing, 71

attribute groups, 69
attributes

adding attribute filters, 73
adding attribute filters by copying, 74

apply text format, 202
applying attribute filters, 72
associated multiline, 166
conventions, 164
costs and prices, 166
default filters, 69
deleting attribute filters, 75
editing attribute filters, 74
GDS network, 165
multiline, 201
opening multiline lines, 166
OpenText Active Catalogue conventions, 164
overview, 163
rules, 164
viewing filters, 71

Attributes Analytics Report
deleting, 175
downloading, 171
overview, 169
requesting and running, 170
understanding, 172

auto calendar, entering dates, 18
auto-fill, 16

B
batch download process, 208
batch files, processing, 235
browse bar, 17
button bar, 14

C
catalogue data, finding, 77
Catalogue URL, 7, 9
changes, discarding, 19
changing your password, 8
Classification Level 1, 165
color codes, 102

description abbreviations, 115
downloading, 107
filtering, 105
finding, 104
GS1 US ranges, 116

compatibility view, 3, 18
compliance checks

about, 120
email notifications, 122
enabling, 122
GMA compliance, 120
GS1 prefix validation, 121
item maintenance compatibility, 120
product description uniqueness, 121
rejecting non-compliant data, 122

Compliance Report
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deleting, 181
downloading, 178
filtering list, 181
overview, 175
requesting and running, 176
understanding, 179

components
assigning to containers, 161
finding containers for, 97
finding for a container, 97
removing from containers, 162
rules, 161
UOM codes, 259

containers
assigning components to, 161
finding components of, 97
finding for a component, 97
removing components from, 162
rules, 161

control numbers in EDI document, 236–237
copy data to table

error processing data, 246
GTIN List page, 92
Internet settings for IE, 98
Item Search Ratio Report, 191
Product List page, 84
Trading Partner Access Report, 191

copying, adding GTINs by, 147
correcting

multiple errors, 251
single errors, 250

correcting errors, group edit, 251
CSS, 5
CSV file

correcting errors, 206
uploading, 204

CSV text file
blank rows, 198
creating from MS Excel, 201
data rows, missing values, 200
file size, 198
format rules, 197
header row, header fields, 199
header row, multiline attributes, 200
header row, qualifying an attribute value, 199
opening a downloaded file, 191, 221
structure, character conventions, 198
structure, required attributes, 198
viewing in Notepad, 204

custom field definitions
adding, 60
deleting, 66
editing, 62
examples, 56
viewing, 64

custom field definitions, overview, 54
custom field values

account-specific, 131

adding and editing, 131
EDI location from Header segment, 55–56
using 888 document, 55
using EDI location to determine, 57
using EDI qualifier location/value pairs for multiple, 59
using EDI qualifier location/value pairs to determine, 57

customer support, 5, 18

D
data rows

action field, 200
excess data values, 200
hierarchy creation, 201
quoted values, 200

data values, excess, 200
dates

auto calendar, 18
entering, 18

deleting, 128
attribute filters, 75
Attributes Analytics Report, 175
Compliance Report, 181
custom field definitions, 66
error documents, 250
from download basket, 212
GTIN image attributes, 158
GTIN images, 159
GTINs, 150
Product image attributes, 143
Product images, 144
Products, 134
Selection Codes, 128
text file download results, 219

demo account, 233
demo environment URL, 233
discarding changes, 19
documentation, accessing, 4
download basket

deleting records, 212
viewing, 211

download methods
batch, 208
text file, 208

download process
batch, 208
text file, 209

download results
deleting text file, 219
filtering list, 220
finding text file, 220

downloading
batch process, 208
completing a batch file download, 212
completing a text file download, 214
data, 208
GS1 US color codes, 107
GS1 US size codes, 112
GTIN images, 226
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GTINs, 210
overview, 208
Product images, 225
Products, 210
Selection Codes, 210
text file process, 209

E
EDI

error statuses on EMC, 231
monitoring files, 228–229
standards validation errors, 228
submit sample data, 228
submitting sample data, 233
validation errors, 228
validation workflow, 228
view errors, 229

EDI Management Console, 229
editing

attribute filters, 74
custom field definitions, 62
custom field values, 131
GTIN image attributes, 155
GTIN images, 158
GTINs, 148
mulitple GTINs, 149
Product image attributes, 140
Product images, 143
Products, 130
Selection Code Descriptions, 127

email notification
compliance checks, 122
reset password, 10

encoding guidelines,special character, 125
error documents

deleting, 250
filtering, 244
marking as read or unread, 254
processing, 235
selecting, 248

error messages, 19
error processing

correcting multiple errors, 251
correcting single errors, 250
deleting attribute from function, 250
deleting errors, 250
group edit, 251
levels of, 239
navigating, 240
reverting error types, 249
reverting errors, 249, 253

error processing data
copy data to table, 246

error types, selecting, 249
errors

correcting multiple, 251
correcting single, 250
correcting with group edit, 239

CSV file, 206
data validation, 228
deleting, 250
EDI validation, 228
identifying, 228
locating translation, 245
reverting, 253–254
selecting, 249
translation, 228
view EDI, 229

Excel
apply text format, 202
create spreadsheet structure, 202
entering data into spreadsheet, 203
save file as .csv, 203
save file as .xls, 203
warning dialog box, 203–204

F
filter bar, 15
filtering

attribute filter list, 71
Compliance Reports list, 181
error documents list in EP, 244
error files on EMC, 232
GS1 (EAN or UCC) prefix lists, 54
GS1 US color code list, 105
GS1 US size code list, 108
GTIN list, 92
Item Search Ratio Reports list, 184
Partner Access Reports list, 187
Product access list, 42
Product list, 84
Selection Code access list, 42
text file download results list, 220
trading partner access list, 41, 53

Find link, 17
finding

attribute filters, 70
catalogue data, 77
components for a container, 97
containers for a component, 97
EDI errors, 228
GS1 US color codes, 104
GS1 US size codes, 107
GTINs across Selection Codes, 88
GTINs under one Product, 90
Products across Selection Codes, 80
Products under one Selection Code, 82
retailers, 53
Selection Codes, 77
trading partner access, 39
your GS1 (EAN or UCC) prefixes, 52

G
GDS network, 165
global support services, 5
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GMA compliance check, 120
group edit

examples, 252
reverting errors, 254
using, 239, 251

GS1 (EAN or UCC) prefixes
filtering lists, 54
finding your, 52

GS1 (UCC/EAN) prefix validation, 121
GS1 prefix validation, compliance check, 121
GS1 US

color and size codes, 102
color codes

finding, 104
GS1 US color codes

description abbreviations, 115
downloading, 107
filtering, 105
ranges, 116

GS1 US Product Category List, 117
GS1 US Product Category2 List, 118
GS1 US size codes

downloading, 112
filtering, 108
finding, 107
requesting new, 113

GTINs, 1
adding, 145
adding by copying, 147
adding image attributes, 151
adding images, 154
assigning components, 161
associated multiline attributes, 166
attribute conventions, 164
attribute groups, 69
attribute rules, 164
attributes overview, 163
component UOM codes, 259
container/component rules, 161
cost and price attributes, 166
deleting, 150
deleting image attributes, 158
deleting images, 159
details, 95
downloading, 210
downloading physical images, 226
editing, 148
editing image attributes, 155
editing images, 158
editing multiple, 149
filtering a list, 92
finding across Selection Codes, 88
finding components for a container, 97
finding containers for a component, 97
finding under one Product, 90
maintaining container and component GTINs, 162
mock, 120
opening multiline attributes lines, 166

removing components, 162
updating image attributes, 155
updating images, 158
uploading images, 154
validating, 160
viewing details, 95

H
hierarchy creation, 201
https

//www.opentext.com/patents, ii
hyperlinks, 17

I
IE settings, copy data to table, 98
IE settings, reports, 187
image attributes

adding GTIN, 151
adding Product, 135

images
adding GTIN, 154
adding Product, 139
downloading GTIN, 226
downloading Product, 225

images, viewing Product media, 87, 96
Internet options for IE, copy data to table, 98
Internet options for IE, reports, 187
Item Search Ratio Report

accessing, 183
copy data to table, 191
filtering list, 184
overview, 182
viewing, 182

L
lockout, account, 7
logging in, 7
logging out, 7
logging out automatically, 19

M
maintaining

container and component GTINs, 162
maintaining your account, 49
mass update access, 45
media,viewing Product, 87, 96
menu bar, 18
messages

error, 19
success, 19

minimum system requirements, 3
mock GTIN, 120
moving Products, 133
multiline attributes, 201

N
navigating
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error processing, 240
OpenText Active Catalogue, 10

navigation
auto-fill, 16
browse bar, 17
button bar, 14
contacting support, 18
filter bar, 15
hyperlinks, 17
menu bar, 18
online help, 18
page size, 17
panel, 12
search bar, 15
sorting a list, 17
using the Find link, 17

Notepad, viewing CSV text file, 204
notification, reset password, 10

O
online help, 18
OpenText website link, 10
options, IE settings for copy data to table, 98
options, IE settings for reports, 187

P
page size, 17
Partner Access Report

filtering list, 187
password

changing your, 8
requirements, 8
resetting your, 9

printing, from Catalogue, 19
processing

batch files, 235
error documents, 235

Product access, assigning by mass update, 45
Products

adding, 128
adding image attributes, 135
adding images, 139
deleting, 134
deleting image attributes, 143
deleting images, 144
downloading, 210
downloading physical images, 225
editing, 130
editing image attributes, 140
editing images, 143
filtering list of, 84
finding across Selection Codes, 80
finding under one Selection Code, 82
moving, 133
updating image attributes, 140
updating images, 143
uploading images, 139

viewing details, 86
viewing media, 87, 96

Q
quoted values, 200
qXML

rejectable functions, 239
request overview, 250

R
read error messages, 254
reports

Attributes Analytics, 169
Compliance, 175
Internet settings for IE, 187
Item Search Ratio, 182
Trading Partner Access, 186

resetting your password, 9
retailers, finding, 53
reverting

error documents, 254
error types, 249
errors, 249, 253

S
save file

as .csv, 203
as .xls, 203

search bar, 15, 77
selecting

error documents, 248
error types, 249
errors, 249

Selection Code access, assigning by mass update, 45
Selection Codes, 128

adding, 126
downloading, 210
editing Descriptions, 127
finding, 77
moving Products, 133
viewing details, 79

settings, IE options for copy data to table, 98
settings, IE options for reports, 187
size codes, 102

downloading, 112
filtering, 108
finding, 107
GS1 US Product Category List, 117
GS1 US Product Category2 List, 118
requesting new GS1 US, 113

sorting a list, 17
special character encoding guidelines, 125
spreadsheet structure, create, 202
submitting sample EDI data, 233
success messages, 19
support, contacting, 5, 18
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T
table

copy data from error processing, 246
copy data from GTIN List page, 92
copy data from Item Search Ratio Report, 191
copy data from Product List page, 84
copy data from Trading Partner Access Report, 191

technical support, 5
text file

correcting errors, 206
format rules, 197
uploading, 204

text file download process, 209
text file download results

deleting, 219
filtering list, 220
finding, 220

text file upload, using, 196–197
text format, apply to attributes, 202
timing out, 19
trading partner access

assigning by mass update, 45
finding, 39
setting and maintaining, 43

Trading Partner Access Report
copy data to table, 191
overview, 186
viewing, 186

trading partners, filtering access, 41, 53
translation errors

locating, 245

viewing, 245

U
UCC/EAN prefix validation, 121
unread error messages, 254
updating

GTIN image attributes, 155
GTIN images, 158
Product image attributes, 140
Product images, 143

uploading
GTIN images, 154
Product images, 139

uploading, CSV file, 204
user access rights, 39

V
validation, EDI workflow, 228
values, excess data, 200
viewing

attribute filters, 71
custom field definitions, 64
download basket, 211
GTIN details, 95
Item Search Ratio Report, 182
Product details, 86
Product media, 87, 96
Selection Code details, 79
Trading Partner Access Report, 186
translation errors, 245

viewing, CSV text file in Notepad, 204
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